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Agilent 1O Libraries Suite
Agilent SICL User’sGuide

1
| ntroduction

This Agilent SICL User’s Guide describes Agilent SICL and how to use
it to develop 1/O applications on Microsoft Windows®. A “getting
started” chapter is provided to help you write and run your first SICL
program. Then, this guide explains how to build and program SICL
applications. Later chapters are interface-specific, describing how to use
SICL with GPIB, VXI, RS-232, LAN, and USB interfaces.

Before you can use SICL, you must install and configure the Agilent IO
Libraries Suite on your computer. See the Agilent 10 Libraries Quite
Connectivity Guide wiith Getting Sarted for installation instructions.

This chapter includes:

* What'sin This Guide?
» SICL Overview

e If You Need Help

Agilent Technologies 9



1 Introduction

What’sin This Guide?

This chapter provides an introduction and overview of SICL.
Subsequent chapters address the following topics:

10

Chapter 2 - Getting Sarted with SCL shows how to build and run a
sample program in C/C++ and in Visual Basic.

Chapter 3 - Programming with SICL shows how to build a SICL
application in a Windows environment and provides information on
communications sessions, addressing, error handling, locking, etc.

Chapter 4 - Using SICL with GPIB shows how to communicate over
the GPIB interface.

Chapter 5 - Using SICL with VXI shows how to communicate over
the VXIbus interface.

Chapter 6 - Using SICL with RS-232 shows how to communicate
over the RS-232 interface.

Chapter 7 - Using S CL with LAN shows how to communicate over a
Local AreaNetwork (LAN).

Chapter 8 - Using S CL with USB shows how to communicate over a
USB interface.

Appendix A - SICL Library Information provides information on
SICL filesand registry entries.

Appendix B - Troubleshooting SICL Programs gives general
troubleshooting techniques and shows common Windows, RS-232,
and LAN problems.

Glossary includes major terms and definitions used in this guide.

Agilent SICL User’s Guide



Introduction 1

SICL Overview

SICL ispart of the Agilent 10 Libraries Suite product. The Agilent 10
Libraries Suite includes three libraries: Agilent Virtual Instrument
Software Architecture (VISA), VISA for the Common Object Model
(VISA COM) and Agilent Standard Instrument Control Library (SICL).

Introducing VISA, VISA COM, and SICL

e Agilent Virtual Instrument Software Architecture (VISA) isan I/O
library designed according to the V XIplug& play System Alliance
that allows software developed from different vendorsto run on the
same system.

 If you are using new instruments or are developing new 1/0
applications or instrument drivers, we recommend you use Agilent
VISA or VISA COM. In particular, use VISA or VISA COM if you
want to use V XIplugé& play instrument driversin your applications,
or if you want the I/O applications or instrument drivers that you
develop to be compliant with V X1plugé& play standards.

» Agilent Standard Instrument Control Library (SICL) isan 1/O library
developed by Agilent that is portable across many 1/O interfaces and
systems.

* You can use Agilent SICL if you have been using SICL and want to
remain compatible with software currently implemented in SICL.

Using VISA functionsand SICL functionsin the same 1/O applicationis
not supported.

Agilent SICL User’s Guide 11



1 Introduction

SICL Description

Agilent Standard Instrument Control Library (SICL) isan I/O library
developed by Agilent that is portable across many /O interfaces and
systems. SICL isamodular instrument communications library that
works with avariety of computer architectures, 1/0 interfaces, and
operating systems. Applications written in C/C++ or Visual Basic using
thislibrary

can be ported at the source code level from one system to another with
very few, if any, changes.

SICL uses standard, commonly used functions to communicate over a
wide variety of interfaces. For example, a program written to
communicate with a particular instrument on a given interface can also
communicate with an equivalent instrument on a different type of
interface.

SICL Support

SICL Users

This 32-hit version of SICL is supported on Windows 2000, Windows
XP, and Windows Vista. (For information on 16-bit SICL support, and
support of older operating systems, see the revision history information
inthe Agilent O Libraries Suite Online Help.) C, C++, and Visual Basic
are supported on these Windows versions.

SICL isintended for instrument 1/0 and is best for C/C++ or Visual
Basic programmers who are familiar with Windows programming. To
perform SICL installation and configuration on Windows 2000,
Windows XP, or Windows Vista, you must have system administrator
privileges on the applicable system.

SICL Documentation

12

The following table shows associated documentation you can use when
programming with Agilent SICL.
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Introduction

Tablel Agilent SICL Documentation

1

Document Description

Agilent SICL User's Shows how to use Agilent SICL.

Guide for Windows

SICL Online Help Function reference information is provided in
the form of Windows Help.

SICL Sample Programs Sample programs are provided online to help
you develop SICL applications. If the default
installation directory was used, SICL sample
programs are provided in the C-\

Program Files\Agilent\
10 Libraries Suite\
ProgrammingSamples subdirectory.

V XIbus Consortium TCP/IP Instrument Protocol Specification -
specifications(whenusing  VXI-11, Rev. 1.0
VISA over LAN) TCP/IP-VXIbus I nterface Specification -

VXI-11.1, Rev. 1.0

TCP/IP-1EEE 488.1 Interface Specification -
VXI1-11.2, Rev. 1.0

TCP/IP-IEEE 488.2 Instrument Interface
Soecification - VXI-11.3, Rev. 1.0

13



1 Introduction

If You Need Help

* Inthe USA, you can reach Agilent Technologies at this telephone
number:

USA: 1-800-829-4444

» Outside the USA, contact your country’s Agilent support
organization. A list of contact information for other countriesis
available on the Agilent web site:
http://www.agilent.com/find/assist

» The Agilent Developer Network (ADN),

http://www.agilent.com/find/adn

isaone-stop Web resource that supports your connectivity needs
with software downloads, sample code, technical notes and white

papers.

14 Agilent SICL User’s Guide
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2
Getting Sarted with SICL

This chapter provides guidelines to help you get started programming
with SICL using the C/C++ and Visual Basic languages. This chapter
provides sample programsin C/C++ and in Visual Basic to help you
verify your configuration and introduce you to some of SICL’s basic
features. The chapter contents are:

» Getting Started Using C
» Getting Started Using Visua Basic

You may want to review the SICL Language Referencein online Help
to familiarize yourself with SICL functions. To see the reference
information online, click the IO Control (blue 1 O icon) in the Windows
notification area.

Agilent Technologies 15



2  Getting Started with SICL

Getting Sarted Using C

This section describes a sample program called idn that queriesa GPIB
instrument for its identification string. This sample builds a console
application for WIN32 programs (32-bit SICL programs on Windows
systems) using the C programming language.

C Sample Program Code

16

All files used to develop SICL applicationsin C or C++ arelocated in
the C subdirectory of the base Agilent IO Libraries Suite installation
directory. Sample C/C++ programsfor SICL are located in the
C:\Program Files\

Agilent\I0 Libraries Suite\ProgrammingSamples\C\
SICL subdirectory, if Agilent 10 Libraries Suite was installed in the
default directory.

You must first compile the sample C/C++ programs before you can
execute them. Some sample programs include makefiles or project files
that you can use to build the programs.

Theidn samplefiles are located in the
ProgrammingSamples\C\SICL\1dn subdirectory under the base
Agilent 10 Libraries Suite installation directory. This subdirectory
contains the source program, IDN.C. The sourcefile IDN.C islisted
on the following pages. An explanation of the function callsin the
sample follows the program listing.

/* This program uses the Standard Instrument
Control Library to query a GPIB instrument for
an identification string and then prints the
result. This program is to be built as a WIN32
console application. Edit the DEVICE_ADDRESS
line to specify the address of the applicable
device. For example:

gpib0,0: refers to a GPIB device at bus address
0 connected to an interface named “gpib0” by the
Connection Expert utility.

Agilent SICL User’s Guide
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Getting Started with SICL 2

gpib0,9,0: refers to a GPIB device at bus
address 9, secondary address 0, connected to an
interface named “gpib0” by the Connection Expert
utility. */

#include <stdio.h>/* for printf() */

#include “sicl_h”/* SICL routines */

#define DEVICE_ADDRESS “gpib0,0” /* Modify for
setup */

void main(void)
{

INST id; /* device session id */
char buf[256] = { 0 }; /* read buffer for idn
string */

/* Install a default SICL error handler that
logs an error message and exits. View messages
with the Event Viewer. */

ionerror(1_ERROR_EXIT);

/* Open a device session using the
DEVICE_ADDRESS */
id = i1open(DEVICE_ADDRESS);

/* Set the 1/0 timeout value for this session to
1 second */
itimeout(id, 1000);

/* Write the *RST string (and send an EOI
indicator) to put the instrument into a known
state. */

iprintf(id, “*RST\n);

/* Write the *IDN? string and send an EOI
indicator, then read the response into buf.*/
ipromptf(id, “*IDN?\n”’, “%t”, buf);

printfF(“%s\n”, buf);
iclose(id);

}

17



2  Getting Started with SICL

C Sample Code Description

18

sicl.h

Thesicl.h fileisincluded at the beginning of the file to provide the
function prototypes and constants defined by SICL.

INST

Notice the declaration of INST id at the beginning of main. The type
INST isdefined by SICL and isused to represent auniqueidentifier that
will describe the specific device or interface that you are
communicating with. Theid is set by the return value of the SICL iopen
call and will be set to O if iopen fails for any reason.

ionerror

Thefirst SICL call, ionerror, installs a default error handling routine
that is automatically called if any of the subsequent SICL callsresult in
an error. |_ERROR_EXIT specifies abuilt-in error handler that will
print out a message about the error and then exit the program. If you
wish, you can specify a custom error handling routine instead.

You can view SICL error messages with the Event Viewer utility
available from the Agilent 1O Control on the Windows taskbar.

iopen

When an iopen call is made, the parameter string “ gpib0,0” passed to
iopen specifies the GPIB interface followed by the bus address of the
instrument. The interface name gpib0 is the name given to the interface
during execution of the Connection Expert utility. The bus (primary)
address of the instrument follows (0 in this case) and istypically set
with switches on the instrument or from the front panel of the
instrument.

To modify the program to set the interface name and instrument address
to those applicable for your setup, see Chapter 3, “ Programming with
SICL” for information on using SICL’s addressing capabilities.

Agilent SICL User’s Guide



Getting Started with SICL 2

itimeout

itimeout is called to set the length of time (in milliseconds) that SICL
will wait for an instrument to respond. The specified value will depend
on the needs of your configuration. Different timeout values can be set
for different sessions as needed.

iprintf and ipromptf

SICL provides formatted 1/0 functions that are patterned after those
used in the C programming language. These SICL functions support the
standard ANSI C format strings, plus additional formats defined
specificaly for instrument 1/0.

The SICL iprintf call sends the Standard Commands for
Programmable Instruments (SCPI) command *RST to the instrument
that putsit in a known state. Then, ipromptf queries the instrument for
itsidentification string. The string is read back into buf and then printed
to the screen. (Separate iprintf and iscanf calls could have been used to
perform this operation.)

The %t read format string specifies that an ASCII string isto be read
back, with end indicator termination. SICL automatically handles all
addressing and GPIB bus management necessary to perform these reads
and writes to the instrument.

iclose
Theiclose function closes the device session to thisinstrument (id isno
longer valid after this point).

Compiling the C Sample Program

The ProgrammingSamples\C\SICL\1dn subdirectory (default
path C:\Program Files\Agilent\
10 Libraries Suite\ProgrammingSamples\C\SICL\

Agilent SICL User’s Guide 19



2  Getting Started with SICL

20

idn) containsthe 1dn.c source file for this sample program. Steps
required to compile theidn sample program in Microsoft Visual C++
6.0 follow:

1

Connect an instrument to a GPIB interface that is compatible with
|EEE 488.2.

In Visual C++, select File > New... to create a new project. Select
Win32 Console Application for this sample program, and typein a
name for your project.

Select Project > Settings from the menu. Click the Link tab and add
sicl32.1i1b totheObject/Library Moduleslist box. Optionally,
you may add the library directly to your project file. Click OK to
close the dialog box.

You may want to add the include files and library files search paths.
They are set asfollows:

Select Tools > Options from the menu.
Click the Directories tab to set the include file path.
Select Include Files from the Show Directories For list box.

Click at the bottom of the list box and type:

C:\Program Files\Agilent\I0 Libraries Suite
\include

(This assumes that you used the default installation location for
IO Libraries Suite.)

Select Library Files from the Show Directories For list box.

Click at the bottom of the list box and type:

C:\Program Files\Agilent\IO Libraries Suite
\lib

(This assumes that you used the default installation location for
IO Libraries Suite.)

Add or create your C or C++ source files. For this sample program,
select Project > Add to Project > Files... and type or browse to
C:\Program Files\Agilent\

10 Libraries Suite\ProgrammingSamples\C\SICL\
idn\1idn.c (assuming the default installation location).

The program assumes the GPIB interface name is gpib0 (set using
the Connection Expert utility) and the instrument is at bus address 0.
If necessary, modify the interface name and instrument address on
the DEVICE_ADDRESS definition linein the IDN . C sourcefile.

Agilent SICL User’s Guide
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7 Click Build > Rebuild All to build the SICL program.

Running the C Sample Program

» Toruntheidn sample program, execute the program from a console
command prompt by selecting Project > Execute or Run > Go.

If the program runs correctly, a sample of the output if connected to a
54622A oscilloscopeis:

AGILENT TECHNOLOGIES,54622A,22457869,A.01.50

If the program does not run, see the message logger for alist of run-time
errors, and see “ Appendix B: Troubleshooting SICL Programs’ for
guidelines to correct the problem.

Whereto Go Next
Go to Chapter 3, “Programming with SICL.” In addition, see the
chapter(s) that describe how to use SICL with your specific interface(s):
» Chapter 4 - Using SICL with GPIB
» Chapter 5 - Using SICL with VXI
e Chapter 6 - Using SICL with RS-232
» Chapter 7 - Using SICL with LAN
» Chapter 8 - Using SICL with USB
You may also want to familiarize yourself with SICL functions, which
are defined in the reference information provided in the SICL online

Help. If you have any problems, see “ Appendix B: Troubleshooting
SICL Programs’ for more information.

Agilent SICL User’s Guide 21
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Getting Sarted Using Visual Basic

22

This section provides guidelines to getting started programming
applicationsin Visua Basic 6.0 (VB 6.0).

Visual Basic Program Sample Code

This section describes a sample program called idn that queriesa GPIB
instrument for its identification string. This sample builds a console
application using the Microsoft Visual Basic 6.0 programming
environment.

Be suretoincludethe sicl32.bas filein your Visual Basic project.
Thisfile contains the necessary SICL definitions, function prototypes,
and support proceduresto allow you to call SICL functions from Visual
Basic.

The default Agilent 10 Libraries Suite install location is
C:\Program Files\Agilent\IO Libraries Suite.
Sample Visua Basic programsfor SICL are located in the
C:\Program Files\Agilent\IO Libraries Suite\
ProgrammingSamples\VB6\SICL subdirectory. Each sample
program subdirectory contains a project file (.vbp) that you can open
from Visual Basic 6.0.

Theidn samplefiles are located in the
ProgrammingSamples\VB6\SI1CL\idn subdirectory under the
base Agilent 10 Libraries Suite installation directory. This subdirectory
contains the Visual Basic module, idn.bas. Thismoduleislisted on
the following pages (some comments are not listed). An explanation of
the function calls in the sample follows the program listing.

Option Explicit

idn._bas

The following subroutine queries *IDN? on a
GPIB instrument and prints out the result. No
SICL error handling is set up in this

Agilent SICL User’s Guide
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example, but should be as good programming
practice

Sub Main(Q)

Dim id As Integer

Dim strres As String * 80 “ Fixed-length

“ String

Dim actual As Long

" Open the instrument session

“*"gpib0™ is the SICL Interface name as

“ defined in the Connection Expert
22" is the iInstrument gpib address on the
bus
Change these to the SICL Name and gpib
address for your instrument

id = iopen('gpib0,22'™)
Call itimeout(id, 5000)

" Query device"s *IDN? string
Call iwrite(id, "*IDN?" + Chr$(10), 6, 1, 0&)

" Read result
Call iread(id, strres, 80, 0&, actual)

" Display the results
MsgBox ""Result is: " + strres, vbOKOnly,
"*IDN? Result"

" Close the instrument session
Call iclose(id)

End Sub

Agilent SICL User’s Guide 23
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Visual Basic Sample Code Description

24

id

Notice the declaration of id at the beginning of Sub Main(). The integer
id is used to represent a unique identifier that will describe the specific
device or interface that you are communicating with. Theid isset by the

return value of the SICL iopen call and will be setto O if iopen failsfor
any reason.

iopen

When an iopen call is made, the parameter string “ gpib0,22” passed to
iopen specifies the GPIB interface followed by the bus address of the
instrument. The interface name “ gpib0” isthe name given to the
interface during execution of the Connection Expert utility. The bus
(primary) address of the instrument follows (“22" in this case) and is
typically set with switches on the instrument or from the front panel of
the instrument.

To modify the program to set the interface name and instrument address
to those applicable for your setup, see Chapter 3, “Programming with
SICL” for information on using SICL's addressing capabilities.

You can view error messages by running the Event Viewer available
from the Agilent IO Control in the taskbar notification area.

itimeout

itimeout is called to set the length of time (in milliseconds) that SICL
will wait for an instrument to respond. The specified value will depend
on the needs of your configuration. Different timeout values can be set
for different sessions as needed.
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iwriteand iread

The SICL /O iwrite function sends ablock of datato an interface or
device and iread reads raw datafrom the device or interface. Theiwrite
call sends the Standard Commands for Programmabl e I nstruments
(SCPI) command *1 DN? to the instrument that asksfor itsidentification
string.

The fixed-length string strresisread back into buf with iread and thisis
then displayed in aMessage Box. SICL automatically handles al
addressing and GPIB bus management necessary to perform these reads
and writesto the instrument.

iclose

The iclose function closes the device session to this instrument (id isno
longer valid after this point).

Building and Running the VB Sample Program

Agilent SICL User’s Guide

The ProgrammingSamples\VB6\SICL\idn subdirectory
contains the files you can use to build and run the sample:

idn._bas Microsoft Visual Basic 6.0 Modulefile
idn_vbp Microsoft Visual Basic 6.0 Project file
idn.vbw Microsoft Visual Basic 6.0 Workspace file

The steps to build and run theidn sample program follow.

1 Connect an instrument to a GPIB interface that is compatible with
|EEE 488.2.

2 Start the Visual Basic 6.0 application.

This example assumes you are building anew project (no . vbp file
exists for the project). If you do not want to build the project from
scratch, from the menu select File > Open Project..., select and open
the 1dn.vbp file, and skip to step 7.

3 Start anew Visua Basic (VB 6.0) Standard EXE project. VB 6.0 will
open up anew Projectl project with ablank Form, Form1.

25



2  Getting Started with SICL

4 From the menu, select Project > Add Module, select the Existing
tab, and browse to the idn directory. If you used default installation
paths, this directory is
C:\Program Files\Agilent\IO Libraries Suite\
ProgrammingSamples\VB6\SICL\idn. Selectthefile
idn.bas and click Open.

5 (Optional) Sincethe Main( ) subroutine is executed when the
program is run without requiring user interaction with a Form, you
may choose to delete Form1. To do this, right-click Form1 in the
Project Explorer window and select Remove Forml1.

6 SICL applicationsin Visua Basic require that the SICL Visual Basic
declaration file sic132_bas module be added to your VB project.
Thisfile contains the SICL function definitions and constant
declarations needed to make SICL callsfrom Visual Basic. To add
this module to your project, from the menu select Project > Add
Module, select the Existing tab, browse to the include directory
under the Agilent 10 Libraries Suite install directory (by default, this
isC:\Program Files\Agilent\

10 Libraries Suite\include), sdect sicl32_bas, and
click Open.

7 At thispoint, you can run and debug the Visual Basic project.

8 The program assumes the SICL interface ID is gpibO (set using the
Connection Expert utility) and the instrument is at bus address 22. If
necessary, modify the interface name and instrument address.

9 If the program runs correctly, an example of the output if connected
to an Agilent 34401A multimeter would be:

AGILENT TECHNOLOGIES, 34401A,123456789,A.01.01

10 If you want to make an executable file, from the menu select File >
Makeidn.exe... and click Open. Thiswill create idn.exe inthe
idn directory.

11 If the program does not run, see the message logger for alist of
run-time errors and see “ Appendix B: Troubleshooting SICL
Programs” for guidelines to correct the problem.

Whereto Go Next

26

Go to Chapter 3, “Programming with SICL.” In addition, see the
chapter(s) that describe how to use SICL with your specific interface(s):

Agilent SICL User’s Guide



Agilent SICL User’s Guide

Getting Started with SICL

Chapter 4 - Using S CL with GPIB
Chapter 5 - Using SICL with VXI
Chapter 6 - Using SICL with RS-232
Chapter 7 - Using SICL with LAN
Chapter 8 - Using SICL with USB

You may also want to familiarize yourself with SICL functions, which
are defined in the reference information provided in SICL online Help.

If you have any problems, see “ Appendix B: Troubleshooting SICL

Programs” for more information.
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Programming with SICL

This chapter describes how to build a SICL application and discusses
SICL programming techniques. Sample programs are provided to help
you develop SICL applications.

The sample programs in this chapter can be found in the following
locations, if Agilent O Libraries Suite were installed in the default
directory:

For C/C++:C:\Program Files\Agilent\IO Libraries Suite\
ProgrammingSamples\C\SICL

For Visual Basic:

C:\Program Files\Agilent\I0 Libraries Suite\
ProgrammingSamples\VB6\SICL
The chapter includes:

» Building aSICL Application

» Opening a Communications Session
» Sending I/0 Commands

» Handling Asynchronous Events

» Handling Errors

» Using Locks

» Additional Sample Programs

For details about SICL functions, see the SICL Online Help.
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Building a SICL Application

30

This section provides guidelines to building a SICL application in a
Windows environment.

Including the SICL Declaration File

For C and C++ programs, you must include the sicl . h header file at
the beginning of every file that contains SICL function calls. This
header file containsthe SICL function prototypes and the definitions for
all SICL constants and error codes.

#include “sicl.h”

For Visual Basic (version 4.0 or later) programs, you must add the
sicl32.bas fileto each project that calls SICL.

Librariesfor C Applicationsand DLLs

All WIN32 applications and DL Lsthat use SICL must link to the
sicl32.1ibimport library.

The SICL librariesare located inthe 1 i b directory under the Agilent IO
Libraries Suite base directory (for example,

C:\Program Files\Agilent\IO Libraries Suite\lib,
if youinstalled Agilent 10 Libraries Suite in the default location). You
may want to add this directory to the library file path used by your
language tools.

Use the DLL version of the C run-time libraries, because the run-time
libraries contain global variables that must be shared between your
application and the SICL DLL.

If you use the static version of the C run-time libraries, these global
variables will not be shared and unpredictabl e results could occur. For
example, if you use isscanf with the % F format, an application error
will occur. The following sections describe how to usethe DLL versions
of therun-time libraries.
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Compiling and Linking C Applicationsusing Visual C++
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A summary of important compiler-specific considerations for Microsoft
Visual C++ follows.

If you are using aversion of Microsoft Visual Studio® other than
Version 6.0, or if you are using another compiler, the menu structure
and selections may be different than indicated here.

1 Select Project > Settings (or Build > Settings for some older Visual
Studio versions) from the menu.

2 Click the C/C++ tab. Then, select Code Gener ation from the
Category list box and select M ultithreaded Using DLL from the
Use Run-Time Library list box. Click OK to close the dialog box.

3 Select Project > Settings (or Build > Settings) from the menu. Click
theLink tab. Then add sicl32_1ib to the Object/Library
Moduleslist box. Click OK to close the dialog box.

4 You may want to add the 1O Libraries Suite directories (for example,
C:\Program Files\Agilent\ 10 Libraries
Suite\include and
C:\Program Files\Agilent\IO Libraries Suite\
1ib) totheincludefile and library file search paths. To do this,
select Tools > Options from the menu and click the Directories tab.
Then:

a To set theinclude file path, select I nclude Files from the Show
Directoriesfor: list box. Next, click below the last listed path to
add a new path, and type C:\Program Files\Agilent\
10 Libraries Suite\include
Then, click OK.

b To set thelibrary file path, select Library Files from the Show
Directoriesfor: list box. Click below the last listed pat to add a
new path, and type
C:\Program Files\Agilent\IO Libraries Suite
\lib
Then, click OK.
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L oading and Running Visual Basic Applications

To load and run an existing Visual Basic application, first start Visua
Basic. Then, open the project file for the program you want to run by
selecting File > Open Project from the Visual Basic menu. Visua
Basic project files have a . vbp file extension. After you have opened
the application’s project file, you can run the application by pressing F5
or by clicking the Run button on the Visual Basic toolbar.

You can create a standalone executable (. exe) version of this program
by selecting File > Make EXE File from the Visual Basic menu. Once
thisis done, the application can be run standalone (just like any other
-exe file) without having to run Visual Basic.

Thread Support for 32-bit Windows Applications

SICL can be used in multi-threaded designs and SICL calls can be made
from multiple threads in WIN32 applications. However, there are some
important points to keep in mind:

e SICL error handlers (installed with ionerror) are per process (not
per thread), but are called in the context of the thread that caused the
error to occur. Calling ionerror from one thread will overwrite any
error handler presently installed by another thread.

» Theigeterrnois per thread and returnsthe last SICL error that
occurred in the current thread.

* You may want to make use of the SICL session locking functions
(ilock and iunlock) to help coordinate common instrument accesses
from more than one thread.

» See Chapter 7, “Using SICL with LAN", for thread information
when using SICL with LAN.

Opening a Communications Session

A communications session is a channel of communication with a
particular device, interface, or commander.

* A device session is used to communicate with a device on an
interface. A deviceisaunit that receives commands from a
controller. Typically adeviceisan instrument, but it could be a
compuiter, a plotter, or aprinter.
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* Aninterface session is used to communicate with a specified
interface. Interface sessions allow you to use interface-specific
functions (for example, igpibsendcmd).

* A commander session is used to communicate with the interface’s
commander. Typically acommander session is used when a
computer is acting like a device (in a non-controller role).

Opening a Communications Session

There are two parts to opening acommunications session with a specific
device, interface, or commander. First, you must declare a variable for
the SICL session identifier. C and C++ programs should declare the
session variable to be of type INST. Visual Basic programs should
declare the session variable to be of type I nteger. Once you have
declared the variable, you can open the communication channel by
using the SICL iopen function, as shown in the following code sample.

C sample:

INST id;
id = iopen (addr);

Visual Basic sample:

Dim id As Integer
id = iopen (addr)

where id isthe session identifier used to communicate to a device,
interface, or commander. The addr parameter specifies a device or
interface address, or the term cmdr for a commander session. See the
sections that follow for details on creating the different types of
communications sessions.

Your program may have several sessions open at the same time by
creating multiple session identifiers with the iopen function. Use the
SICL iclose function to close a channel of communication.

Device Sessions

A device session allows you to have direct access to a device without
knowing the type of interface to which the device is connected. On
GPIB, for example, you do not have to address a device to listen before
sending data to it. Thisinsulation makes applications more robust and
portable across interfaces, and is recommended for most applications.
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Device sessions are the recommended way of communicating using
SICL. They provide the highest-level programming method, best overall
performance, and best portability.

Addressing Device Sessions  To create a device session, specify the
interfacelogical unit or asymbolic interface name and a device-specific
logical addressin the addr parameter of the iopen function. The logical
unit is an integer corresponding to the interface.

The device-specific part of a SICL address generally consists of an
integer that corresponds to the device's bus address. It may also include
asecondary address that is an integer. (Secondary addressing is not
supported on RS-232 interfaces.) The following are valid SICL
addresses.

Table2 Examplesof Addressing Instruments

7,23 Device at address 23 connected to an interface card at logical
unit 7.
7,231 Device at address 23, secondary address 1, connected to an

interface card at logical unit 7.
gpib0,23 GPIB device at address 23.

gpib0,23,1 GPIB device at address 23, secondary address 1, connected to
a second GPIB interface card.

com1,488 RS-232 device

Theinterface logical unit and interface ID are set by running the
Connection Expert utility from the Agilent IO Control (10 icon on the
taskbar). Seethe IO Libraries Suite Online Help for details.

Examples: Opening a Device Session  Thefollowing code samples
open adevice session with a GPIB device at bus address 23.

C sample:

INST dmm;
dmm = iopen (“gpib0,23);

Visual Basic sample:
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Dim dmm As Integer
dmm = i1open (“‘gpib0,237)

I nter face Sessions

Aninterface session allows direct, low-level control of the specified
interface. A full set of interface-specific SICL functions exists for
programming features that are specific to a particular interface type
(GPIB, serial, etc.). Thisprovidesfull control of the activitieson agiven
interface, but creates less-portable code.

Addressing Interface Sessions To create an interface session,
specify the interface logical unit or interface ID in the addr parameter of
theiopen function. The interfacelogical unit and interface ID are set by
running the Connection Expert utility from the Agilent IO Control (10
icon on the taskbar). See the O Libraries Suite Online Help for details.

Thelogical unit isan integer that corresponds to a specific interface.
Theinterface ID isastring that uniquely describes the interface. The
following are valid interface addresses.

Table3 Valid SICL Addressesfor Interfaces

7 Interface card at logical unit 7
gpibo GPIB interface card.

gpibl Second GPIB interface card.
coml RS-232 interface card.

Samples: Opening an I nterface Session These code samples open
an interface session with an RS-232 interface.

C sample:

INST coml;
coml = iopen (““coml”);

Visual Basic sample:

Dim coml As Integer
coml = iopen (““coml™)
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Commander Sessions

A commander session allows your computer to talk to the interface
controller. Typically, the controller is the computer used to
communicate with devices on the interface. When the computer is not
the active controller, commander sessions can be used to talk to the
computer that is the active controller. In this mode, the computer is
acting like a device on the interface.

Addressing Commander Sessions To create acommander session,
specify avaid interface ID or logical unit followed by acomma, and
then the string cmdr in the iopen function. The following are valid
commander addresses.

Table4 Vaid Commander Addresses

gpib0,cmd  GPIB commander session.
r

7,cmdr Commander session on interface at logical unit 7.

Samples: Creating a Commander Session These code samples
create a commander session with the GPIB interface. The function calls
open a session of communication with the commander on a GPIB
interface.

C sample:

INST cmdr;
cmdr = iopen(““‘gpib0,cmdr’);

Visual Basic sample:

Dim cmdr As Integer
cmdr = iopen (“gpib0O,cmdr’)

Sending I/O Commands

Once you have established a communications session with adevice,
interface, or commander, you can start communicating with that session
using SICL’s /O routines. SICL provides formatted 1/0O and
non-formatted 1/O routines.
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* Formatted I/O converts mixed types of data under the control of a
format string. The datais buffered, thus optimizing interface traffic.
The formatted 1/0 routines are geared towards instruments, and
reduce the amount of 1/O code.

* Non-formatted I/O sends or receives raw datato or from adevice,
interface, or commander. With non-formatted 1/0, no format or
conversion of the datais performed. Thus, if formatted datais
required, the formatting must be done by the user.

Formatted I/O in C Applications

The SICL formatted I/O mechanism is similar to the C stdio
mechanism. SICL formatted I/O, however, is designed specifically for
instrument communication and is optimized for IEEE 488.2 compatible
instruments. The three main functions for formatted 1/0 in C
applications follow.

e Theiprintf function formats according to the format string and sends
datato adevice:

iprintf(id, format [,argl][,arg2][.,---1);

» Theiscanf function receives and converts data according to the
format string:

iscanf(id, format [,argl][,arg2][,---1);

» Theipromptf function formats and sends data to a device, and then
immediately receives and converts the response data:

ipromptf(id, writefmt, readfmt[,argl]
L.arg2]l.-.-D:

The formatted I/O functions are buffered. Also, there are two
non-buffered and non-formatted I/O functions called iread and iwrite.
(See“Non-Formatted I/O” on page 53.) These are raw /O functions and
should not be intermixed with formatted /O functions.

If raw 1/0 must be mixed, use the ifread/ifwrite functions. These
functions have the same parameters asiread and iwrite, but read or
write raw output data to the formatted 1/0 buffers. See “ Formatted 1/0
Buffers’ on page 52 for more details.
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Formatted 1/O Conversion Formatted I/O functions convert data
under the control of the format string. The format string specifies how
the argument is converted beforeit isinput or output. A typical format

string syntax is:

%[format Flags][field width][. precision]
[, array size][argument modifier]format code

Format Flags Zero or more flags may be used to modify the
meaning of the format code. The format flags are only used when
sending formatted 1/0 (iprintf and ipromptf). Supported format flags

are:

Table5 Format Flags

Format Flag  Description

@1 Convertsto a488.2 NR1 number.

@2 Convertsto a 488.2 NR2 number.

@3 Converts to a 488.2 NR3 number.

@H Converts to a 488.2 hexadecimal number.

@Q Convertsto a 488.2 octal number.

@B Converts to a 488.2 binary number.

+ Prefixes number with sign (+ or -).

- Left-justifies result.

space Prefixes number with blank space if positive or with — if
negative.

# Uses alternate form. For o conversion, it prints aleading
zero. For x or X, anonzero will have Ox or OX as a prefix.
For e E, f, g, or G, theresult will always have one digit on
the right of the decimal point.

0 Causes left pad character to be azero for all numeric

conversion types.

This example converts numb into a488.2 floating point number and
sends the value to the session specified by id:
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int numb = 61;
iprintf (id, “%@2d&\n”’, numb);

Sends: 61.000000

Field Width isan optional integer that specifies how many
characters are in the field. If the formatted data has fewer characters
than specified in the field width, it will be padded. The pad character is
dependent on various flags. You can use an asterisk (*) in place of the
integer to indicate that the integer is taken from the next argument.

This example pads numb to six characters and sends the value to the
session specified by id:

long numb = 61;
iprintf (id, “%61d&\n”’, numb);

Padsto six characters: 61

. Precision isan optional integer preceded by a period. When used
with format codes e, E, and F, the number of digitsto the right of the
decimal point are specified. For thed, i, 0, u, x, and X format codes, the
minimum number of digitsto appear is specified. For thes and S
format codes, the precision specifies the maximum number of
characters to be read from the argument.

Thisfield isonly used when sending formatted 1/0 (iprintf and
ipromptf). You can use an asterisk (*) in place of the integer to indicate
that the integer is taken from the next argument.

This example converts numb so that there are only two digits to the
right of the decimal point and sends the value to the session specified by
id:

float numb = 26.9345;

iprintf (id, “.2f\n”, numb);

Sends: 26.93
,Array Size The comma operator is aformat modifier which allows
you to read or write acommarseparated list of numbers (only valid with

%d and % ¥ format codes). It isa comma followed by an integer. The
integer indicates the number of elementsin the array. The comma
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operator has the format of , dd where dd is the number of elementsto
read or write. This example specifies a comma-separated list to be sent
to the session specified by id.

int list[5]={101,102,103,104,105%;

iprintf (d, “%,5d\n”, list);

Sends: 101,102,103,104,105

Argument Modifier Themeaning of the optional argument modifier
h, I, w, z, or Z is dependent on the format code.

Table6 Argument Modifiersin C Applications

Argument Forma Description
M odifier t
Codes

h d,i Corresponding argument is a short integer.

h f Corresponding argument isafloat for iprintf or
apointer to afloat for iscant.

| d,i Corresponding argument is along integer.

| b,B Corresponding argument is a pointer to ablock of
long integers.

| f Corresponding argument isadoublefor iprintf
or apointer to adoublefor iscanf.

w b,B Corresponding argument is a pointer to a block of
short integers.

z b,B Corresponding argument is a pointer to a block of
floats.

z b,B Corresponding argument is a pointer to a block of
doubles.
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Format Codes for sending and receiving formatted 1/0 are different.
The following tables summarize the format codes for each.

Table7

iprintf and ipromptf Format Codesin C Applications

Format

Codes

Description

d,i
f
b,B

c,C
t

sS

%

o,u,x,X

eE,0,G
n

F

Corresponding argument is an integer.
Corresponding argument is a float.

Corresponding argument is a pointer to an arbitrary block of
data.

Corresponding argument is a character.

Controls whether the END indicator is sent with each LF
character in the format string.

Corresponding argument is a pointer to anull terminated
string.

Sends an ASCII percent (%) character.

Corresponding argument will be treated as an unsigned
integer.

Corresponding argument is a double.
Corresponding argument is a pointer to an integer.

Corresponding argument is a pointer to a FILE descriptor
opened for reading.

This example sends an arbitrary block of datato the session specified by
the id parameter. The asterisk (*) is used to indicate that the number is
taken from the next argument:

int size = 1024;
char data [1024];

iprintf (id, “%*b&\n”, size, data);
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Sends 1024 characters of block data.

Table8 iscanf and ipromptf Format Codes

For mat Description

Codes

d,i,n Corresponding argument must be a pointer to an integer.

ef.g Corresponding argument must be a pointer to afloat.

c Corresponding argument is a pointer to a character.

s St Corresponding argument is a pointer to a string.

o,u,X Corresponding argument must be a pointer to an unsigned
integer.

[ Corresponding argument must be a character pointer.

F Corresponding argument is a pointer to a FILE descriptor
opened for writing.

This exampl e receives data from the session specified by theid
parameter and converts the datato a string:

char data[180];
iscanf (id, “%s”, data);

Sample: Formatted I/0O (C)  shows one way to send and receive
formatted 1/0O. This code sample opens a GPIB communications session
with a multimeter and uses a comma operator to send a
comma-separated list to the multimeter. The If format codes are used to
receive a double from the multimeter.

/* formatio.c

This example program makes a multimeter
measurement with a comma-separated list passed
with formatted 1/0 and prints the results */

#include <sicl.h>
#include <stdio.h>
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main(Q)

{

INST dvm;

double res;

double list[2] = {1,0.001};

/* Log message and terminate on error */
ionerror (1_ERROR_EXIT);

/* Open the multimeter session */
dvm = iopen (“‘gpib0,16);
itimeout (dvm, 10000);

/*Initialize dvm*/
iprintf (dvm, “*RST\n”");

/*Set up multimeter and send comma-separated
list*/

iprintf (dvm, “CALC:DBM:REF 50\n”");

iprintf (dvm, “MEAS:VOLT:AC? %,2If\n”, list);

/* Read the results */
iscanf (dvm,”%l1f”,&res);

/* Print the results */
printf (“Result is %f\n”,res);

/* Close the multimeter session */
iclose (dvm);

return O;

}

Format Strings  for iprintf puts a special meaning on the newline
character (\n). The newline character in the format string flushes the
output buffer to the device. All charactersin the output buffer will be

written to the device with an END indicator included with the last byte
(the newline character). This means you can control the point at which

the data is written to the device.

If no newline character isincluded in the format string for an iprintf

call, the characters converted are stored in the output buffer. You must
make another call to iprintf or acall to iflush to have those characters

written to the device.
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This can be very useful in queuing up datato send to adevice. It can
asoraise 1/0O performance by doing afew large writesinstead of several
smaller writes. You can change this behavior with the isetbuf and
isetubuf functions. See “Formatted I/O Buffers’ on page 52 for details.

The format string for iscanf ignores most white-space characters. Two
white-space characters that it does not ignore are newlines (\n) and
carriage returns (\r). These characters are treated just like normal
charactersin the format string, which must match the next
non-white-space character read from the device.

Formatted 1/0O Buffers The SICL software maintains both aread
and awrite buffer for formatted I/O operations. Occasionally, you may
want to control the actions of these buffers. See the isetbuf function for
other options for buffering data.

The write buffer ismaintained by theiprintf and the write portion of the
ipromptf functions. It queues characters to send to the device so that
they are sent in large blocks, thus increasing performance. The write
buffer automatically flushes when it sends a newline character from the
format string (see the %t format code to change this feature).

The write buffer also flushes immediately after the write portion of the
ipromptf function. It may occasionally be flushed at other
non-deterministic times, such as when the buffer fills. When the write
buffer flushes, it sends its contents to the device.

The read buffer is maintained by the iscanf and the read portion of the
ipromptf functions. The read buffer queues the data received from a
device until it is needed by the format string. The read buffer is
automatically flushed before the write portion of an ipromptf. Flushing
the read buffer destroys the datain the buffer and guarantees that the
next call to iscanf or ipromptf reads data directly from the device rather
than from data that was previously queued.

Flushing the read buffer also includes reading all pending response data
from adevice. If the device is still sending data, the flush process will
continue to read data from the device until it receives an END indicator
from the device.
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Related Formatted I/O Functions A set of functions related to
formatted /O follows.

Table9 Functions Related to Formatted 1/0

I1/0 Function  Description

ifread Obtainsraw datadirectly from the read formatted /O buffer.
Thisisthe same buffer that iscanf uses.

ifwrite Writes raw data directly to the write formatted 1/0 buffer.
Thisisthe same buffer that iprintf uses.

iprintf Converts data viaaformat string and writes the arguments
appropriately.

iscanf Reads data from a device/interface, converts this dataviaa

format string, and assigns the values to your arguments.

ipromptf Sends, then receives, datafrom a device/instrument. It also
converts data viaformat strings that are identical to iprintf
and iscanf.

iflush Flushes the formatted 1/0 read and write buffers. A flush of

the read buffer meansthat any datain the buffer islost. A
flush of the write buffer means that any datain the buffer is
written to the session’s target address.

isetbuf Sets the size of the formatted 1/0 read and the write buffers.
A size of zero (0) means no buffering. If no buffering is
used, performance can be severely affected.

isetubuf Setsthe read or the write buffer to your allocated buffer. The
same buffer cannot be used for both reading and writing.
You should also be careful when using buffers that are
automatically allocated.

Formatted 1/O in Visual Basic Applications

SICL formatted 1/O is designed specifically for instrument
communication and is optimized for IEEE 488.2 compatible
instruments. The two main functions for formatted |/O in Visual Basic
applications are:

» Theivprintf function, which formats according to the format string
and sends data to a device:
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Function ivprintf(id As Integer, fmt As
String, ap As Any) As Integer

» Theivscanf function, which receives and converts data according to
the format string:

Function ivscanf(id As Integer, fmt As
String,ap As Any) As Integer

There are certain restrictions when using ivprintf and ivscanf with
Visual Basic. For details about these restrictions, see “Restrictions
Using ivprintf in Visual Basic” in theiprintf function or “ Restrictions
Using ivscanf in Visual Basic” in the iscanf function of online Help.

The formatted 1/0 functions are buffered. There are two non-buffered
and non-formatted /O functions called iread and iwrite. (See
“Non-Formatted I/O” later in this chapter.) These are raw /O functions
and do not intermix with the formatted 1/0O functions.

If raw 1/O must be mixed, use the ifread/ifwrite functions. They have
the same parameters asiread and iwrite, but read or write raw output
data to the formatted 1/O buffers. See “Formatted 1/0 Buffers’ for
details.

Formatted 1/0O Conversion The formatted 1/O functions convert
data under the control of the format string. The format string
specifies how the argument is converted beforeit isinput or output.
Thetypical format string syntax is.

%[format Flags][field width][. precision]
[, array size][argument modifier]format code

Format Flags Zero or more flags may be used to modify the
meaning of the format code. The format flags are only used when
sending formatted 1/0 (ivprintf). Supported format flags are:

Table 10 Format Flagsfor ivprintf in Visual Basic

Format Description
Flag
@1 Convertsto a488.2 NR1 number.
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Table10 Format Flagsfor ivprintf in Visual Basic

Format Description

Flag

@2 Converts to a488.2 NR2 number.

@3 Converts to a488.2 NR3 number.

@H Converts to a488.2 hexadecimal number.

@Q Converts to a488.2 octal number.

@B Converts to a 488.2 binary number.

+ Prefixes number with sign (+ or -).

- Left justifies result.

space Prefixes number with blank space if positive or with — if
negative.

# Uses alternate form. For o conversion, it prints aleading zero.
For x or X, anonzero will have Ox or OX asaprefix. For e, E, f,
0, or G, theresult will always have one digit on the right of the
decimal point.

0 Causes left pad character to be azero for al numeric

conversion types.

This example converts numb into a488.2 floating point number to the
session specified by id. The function return values must be assigned to
variablesfor all Visual Basic function calls. Also, + Chr$(10) addsthe
newline character to the format string to indicate that the formatted 1/0
write buffer should be flushed. (Thisis equivalent to the \n character
seguence used for C/C++ programs.)

Dim numb As Integer
Dim ret_val As Integer

numb = 61

ret_val
numb)

= ivprintf(id, “%@2d” + Chr$(10),

Sends: 61.000000
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Field Width isan optional integer that specifies how many
characters arein the field. If the formatted data has fewer characters
than specified in the field width, it will be padded. The padded character
is dependent on various flags. This example pads numb to six
characters and sends the value to the session specified by id:

Dim numb As Integer
Dim ret_val As Integer

numb = 61
ret_val = ivprintf(id, “%6d” + Chr$(10), numb)

Pads to six characters: 61

. Precision isan optional integer preceded by a period. When used
with format codes e, E, and f, the number of digits to the right of the
decimal point are specified. For thed, i, o, u, x, and X format codes, the
minimum number of digitsto appear is specified. Thisfield isonly used
when sending formatted 1/O (ivprintf).

This example converts numb so there are only two digits to the right of
the decimal point and sends the value to the session specified by id:

Dim numb As Double
Dim ret_val As Integer

numb = 26.9345
ret_val = ivprintf(id, “%.21Ff° + Chr$(10),
numb)

Sends: 26.93

,Array Size The comma operator is aformat modifier which allows
you to read or write acomma-separated list of numbers (only valid with
%d and %f format codes). It isacomma followed by an integer. The
integer indicates the number of elementsin the array. The comma
operator has the format of ,dd where dd is the number of elementsto
read or write.

This exampl e specifies a comma-separated list to be sent to the session
specified by id.

Dim list(4) As Integer
Dim ret_val As Integer
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ivprintf(id, “%,5d” + Chr$(10),

Sends; 101,102,103,104,105

3

Argument Modifier The optional argument modifier h, I, w, z, or Z
is dependent on the format code.

Table11 Argument Modifiersin Visual Basic Application

Argument Format  Description

M odifier Codes

h d,i Corresponding argument is an Integer.

h f Corresponding argument isa Single.

| d,i Corresponding argument isa Long.

| d,B Corresponding argument is an array of Long.

| f Corresponding argument is a Double.

w d,B Corresponding argument is an array of Integer.
z d,B Corresponding argument is an array of Single.

Z d,B Corresponding argument is an array of Double.

Format Codes for sending and receiving formatted 1/0 are different.
The following tables summarize the format codes for each.

Table 12 ivprintf Format Codesin Visua Basic Application

For mat Description
Codes
d,i Corresponding argument is an Integer.
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Table 12 ivprintf Format Codesin Visual Basic Application

Format Description

Codes

b, B Not supported in Visual Basic.

c,C Not supported in Visual Basic.

t Not supported in Visual Basic.

sS Not supported in Visual Basic.

% Sends an ASCI| percent (%) character.

o,u,X,X Corresponding argument will be treated as an Integer.
f,eE,0,G Corresponding argument is a Double.

n Corresponding argument is an Integer.

F Corresponding arg is a pointer to a FILE descriptor.

Table 13 ivscanf format codesin Visual Basic Application

Format Description

Codes

d,i,n Corresponding argument must be an Integer.

ef,g Corresponding argument must be a Single.

c Corresponding argument is afixed length String.

s St Corresponding argument is a fixed length String.

0,U,X Corresponding argument must be an Integer.

[ Corresponding argument must be a fixed length character
String.

F Not supported in Visual Basic.

This exampl e receives data from the session specified by theid
parameter and converts the datato a string:
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Dim ret_val As Integer
Dim data As String * 180
ret_val = ivscanf(id, “%180s”, data)

‘Example: Formatted 1/0 (Visual Basic)
Option Explicit

"nonfmt._bas
"The following subroutine measures AC voltage
"on a multimeter and prints out the results.

Sub MainQ)

Dim dvm As Integer
Dim strres As String * 20 "Fixed-length String
Dim actual As Long

"Open the multimeter session

"""gpib0" is the SICL Interface name as defined
"in the Connection Expert

"'"23" is the instrument gpib address on the bus
"Change these to the SICL Name and gpib address
"for your instrument

dvm = i1open(‘'gpib0,23™)
Call itimeout(dvm, 5000)

"Initialize dvm
Call iwrite(dvm, "*RST" + Chr$(10), 5, 1, 0&)

"Set up multimeter and take measurements
Call iwrite(dvm, "CALC:DBM:REF 50" + _
Chr$(10), 16, 1, 0&)

Call iwrite(dvm, "MEAS:VOLT:AC? 1, 0.001') +
Chr$(10), 23, 1, 0&)

"Read measurements
Call iread(dvm, strres, 20, 0&, actual)

"Display the results
MsgBox "Result is " + Left$(strres, actual)
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"Close the multimeter session
Call iclose(dvm)

Exit Sub
End Sub

Format Strings  In the format string for ivprintf, when the specia
characters Chr$(10) are used, the output buffer to the deviceis flushed.
All charactersin the output buffer will be written to the device with an
END indicator included with the last byte. This means you can control
at what point you want the data written to the device.

If no Chr$(10) isincluded in the format string for an ivprintf cal, the
characters converted are stored in the output buffer. It will require
another cal to ivprintf or acall to iflush to have those characters
written to the device. This can be very useful in queuing up datato send
toadevice. It can aso raise 1/O performance by doing afew large writes
instead of several smaller writes.

The format string for ivscanf ignores most white-space characters. Two
white-space characters that it does not ignore are newlines (Chr$(10))
and carriage returns (Chr$(13)). These characters are treated just like
normal charactersin the format string, which must match the next
non-white-space character read from the device.

Formatted |/O Buffers The SICL software maintains both aread
and write buffer for formatted 1/0O operations. Occasionally, you may
want to control the actions of these buffers.

The write buffer is maintained by the ivprintf function. It queues
charactersto send to the device so that they are sent in large blocks, thus
increasing performance. The write buffer automatically flushes when it
sends a newline character from the format string. The write buffer may
occasionally be flushed at other non-deterministic times, such as when
the buffer fills. When the write buffer flushes, it sendsits contentsto the
device.

Theread buffer is maintained by the ivscanf function. It queues the data
received from a device until it is needed by the format string. Flushing
the read buffer destroys the datain the buffer and guarantees that the
next call to ivscanf reads data directly from the device rather than data
that was previously queued.
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Flushing the read buffer also includes reading all pending response data
from adevice. If the deviceis still sending data, the flush process will
continue to read data from the device until it receives an END indicator
from the device.

Related Formatted 1/O Functions These functions are related to
formatted I/O in Visual Basic:

Table 14 Related Formatted I/O Functions

1/10 Description

Function

ifread Obtains raw data directly from the read formatted 1/0O buffer.
Thisis the same buffer that ivscanf uses.

ifwrite Writes raw data directly to the write formatted 1/O buffer. This
isthe same buffer that ivprintf uses.

ivprintf Converts dataviaaformat string and converts the arguments
appropriately.

ivscanf Reads data from a device/interface, converts data via a format

string, and assigns the value to your arguments.

iflush Flushesthe formatted 1/0 read and write buffers. A flush of the
read buffer means that any datain the buffer islost. A flush of
the write buffer means that any data in the buffer is written to
the session’s target address.

Non-Formatted |/O

There are two non-buffered, non-formatted I/O functions called iread
and iwrite. These are raw 1/O functions and do not intermix with the
formatted /O functions. If raw I/O must be mixed, use the ifread and
ifwrite functions that have the same parametersasiread and iwrite, but
read/write raw data from/to the formatted 1/0O buffers.

iread Function Theiread function reads raw data from the device

or interface specified by the id parameter and stores the resultsin the
location where buf is pointing.
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C sample

iread(id, buf, bufsize, reason, actualcnt);

VB sample:

Call iread(id, buf, bufsize, reason, actualcnt)
iwrite Function Theiwrite function sends the data pointed to by
buf to the interface or device specified by id.

C sample:

iwrite(id, buf, datalen, end, actualcnt);

VB sample:

Call iwrite(id, buf, datalen, end, actualcnt)
Sample: Non-Formatted |/O (C) This C language program
illustrates using non-formatted 1/0 to communicate with a multimeter
over the GPIB interface. The SICL non-formatted I/O functionsiwrite

and iread are used for communication. A similar example was used to
illustrate formatted 1/O earlier in this chapter.

/* nonfmt.c
This example program measures AC voltage on a
multimeter and prints the results*/

#include <sicl.h>
#include <stdio.h>

main()

{
INST dvm;

char strres[20];
unsigned long actual;

/* Log message and terminate on error */
ionerror (1_ERROR_EXIT);

/* Open the multimeter session */
dvm = iopen (“‘gpib0,16);
itimeout (dvm, 10000);
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/*Initialize dvm*/
iwrite (dvm, “*RST\n”, 5, 1, NULL);

/*Set up multimeter and take measurements*/

iwrite (dvm,”CALC:DBM:REF 50\n”*,16,1,NULL);

iwrite (dvm,”MEAS:VOLT:AC? 1,
0.001\n",23,1,NULL);

/* Read measurements */
iread (dvm, strres, 20, NULL, &actual);

/* NULL terminate result string and print the
results*/

/* This technique assumes the last byte sent
was a line-feed */

if (actual){
strresf[actual - 1] = (char) 0;
printf(“Result is %s\n”, strres);

}

/* Close the multimeter session */
iclose(dvm);

return 0; }
Sample: Non-Formatted |/O (Visual Basic)

' nonfmt.bas
" The following subroutine measures AC voltage
“ on a multimeter and prints the results.
Sub Main Q

Dim dvm As Integer

Dim strres As String * 20

Dim actual As Long " Open the multimeter
session

dvm = iTopen(*‘gpib0,16™)

Call itimeout(dvm, 10000)

Initialize dvm
Call iwrite(dvm,Byval “*RST” + Chr$(10), 5,
1,\ 0&)
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" Set up multimeter and take measurements
Call i1write(dvm,ByVal “CALC:DBM:REF 50 +
Chr$(10),16,1, 0&)

Call iwrite(dvm,Byval “MEAS:VOLT:AC? 1, 0.001”
+ Chr$(10),23,1, 0&)

" Read measurements
Call iread(dvm,ByVal strres, 20, 0&, actual)

" Print the results
Print “Result is “ + Left$(strres, actual)

" Close the multimeter session
Call iclose(dvm)

Exit Sub
End Sub

Handling Asynchronous Events

Asynchronous events are events that happen outside the control of your
application. These events include service requests (SRQs) and
interrupts. An SRQ isanotification that adevice requires service. Both
devices and interfaces can generate SRQs and interrupts.

SICL dlowsinstalation of SRQ and interrupt handlersin C programs,
but does not support them in Visual Basic programs.

By default, asynchronous events are enabled. However, the library will
not generate any events until the appropriate handlers areinstalled in
your program.

If an application uses asynchronous events (ionsrq, ionintr), a callback
thread is created by the underlying SICL implementation to service the
asynchronous event. Thisthread will not be terminated until some other
thread of the application callsiclose. Some example declarations are:
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void SICLCALLBACK my_int_handler(INST id, iInt
reason, long sec)
{

/* your code here */

}

void SICLCALLBACK my_srq_handler(INST id)
{

/* your code here */

}

SRQ Handlers

Theionsrq function installs an SRQ handler. The currently installed
SRQ handler is called any time its corresponding device generates an
SRQ. If aninterface is unable to determine which device on the
interface generated the SRQ, all SRQ handlers assigned to that interface
will be called.

Therefore, an SRQ handler cannot assume that its corresponding device
generated an SRQ. The SRQ handler should usetheireadstb function to
determine whether its device generated an SRQ. If two or more sessions
refer to the same device, the handlers for each of the sessions are called.

Interrupt Handlers

Two distinct steps are required for an interrupt handler to be called.
First, the interrupt handler must be installed. Second, the interrupt event
or events need to be enabled. Theionintr function installs an interrupt
handler. Theisetintr function enables the interrupt event or events.

An interrupt handler can beinstalled with no events enabled.
Conversely, interrupt events can be enabled with no interrupt handler
installed. Only when both an interrupt handler isinstalled and interrupt
events are enabled will the interrupt handler be called.

Temporarily Disabling/Enabling Asynchronous Events

To temporarily prevent all SRQ and interrupt handlers from executing,
use the iintroff function to disable all asynchronous handlers for all
sessions in the process.
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To re-enable asynchronous SRQ and interrupt handlers previously
disabled by iintroff, use the iintron function. This enables al
asynchronous handlers for al sessions in the process that had been
previously enabled. These functions do not affect the isetintr values or
the handlers (ionsrq or ionintr). The default value for both functionsis
on.

For operating systems that support multiple threads (such as Windows
2000 and XP), SRQ and interrupt handlers execute on a separate thread
(athread created and managed by SICL). This means a handler can be
executing when the iintr off call ismade. If this occurs, the handler will
continue to execute until it has completed.

Animplication of thisisthat the SRQ or interrupt handler may need to
synchronize its operation with the application’s primary thread. This
could be accomplished via WIN32 synchronization methods or by using
SICL locks, where the handler uses a separate session to perform its
work.

Cdllsto iintroff/iintron may be nested, meaning that there must be an
equal number of ons and offs. Thus, calling the iintron function may
not actually re-enable interrupts.

Occasionally, you may want to suspend a process and wait until an
event occurs that causes a handler to execute. The iwaithdlIr function
causes the process to suspend until an enabled SRQ or interrupt
condition occurs and the related handler executes. Once the handler
completes its operation, this function returns and processing continues.

For this function to work properly, your application must turn interrupts
off (i.e., useiintroff). Theiwaithdlr function behaves asif interrupts
are enabled. Interrupts are still disabled after the iwaithdlr function has
completed.

Interrupts must be disabled if you useiwaithdlr. Useiintroff to disable
interrupts. The reason for disabling interruptsisthat there may be arace
condition between the isetintr and iwaithdlr. If you only expect one
interrupt, it might come before the iwaithdlr. This may or may not have
the desired effect. For example:

ionintr (gpib0, act_isr);
isetintr (gpibO, I_INTR_INTFACT, 1);
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iintroff ;

igpibpassctl (gpib0, ba);
whille (!done)

iwaithdlr (0);

iintron ;

Handling Errors

Agilent SICL User’s Guide

This section provides guidelines to handling errorsin SICL, including:
» Logging SICL Error Messages

» Using Error Handlersin C

» Using Error Handlersin Visual Basic

Logging SICL Error Messages

This section shows how to use the Event Viewer to log SICL error
messages. Run the Event Viewer after you run the SICL program.

Using the Event Viewer SICL logsinternal messages as Windows
events. Thisincludes error messages logged by the|_ERROR_EXIT
and |_ERROR_NOEXIT error handlers. While developing your SICL
application or tracking down problems, you can view these messages by
opening the Agilent 10 Control (10 icon on the taskbar) and clicking
Event Viewer. Both system and application messages can be logged to
the Event Viewer from SICL. SICL messages are identified by SICL

L OG or by the driver name (e.g., ag341i32).

Using Error Handlersin C

When a SICL function call in a C/C++ program resultsin an error, it
typically returns aspecia value such asaNULL pointer or anon-zero
error code. SICL alowsyou toinstall an error handler for al SICL
functions within a C/C++ application to provide a convenient
mechanism for handling errors.

Installing an error handler allows your application to ignore the return
value, and permits the error procedure to detect errors and recover. The
error handler is called before the function that generated the error
completes. Error handlers are per process (not per session or per thread).
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ionerror Function Thefunctionionerror used to instal an error
handler is defined as:

int ionerror (proc);
void (*proc)();

where:

void SICLCALLBACK proc (id, error);
INST id;
int error;

The routine proc is the error handler and is called whenever a SICL
error occurs. Two special reserved values of proc may be passed to the
ionerror function.

Table 15 Reserved Valuesfor proc

|_ERROR_EXIT Thisvaueinstalsaspecial error handler which will log a
diagnostic message and then terminate the process.

|_ERROR_NOE Thisvaueinstalsaspecial error handler which will log a
XIT diagnostic message and then allow the processto continue
execution.

This mechanism has substantial advantages over other 1/0 libraries,
because error handling code is located away from the center of your
application.

Sample: Installing an Error Handler (C) Typicaly, error
handling code isintermixed with the 1/O code in an application.
However, with SICL error handling routines, no special error handling
code isinserted between the 1/O calls. Instead, asingle line at the top
(calling ionerror) installs an error handler that gets called any time an
error occurs. In this code sample, a standard, system-defined error
handler isinstalled that logs a diagnostic message and then exits.

/* errhand.c
This example demonstrates how a SICL error
handler can be installed. */

#include <sicl.h>
#include <stdio.h>
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main O
{
INST dvm;
double res;

ionerror (1_ERROR_EXIT);

dvm = iopen (*‘gpib0,16");

itimeout (dvm, 10000);

iprintf (dvm, “%s\n”, “MEAS:VOLT:DC?");
iscanf (dvm, “%1f”, &res);

printf (“Result is %If\n”, res);

iclose (dvm);

return O;

}

Sample: Writing an Error Handler (C) Thisisan example of
writing and implementing your own error handler.

If an error occursin iopen, the id passed to the error handler may not be
valid.

/* errhand2.c

This program shows how you can install your own
error handler*/

#include <sicl.h>

#include <stdio.h>

#include <stdlib.h>

void SICLCALLBACK err_handler (INST id, int
error) {
fprintf (stderr, “Error: %s\n”, igeterrstr
(error));
exit (1);
}
main ()
{
INST dvm;
double res;
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ionerror (err_handler);

dvm = i1open (“‘gpib0,16);

itimeout (dvm, 10000);

iprintf (dvm, “%s\n”, “MEAS:VOLT:DC?);
iscanf (dvm, “%1f’, &res);

printf (“Result is %IFf\n”, res);

iclose (dvm);

return O;

}

Using Error Handlersin Visual Basic

Typicaly in an application, error handling code is intermixed with the
I/0 code. However, by using Visual Basic's error handling capabilities,
you need not insert specia error handling code between the I/0O calls.
Instead, asingle line at the top (On Error GoTo) installs an error
handler in the subroutine that gets called any time a SICL or Visual
Basic error occurs.

When a SICL call resultsin an error, the error is communicated to
Visual Basic by setting Visual Basic's Err variable to the SICL error
code. Error$is set to a human-readable string that correspondsto Err.
Thisallows SICL to be integrated with Visual Basic's built-in error
handling capabilities. SICL programswritten in Visual Basic can set up
error handlers with the Visual Basic On Error statement.

The SICL ionerror function for C programsis not used with Visual
Basic. Similarly, thel_ERROR_EXIT and |_ERROR_NOEXIT default
handlers used in C programs are not defined for Visual Basic.

When an error occurs within aVisual Basic program, the default
behavior isto display adialog box indicating the error and then halt the
program. If you want your program to intercept errors and keep
executing, you will need to install an error handler with the On Error
statement. For example:

On Error GoTo MyErrorHandler

Thiswill cause your program to jump to code at the label
MyErrorHandler when an error occurs. Note that the error handling
code must exist within the subroutine or function where the error
handler was declared.
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If you do not want to call an error handler or have your application
terminate when an error occurs, you can use the On Error statement to
tell Visual Basic to ignore errors. For example:

On Error Resume Next

Thistells Visual Basic to proceed to the statement following the
statement in which an error occurs. In this case, you could call the
Visual Basic Err function in subsequent lines to find out which error
occurred.

Visual Basic error handlers are only active within the scope of the
subroutine or function in which they are declared. Each Visua Basic
subroutine or function that wants an error handler must declare its own
error handler. Thisis different than the way SICL error handlers
installed with ionerror work in C programs. An error handler installed
with ionerror remains active within the scope of the whole C program.

Sample: Error Handlers (Visual Basic) InthisVisual Basic code
sample, the error handler displays the error message in a dialog box and
then terminates the program. When an error occurs, the Visual Basic
Err variableis set to the error code and the Error $ variable is set to the
error message string for the error that occurred.

Option Explicit

"errhand.bas

"In this example, the error handler displays the
"error message in a Message Box and then
"terminates the program.

Sub Main(Q)

Dim dvm As Integer
Dim res As Double

"Install an error handler
On Error GoTo ErrorHandler

gpib0" is the SICL Interface name as
"defined in Connection Expert
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Using L ocks

""'22" 1s the instrument gpib address on the bus
"Change these to the SICL Name and gpib address
“for your instrument

dvm = iopen('gpib0,22')

"Set timeout to 5 seconds
Call itimeout(dvm, 5000)

"Take a measurement
Call ivprintf(dvm, "MEAS:VOLT:DC?" + Chr$(10),
0&)

"Read the results
Call ivscanf(dvm, "%I1f", res)

MsgBox ""Result is " + Format(res)
iclose (dvm)

"Tell SICL to cleanup for this task
Call siclcleanup

Exit Sub
ErrorHandler:

"Display the error message
MsgBox "*** Error : " + Error, vbExclamation

End Sub

Because SICL allows multiple sessions on the same device or interface,
the action of opening does not mean you have exclusive use. In some
cases thisis not an issue, but it should be a consideration if you are
concerned with program portability.

What are L ocks?

The SICL ilock function isused to lock an interface or device. The
SICL iunlock function is used to unlock an interface or device.
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Locks are performed on a per-session (device, interface, or commander)
basis. Also, locks can be nested. The device or interface only becomes
unlocked when the same number of unlocks are done as the number of
locks. Doing an unlock without alock returns the error
|_ERR_NOLOCK.

What does it mean to lock? Locking an interface (from an interface
session) restricts other device and interface sessions from accessing this
interface. Locking a device restricts other device sessions from
accessing this device; however, other interface sessions may continue to
access the interface for this device. Locking acommander (from a
commander session) restricts other commander sessions from accessing
this commander.

It ispossible for an interface session to access a device locked from a
device session. In such a case, data may be lost from the device session
that was underway. For example, Agilent VEE applications use SICL
interface sessions. Therefore, 1/0 operations from V EE applications can
supersede any device session that has alock on a particular device.

Not all SICL routines are affected by locks. Some routines that set or
return session parameters never touch the interface hardware and
therefore work without locks. For information on using locksin
multi-threaded SICL applications over LAN, see Chapter 7, “Using
SICL with LAN.”

Lock Actions

If asession triesto perform any SICL function that obeys locks on an
interface or device currently locked by another session, the default
action isto suspend the call until the lock isreleased, or, if atimeout is
set, until the call times out.

This action can be changed with the isetlockwait function. If the
isetlockwait function is called with the flag parameter set to O (zero),
the default action is changed. Rather than causing SICL functions to
suspend, an error will be returned immediately.

To return to the default action, to suspend and wait for an unlock, call
the isetlockwait function with the flag set to any non-zero value.
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Locking in a Multi-User Environment

In a multi-user/multi-process environment where devices are being
shared, it isagood idea to use locking to ensure exclusive use of a
particular device or set of devices. However, asexplained in “Using
Locks” on page 64, an interface session can access adevice locked from
adevice session.

In general, it is not good programming practice to lock a device at the
beginning of an application and unlock it at the end. This can result in
deadlocks or long waits by others who want to use the resource.

The recommended procedure is to use locking per transaction. Per
transaction means that you lock before you set up the device, then
unlock after all desired data has been acquired. When sharing a device,
you cannot assume the state of the device, so the beginning of each
transaction should have any setup needed to configure the device or
devicesto be used.

Sample: Device Locking (C)

/* locking.c
This example shows how device locking can be
used to gain exclusive access to a device*/

#include <sicl._h>
#include <stdio.h>

main()
{
INST dvm;
char strres[20];
unsigned long actual;

/* Log message and terminate on error */
ionerror (1_ERROR_EXIT);

/* Open the multimeter session */
dvm = i1open (“‘gpib0,16);
itimeout (dvm, 10000);
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/* Lock the multimeter device to prevent
access from other applications*/
ilock(dvm);

/* Take a measurement */
iwrite (dvm, “MEAS:VOLT:DC?\n”’, 14, 1, NULL);

/* Read the results */
iread (dvm, strres, 20, NULL, &actual);

/* Release the multimeter device for use by
others */
iunlock(dvm);

/* NULL terminate result string and print
results */

/* This technique assumes the last byte sent
was a line-feed */

if (actual) {
strresf[actual - 1] = (char) 0;
printf(“Result is %s\n”, strres);

}

/* Close the multimeter session */
iclose(dvm);

return 0;}

Sample: Device Locking (Visual Basic)
Option Explicit

locking.bas

" This example shows how device locking can be

used to gain exclusive access to a device

Sub Main(Q)

Dim dvm As Integer

3

Dim strres As String * 20 “Fixed length String

Dim actual As Long
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"Install an error handler
On Error GoTo ErrorHandler

"Open the multimeter session
dvm = iopen('gpib0,23™)
Call itimeout(dvm, 10000)

"Lock the multimeter device to prevent access
“from other applications
Call ilock(dvm)

"Take a measurement
Call iwrite(dvm, "MEAS:VOLT:DC?" + Chr$(10),
14, 1, 0&)

"Read the results
Call iread(dvm, strres, 20, 0&, actual)

"Release the multimeter for use by others
Call iunlock(dvm)

"Display the results
MsgBox ""Result is " + Left$(strres, actual)

"Close the multimeter session
Call iclose(dvm)

Exit Sub
ErrorHandler:

"Display the error message.
MsgBox ''*** Error : " + Error

End Sub

Additional Sample Programs

This section contains two additional sample programs that provide
guidelinesto help you develop SICL applications.
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Sample: Oscilloscope Program (C)

This C sample programs an oscilloscope (such as an Agilent 54601),
uploads the measurement data, and instructs the oscilloscope to print its
display to a printer. This program uses many SICL features and
illustrates some important C and Windows programming techniques for
SICL.

Program Files The oscilloscope sample files are located in the
C:\Program Files\Agilent\IO Libraries Suite\
c\samples\scope subdirectory, if Agilent 10 Libraries Suite was
installed in the default directory. The subdirectory contains the source
program and anumber of filesto help you build the sample with specific
compilers, depending on the Windows environment used.

Table 16 Program Files for the C Oscilloscope Program

Agilent SICL User’s Guide

SCOPE.C Sample program source file.
SCOPE.H Sample program header file.
SCOPE.RC Sample program resource file.

SCOPE. ICO Sample program icon file.

Building the Project File This section shows how to create the
project file for this sample using Microsoft Visual C++ 6.0.

To compile and link the sample program with Microsoft Visual C:
1 Sdect File> New from the menu. Select the Project tab.

2 Typethe name you want for the project in the edit box labeled
Project name. Then, select Win32 Application from the project
type list box. Specify a directory location for the project in the
L ocation edit box. Click the OK button.

3 TheWin32 Application wizard will appear. Select An empty project
and click Finish.

4 Click Project > Add to Project > Files.... Browse to the sample
folder (by default, thisisC-\Program Files\Agilent\
10 Libraries Suite\ProgrammingSamples\C\SICL\
scope) . Select the source files scope . c, scope.rc, and
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scope . h to add them to the project. Also add sicl32. 1ib from
the 1'ib directory (by default, C:\
Program Files\Agilent\IO Libraries Suite\lib).

5 Select Project > Settings from the menu and click the C/C++ tab.
Select Code Gener ation from the Category list box. Then, select
Multithreaded DLL from the Userun-Timelibrary list box and
click OK.

6 Select Tools > Options from the menu and click the Directories tab
in the Options dialog box. Select I nclude Files from the Show
Directoriesfor: list box, click the New icon, click below the last
directory in the list box, browse to the 1O Libraries Suite include
directory (by default, C:\Program Files\Agilent\

10 Libraries Suite\include) andclick OK.

7 Select Build > Build samplename.exe to build the application.

If there are no errors reported, you can execute the program by selecting
Build > Execute samplename.exe. An application window will open.
Several commands are available from the Action menu, and any results
or output will be printed in the program window. To end the program,
select File > Exit from the program menu.

Program Overview You may want to view the program with an
editor as you read through this section. The entire program is not listed
here because of its length. This program illustrates specific SICL
features and programming techniques and is not meant to be a robust
Windows application. See the SICL online Help for detailed
information on the SICL features used in this program.

Custom Error Handler  The oscill oscope program defines a custom
error handler that is called whenever an error occurs during a SICL call.
The handler isinstalled using ionerror before any other SICL function
call is made, and will be used for all SICL sessions created in the
program.

void SICLCALLBACK my_err_handler(INST id, int
error)

{

sprintf(text_buf[num_lines++], “session id=%d,
error = %d:%s”, id, error, eterrstr(error));
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sprintf(text_buf[num_lines++], “Select “File |
Exit” to exit program!™™);...

// 1f error is from scope, disable 1/0 actions
// by graying out menu picks.
if (id == scope) {
... code to disallow further 1/0 requests
from user
}
}

The error number is passed to the handler, and igeterrstr isused to
trang ate the error number into a more useful description string. If
desired, different actions can be taken depending on the particular error
or id that caused the error.

Locks SICL alows multiple applications to share the same interfaces
and devices. Different applications may access different devices on the
same interface, or may alternately access the same device (a shared
resource). If your program will be executing along with other SICL
applications, you may want to prevent another application from
accessing a particular interface or device during critical sections of your
code. SICL providestheilock/iunlock functions for this purpose.

void get_data (INST id)
{

... non-SICL code

/* lock device to prevent access from other
applications */
ilock(scope);

SICL 1/0 code to program scope and get data

/* release the scope for use by other
applications */
iunlock(scope);

... non-SICL code
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Lock the interface or device with ilock before critical sections of code,
and release the resource with iunlock at the end of the critical section.
Using ilock on a device session prevents any other device session from
accessing the particular device. Using ilock on an interface session
prevents any other session from accessing the interface and any device
connected to the interface.

Formatted 1/0O  SICL provides extensive formatted 1/0 functionality
to help facilitate communication of 1/0 commands and data. The sample
program uses a few of the capabilities of the iprintf/iscanf/ipromptf
functions and their derivatives.

Theiprintf function is used to send commands. Aswith all of the
formatted /O functions, the datais actually buffered. In thiscall, the \n
at the end of the format:

iprintf(id,”:waveform:preamble?\n”);

causes the buffer to be flushed and the string to be output. If desired,
several commands can be formatted before being sent and then al
commands outputted at once. The formatted 1/0 buffers are
automatically flushed whenever the buffer fills (see isetbuf) or when an
iflush call is made.

When reading data back from a device, the iscanf function is used. To
read the preamble information from the oscill oscope, use the format
string “%,20f\n":

iscanf(id,”%,20f\n”,pre);

This string expectsto input 20 comma-separated floating point numbers
into the pre array.

To upload the oscill oscope waveform data, use the string “ % #wb\n”.
The wb indicates that iscanf should read word-wide binary data. The #
preceding the data modifier tells iscanf to get the maximum number of
binary words to read from the next parameter (& elements):

iscanf(id,”%#wb\n”,&elements, readings);

The read will continue until an EOI indicator is received or the
maximum number of words have been read.
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Interface Sessions  Sometimes it may be necessary to control the
GPIB bus directly instead of using SICL commands. Thisis
accomplished using an interface session and interface-specific
commands. This sample uses igetintfsess to get a session for the
interface to which the oscilloscope is connected. (If you know which
interfaceisbeing used, it isalso possibleto just use aniopen call on that
interface.)

Then, igpibsendcmd is used to send some specific command bytes on
the busto tell the printer to listen and the oscilloscope to send its data.
Theigpibatnctl function directly controlsthe state of the ATN signal on
the bus.

void print_disp (INST id)

{
INST gpibOintf ;

gpibOintf = igetintfsess(id);

/* tell oscilloscope to talk and printer to
listen. The listen command is formed by adding
32 to the device address of the device to be a
listener. The talk command is formed by adding
64 to the device address of the device to be a
talker. */

cmd[0] = (unsigned char)63 ; // 63 is unlisten
cmd[1] = (unsigned char)(32+1) ; /* printer at
addr 1,make it a listener */
cmd[2] = (unsigned char)(64+7) ; /* scope at
addr 7,make it a talker */
cmd[3] = “\0”; /* terminate the string */

length = strlen (cmd) ;

igpibsendcmd(gpibOintf,cmd, length);
igpibatnctl(gpibOintf,0);

73



3

74

Programming with SICL

SRQsand iwaithdlr Many instruments are capable of using the
service request (SRQ) signal on the GPIB bus to signal the controller
that an event has occurred. If an application needs to respond to SRQs,
an SRQ handler must be installed with theionsrq call. All SRQ
handlers are called whenever an SRQ occurs.

In the sample handler, the oscilloscope status is read to verify that the
oscilloscope asserted SRQ, and then the SRQ is cleared and a status
message is displayed. If the oscilloscope did not assert SRQ, the handler
prints an error message.

void SICLCALLBACK my srq_handler(INST id)
{

unsigned char status;

/* make sure It was the scope requesting
service */
ireadstb(id,&status);

if (status &= 64) {
/* clear the status byte so the scope can
assert SRQ again if needed. */
iprintf(id,”*CLS\n”");
sprintf(text_buf[num_lines++], “id = %d, SRQ
received!, stat=0x%x", id,status);
} else {
sprintf(text_buf[num_lines++],
“SRQ received, but not from the scope”);
¥
InvalidateRect(hWnd, NULL, TRUE);

}

In the routine that commands the oscilloscope to print its display, the
oscilloscope is set to assert SRQ when printing is finished. While the
oscilloscopeis printing, the sample program has the application suspend
execution. SICL provides the function iwaithndlr that will suspend
execution and wait until either an event occurs that would call ahandler,
or a specified timeout value is reached.

In the sample, interrupt events are turned off with iintroff so that all
interrupts are disabled while interrupts are being set up. Then, the SRQ
handler isinstalled with ionsrg. Code to program the oscill oscope to
print and send an SRQ is next, then the call to iwaithdlIr, with atimeout
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value of 30 seconds. When the oscilloscope finishes printing and sends
the SRQ, the SRQ handler will be executed and then iwaithdIr will
return. A cal to iintron re-enables interrupt events.

void print_disp (INST id)
{

iintroff();
ionsrq(id,my_srqg_handler);/* Not supported on
82335 */

/* tell the scope to SRQ on “operation
complete” */

iprintf(id,”*CLS\n”);

iprintf(id,”*SRE 32 ; *ESE 1\n”) ;

/* tell the scope to print */
iprintf(id,”:print ; *OPC\n”) ;

... code to tell the scope to print

/* wait for SRQ before continuing program */
iwaithdlr(30000L);
iintron(Q);

sprintf (text_buf[num_lines++],”Printing
complete!™”) ;

}

Sample: Oscilloscope Program (Visual Basic)

This Visual Basic sample program uses SICL to get and plot waveform
datafrom an Agilent 54601A (or compatible) oscilloscope. Thisroutine
is called each time the cmdGetWaveform command button is clicked.

Program Files The oscilloscope sample files are located in the
C:\Program Files\Agilent\IO Libraries Suite\
vb\samples\scope subdirectory, if Agilent 10 Libraries Suite was
installed in the default directory. Thefiles are listed in the following
table.
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Table 17 Files Used for the Oscilloscope Sample Program

SCOPE.FRM Visua Basic source for the SCOPE sample program.

SCOPE.VBP Visua Basic project file for the SCOPE sample program.

SCOPE.VBW Visua Basic workspace file for the SCOPE sample

program.

L oading and Running the Program  Follow these stepsto load and

run the SCOPE sample program:
1 Connect an Agilent 54601A oscilloscope to your interface.
2 Run Visual Basic 6.0.
3 Openthe project file scope . vbp by selecting File > Open Project
from the Visual Basic menu.
4 Edit the scope. frm file to set the scope_address constant to the
address of your oscilloscope. To do this:
a If aProject Treeisnot aready visible, select View > Project
Explorer from the Visual Basic menu.
b Under Forms, right-click scope.frm and select View Code.
¢ Edit thefollowing line so the address is set to the address of the
oscilloscope:
Private Const scope_address = ''gpib0,7" *
Address of SCOPE
5 Run the program by pressing the F5 key or by clicking the RUN

button on the Visual Basic Toolbar.
Press the Wavefor m button to get and display the waveform.

7 PresstheIntegral button to calculate and display the integral.

8 After performing these steps, you can create a standal one executable

(-exe) version of this program by selecting File > Make
scope.exe... from the Visual Basic menu.

Program Overview  You may want to view the program with an
editor as you read through this section. The entire program is not listed
here because of its length. This program illustrates specific SICL
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features and programming techniques and is not meant to be a robust
Windows application. See the SICL online Help for detailed
information on the SICL features used in this program.

Table 18 Functions of the Sample Program

3

Listing

Description

CmdGetWaveform_Click

On Error

CmdGetWaveform.Enable
d

iopen

Subroutine that is called when the
cmdGetWaveform command button is pressed.
The command button is labeled Wavefor m.

This Visual Basic statement enables an error
handling routine within a procedure. In this
sample, an error handler isinstalled starting at
label ErrorHandler within the
cmdOutputCmd_Click subroutine.

The error handling routineis called any time an
error occurs during the processing of the
cmdGetWaveform_Click procedure. SICL
errors are handled in the same way that Visua
Basic errors are handled with the On Error
statement.

The button that causes the
cmdGetWaveform_Click routinetobecalledis
disabled when code is executing inside
cmdOutputCmd_Click. Thisis good
programming style.

Aniopen call is made to open a device session
for the oscilloscope. The device address for the
oscilloscopeisin the scope_address string.In
this sample, the default addressis “ gpib0,7.”
The interface name gpibO0 is the name given to
the interface with the Connection Expert utility.
The bus (primary) address of the oscill oscope
follows, in this case 7. You may want to change
the scope_address string to specify the correct
address for your configuration.
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Table 18 Functions of the Sample Program

Listing Description

igetintfsess igetintfsessis called to return an interface
session id for the interface to which the
oscilloscope instrument is connected. This
interface session will be used by the following
iclear call to send an interface clear to reset the

interface.

iclear Theiclear functionis called to reset the
interface.

itimeout itimeout is called to set the timeout value for the

oscilloscope's device session to 3 seconds.

ivprintf Theivprintf function is called four timesto set
up the oscilloscope and then request the
oscilloscope's preamble information. In each
case Chr$(10) is appended to the format string
passed as the second argument to ivprintf. This
tellsivprintf to flush the formatted I/O write
buffer after writing the string specified in the
format string.

ivscanf Theivscanf function is called to read the
oscilloscope's preamble information into the
preamble array. The preamble array is passed as
the third parameter to ivscanf. This passesthe
address of the first element of the preamble
array to theivprintf SICL function.

ivprintf ivprintf is called to prompt the oscilloscope for
itswaveform data. Again, Chr$(10) is appended
to the format string passed as the second
argument to ivprintf. Thistellsivprintf to flush
the formatted 1/0 write buffer after writing the
string specified in the format string.
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Table 18 Functions of the Sample Program

3

Listing

Description

iread

iclose

cmdGetWaveform.Enable
d

Exit Sub

errorhandler:

Error$

iclose

iread is called to read in the oscilloscope's
waveform. The waveformisreadinasa
specified number of bytes. The format string
passed as the third parameter to iread specifies
that a maximum of 2010 Byte values be read
into the Byte array. A null value, vbNull, is
passed as the fourth value and a Long variable,
actual, returns the number of bytes actually
read. 0& may also be used for anull value.

The iclose subroutine closes the scope_id
device session for the oscilloscope aswell asthe
intf_id interface session obtained with
igetintfsess.

The button that causes the
cmdGetWaveform_Click routineto becaledis
re-enabled when execution inside
cmdGetWaveform_Click isfinished. This
allows the program to get another waveform.

This Visual Basic statement causes the
cmdGetWaveform_Click subroutine to be
exited after normal processing has completed.

This label specifies the beginning of the error
handler that was installed for this subroutine.
Thishandler is called whenever arun-time error
occurs.

This Visua Basic function is called to get the
error message for the error. The error returned is
the most recent run-time error when no
argument is passed to the function.

Theiclose subroutineis called inside the error
handler to close the scope_id device session for
the oscilloscope as well astheintf_id interface
session obtained with igetintfsess.
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Table 18 Functions of the Sample Program

Listing Description

CmdGetWaveform.Enable This re-enables the button that causes the

d cmdGetWaveform_Click routine to be called.
This allows the program to get another
waveform.

Exit Sub This Visual Basic statement causes the

cmdGetWaveform_Click subroutine to be
exited after processing an error in the
subroutine's error handler.
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4
Using SICL with GPIB

This chapter shows how to open a communications on and
communicate with GPIB devices, interfaces, or controllers. The sample
programsin this chapter can be found in the following locations, if
Agilent 10 Libraries Suite was installed in the default directory:

For C/C++:
C:\Program Files\Agilent\IO Libraries Suite\
ProgrammingSamples\C\SICL\

For Visua Basic:
C:\Program Files\Agilent\I0 Libraries Suite\
ProgrammingSamples\VB6\SICL\

This chapter includes:

* Introduction to GPIB Interfaces

» Using GPIB Device Sessions

e Using GPIB Interface Sessions

» Using GPIB Commander Sessions
» Writing GPIB Interrupt Handlers
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Introduction to GPIB I nterfaces

82

This section provides an introduction to using SICL with the GPIB
interface, including:

* GPIB Interfaces Overview
e Selecting a GPIB Communications Session
» SICL GPIB Functions

GPIB Interfaces Overview

This section provides an overview of GPIB interfaces, including typical
hardware configuration using the Connection Expert utility, and
example configurations using SICL..

Typical GPIB Interface

As shown in the following figure, atypical GPIB interface consists of a
Windows PC with one or more GPIB cards (PCI and/or ISA) cards
installed in the PC and one or more GPIB instruments connected to the
GPIB cardsvia GPIB cable. /O communication between the PC and the
instrumentsis viathe GPIB cards and the GPIB cable. Thisfigure
shows GPIB instruments at addresses 3 and 5.
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N

~

GPIB Interface (82350 PCI GPIB Cards)

Windows PC GPIB Cable GPIB Instruments
5
82350 GPIB Card #1 3
82350 GPIB Card #2 3

Configuring GPIB Interfaces

Agilent SICL User’s Guide

An 10 interface can be defined as both a hardware interface and as a
software interface. One function of the Connection Expert utility isto
associate a unique interface name with a hardware interface.

SICL uses an Interface Name or L ogical Unit Number to identify an
interface. Thisinformation is passed in the parameter string of theiopen
function call in a SICL program. Connection Expert assigns a default
Interface Name and Logical Unit Number, as well as other necessary
configuration values, when the interface hardware is configured; you
can change these values by running the Connection Expert utility. See
the IO Libraries Suite Online Help for details.

Example: GPIB (82350) Interface

The GPIB interface system in the following figure consists of a
Windows PC with two 82350 GPIB cards connected to three GPIB
instruments via GPIB cables. For this system, the Connection Expert
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utility has been used to assign GPIB card #1 a SICL name of gpib0 and
to assign GPIB card #2 a SICL name of gpib1. With these names

assigned to the interfaces, the SICL addressing is as shown in the figure.
Since unique names have been assigned by Connection Expert, you can

/

use theiopen command to open the 1/O paths shown.

GPIB Interface (B2350 PCI GPIB Cards)

aitace S M aaws Wiadowa PC GFIE Calkla GIFIE lisiTiadinains
B
EICL Mamme
“gpbil” 82359 GFIB Cand 51 3
“giEh 1" 2258 GPB Capd 52 3

SICL Addvessing

apan [pEd.ST  Open 0 path o GPIB mstinme at sddeess § usng 82350 Card #1
npen [(pidd. 37 Cpen 10 path o GPIS m=mment 3l sddesse 3 usng 82350 Caddd
npen [apl 37 Gpen 10 path fo GPIE neiumen at eddeess 3 usng 8280 Card 82

Agilent SICL User’'s Guide



Using SICL withGPIB 4

Selecting a GPIB Communications Session

When you have determined the GPIB system is set up and operating
correctly, you can start programming with the SICL functions. First, you
must determine what type of communications session to use.

The three types of communications sessions are device, interface, and
commander. To use a device session, see “Using GPIB Device
Sessions’; to use an interface session, see “Using GPIB Interface
Sessions’; to use a commander session, see “ Using GPIB Commander
Sessions” in this chapter.

SICL GPIB Functions

Agilent SICL User’s Guide

Table19 SICL GPIB Functions

Function Name

Action

igpibatnctl
igpibbusaddr
igpibbusstatus
igpibgettldelay
igpibllo
igpibpassctl
igpibppoll
igpibppollconfig
igpibppollresp
igpibrenctl
igpibsendcmd
igpibsettldelay

Setsor clearsthe ATN line.

Changes bus address.

Returns requested bus data.

Returns the current T1 setting for the interface.
Setsbusin Local Lockout Mode.

Passes active control to specified address.
Performs a parallel poll on the bus.
Configures device for PPOLL response.
Sets PPOLL state.

Setsor clearsthe REN line.

Sends datawith ATN line set.

Setsthe T1 delay value for thisinterface.
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Using GPIB Device Sessions

A device session allows you direct access to a device without knowing
the type of interface to which it is connected. The specifics of the
interface are hidden from the user.

SICL Functionsfor GPIB Device Sessions

This section shows how some SICL functions are implemented for
GPIB device sessions. The data transfer functions work only when the
GPIB interface is the Active Controller. Passing control to another
GPIB device causes this device to lose active control.

Table20 SICL Functions for GPIB Sessions

Functio Description
n

iwrite Causes al devicesto untalk and unlisten. It sendsthis controller’s
talk address followed by unlisten and then the listen address of the
corresponding device session. Then, it sends the data over the bus.

iread Causes all devicesto untalk and unlisten. It sends an unlisten, then
sends this controller’s listen address followed by the talk address
of the corresponding device session. Then, it reads the data from
the bus.

ireadstb  Performs a GPIB serial poll (SPOLL).
itrigger  Performs an addressed GPIB group execute trigger (GET).

iclear Performs a GPIB selected device clear (SDC) on the device
corresponding to this session.

Addressing GPIB Devices

To create adevice session, specify theinterface logical unit or symbolic
name and a particular device logical address in the addr parameter of
theiopen function. The interface logical unit and symbolic name are set
by running the Connection Expert utility.
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Opening Connection Expert  To open the Connection Expert
utility, click the Agilent 10 Control (1O icon on the taskbar) and click
Agilent Connection Expert. Seethe O Libraries Suite Online Help for
details on this utility.

Primary and Secondary Addresses SICL supports both primary
and secondary addressing on GPIB interfaces. The primary address
must be between 0 and 30 and the secondary address must be between 0
and 30. The primary and secondary addresses correspond to the GPIB
primary and secondary addresses. Some example GPIB addresses for
device sessions are;

Table21 GPIB Primary and Secondary Addresses

GPIB,7 A device address corresponding to the device at primary address 7.

gpib0,3, A device address corresponding to the device at primary address 3,
2 secondary address 2.

VXI Mainframe Connections For connectionsto aVXI| mainframe
viaan E1406 Command Module (or equivaent), the primary address
passed to iopen corresponds to the address of the Command Module,
and the secondary address must be specified to select a specific
instrument in the card cage.

Secondary addresses of 0, 1, 2, ... 30 correspond to VXI instruments at
logical addresses of 0, 8, 16, ... 240, respectively. See “GPIB Device
Session Code Samples’ for a sample program to communicate with a
V XI mainframe viathe GPIB interface.

Sample code to open a device session with a GPIB device at bus address
16 follows.

C sample:

INST dmm;
dmm = iopen (“‘gpib0,16");

Visual Basic sample:

Dim dmm As Integer
dmm = i1open (“gpib0,16™)
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GPIB Device Sessions and Service Requests There are no
device-specific interrupts for the GPIB interface, but GPIB device
sessions do support Service Requests (SRQs). On the GPIB interface,
when one device issues an SRQ, the library informs all GPIB device
sessions that have SRQ handlers installed.

Thisisan artifact of how GPIB handles the SRQ line. The interface
cannot distinguish which device requested service. Therefore, the
library acts asif all devices require service. The SRQ handler can
retrieve the device's status byte by using the ireadstb function. For
more information, see “Writing GPIB Interrupt Handlers’ in this
chapter.

GPIB Device Session Code Samples

This section provides C language and Visual Basic language sample
programs for GPIB device sessions.

Sample: GPIB Device Session (C) This sample opens two GPIB
communications sessions with VXI devices (viaa VXl Command
Module). Then, ascan list is sent to a switch and measurements are
taken by the multimeter every time a switch is closed.

/* gpibdev.c

This example program sends a scan list to a
switch and, while looping, closes channels and
takes measurements. */

#include <sicl.h>
#include <stdio.h>

main()
{
INST dvm;
INST sw;
double res;
int i;
/* Log message and terminate on error */
ionerror (1_ERROR_EXIT);
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/* Open the multimeter and switch sessions*/
dvm = iopen (“‘gpib0,9,37);

sw = iopen (“gpib0,9,14");
itimeout (dvm, 10000);
itimeout (sw, 10000);

/*Set up trigger*/
iprintf (sw, “TRIG:SOUR BUS\n”);

/*Set up scan list*/
iprintf (sw,”SCAN (@100:103)\n”");
iprintf (sw,”INIT\n”);

for (i=1;i<=4;i++)
{
/* Take a measurement */
iprintf (dvm,”MEAS:VOLT:DC?\n”");

/* Read the results */
iscanf (dvm,”%l1f”,&res);

/* Print the results */
printf (“Result is %If\n”,res);

/* Trigger to close channel */
iprintf (sw, “TRIG\n);
¥

/* Close the multimeter and switch sessions */

iclose (dvm);
iclose (sw);

return O;

}

Sample: GPIB Device Session (Visual Basic) This sample opens
two GPIB communications sessions with VX devices (viaaVXI
Command Module). Then, ascan list is sent to a switch and
measurements are taken by the multimeter every time aswitch is closed.
Option Explicit

gpibdv.bas

" This example program sends a scan list to a
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“ switch and while looping closes channels and
“ takes measurements.

Sub Main(Q)

Dim dvm As Integer

Dim sw As Integer

Dim res As Double

Dim 1 As Integer

Dim argcount As Integer

"Open the multimeter and switch sessions
"'"gpib0" is the SICL Interface name as defined
"in Connection Expert

"Change this to the SICL name you have defined

dvm = iopen('gpib0,9,3"™)
sw = iopen(*'gpib0,9,14™)

set timeouts
Call itimeout(dvm, 10000)
Call itimeout(sw, 10000)

" Set up trigger
argcount = ivprintf(sw, "TRIG:SOUR BUS"™ +
Chr$(10))

" Set up scan list

argcount = ivprintf(sw, "SCAN (@100:103)" +
Chr$(10))

argcount = ivprintf(sw, "INIT" + Chr$(10))

"Display Forml and print voltage measurements
"default form, (Name) "Forml', containing no
“ controls)

Forml.Show
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For i =1 To 4
"Take a measurement
argcount = ivprintf(dvm, "MEAS:VOLT:DC?" +
Chr$(10))

" Read the results
argcount = ivscanf(dvm, "%If", res)

" Print the results
Forml.Print "Result is " + Format(res)

" Trigger switch
argcount = ivprintf(sw, "TRIG" + Chr$(10))
Next i

" Close the sessions
Call iclose(dvm)
Call iclose(sw)

" Tell SICL to cleanup for this task
Call siclcleanup

End Sub

4
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Using GPIB Interface Sessions

I nterface sessions allow direct, low-level control of the specified
interface, but the programmer must provide all bus maintenance settings
for theinterface and must know the technical details about the interface.
Also, when using interface sessions, interface-specific functions must
be used. Thus, the program cannot be used on other interfaces and
becomes less portable.

SICL Functionsfor GPIB Interface Sessions

This section describes how some SICL functions are implemented for
GPIB interface sessions.

Table 22

Implementing SICL Functions for GPIB

Function

Description

iwrite

iread

itrigger

iclear

Sends the specified bytes directly to the interface without
performing any bus addressing. Theiwrite function alwaysclears
the ATN line before sending any bytes, thus ensuring that the
GPIB interface sends the bytes as data, not as command bytes.

Reads the data directly from the interface without performing any
bus addressing.

Performs a broadcast GPIB group execute trigger (GET) without
additional addressing. Use this function with igpibsendcmd to
send a UNL followed by the appropriate device addresses. This
will allow theitrigger function to be used to trigger multiple
GPIB devices simultaneously. Passing the|_TRIG_STD vaueto
the ixtrig function also causes a broadcast GPIB group execute
trigger (GET). There are no other valid values for theixtrig
function.

Performs a GPIB interface clear (pulses IFC), which resets the
interface.
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Addressing GPIB Interfaces

To create an interface session on your GPIB system, specify the
particular interface logical unit or symbolic name in the addr parameter
of theiopen function. Theinterface logical unit and symbolic name are
set by running the Connection Expert utility.

Opening Connection Expert  To open the Connection Expert
utility, click the Agilent 10 Control (1O icon on the taskbar) and click
Agilent Connection Expert. SeethelO Libraries Suite Online Help for
details on this utility. Example interface addresses follow.

Table 23 Interface Names

GPIB An interface symbolic name.
hpib An interface symbolic name.
gpib2 An interface symbolic name.

IEEE488 An interface symbolic name.

7 An interface logical unit.

These code samples open an interface session with the GPIB interface.
C sample:

INST hpib;
hpib = iopen (“hpib™);

Visual Basic sample:
Dim hpib As Integer
hpib = i1open (“hpib™)

GPIB Interface Sessions Interrupts There are specific interface
session interrupts that can be used. See “Writing GPIB Interrupt
Handlers’ in this chapter for more information.

93



4

94

Using SICL with GPIB

GPIB Interface Sessions and Service Requests GPIB interface
sessions support Service Requests (SRQs). On the GPIB interface, when
one deviceissues an SRQ, the library will inform all GPIB interface
sessions that have SRQ handlers installed. For more information, see
“Writing GPIB Interrupt Handlers’ in this chapter.

GPIB Interface Session Code Samples

This section provides C language and Visual Basic language sample
programs for GPIB interface sessions.

Sample: GPIB Interface Session (C)

/* gpibstat.c
This example retrieves and displays GPIB bus
status information. */

#include <stdio.h>
#include <sicl.h>

main()
{
INST id; /* session id */
int rem; /* remote enable */
int srq; /* service request */
int ndac; /* not data accepted */

int sysctlr; /* system controller */
int actctlr; /* active controller */
int talker; /* talker */

int listener; /* listener */

int addr; /* bus address */

/* exit process if SICL error detected */
ionerror(1_ERROR_EXIT);

/* open GPIB iInterface session */
id = 1open(“gpib0”);

itimeout (id, 10000);
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/* retrieve GPIB bus status */
igpibbusstatus(id, 1_GPIB_BUS REM, &rem);
igpibbusstatus(id, 1_GPIB_BUS SRQ, &srq);
igpibbusstatus(id, 1 _GPIB_BUS NDAC, &ndac);
igpibbusstatus(id, 1 _GPIB_BUS_SYSCTLR,

&sysctlr);

igpibbusstatus(id, 1 _GPIB_BUS_ACTCTLR,
&actctlr);

igpibbusstatus(id, 1_GPIB_BUS_TALKER,
&talker);

igpibbusstatus(id, I_GPIB_BUS_LISTENER,
&listener);
igpibbusstatus(id, 1 _GPIB_BUS_ADDR, &addr);

/* display bus status */

printf(“%-5s%-5s%-5s%-5s%-5s%-5s%-5s%-5s\n"",
REM”, “SRQ”,“NDC”, “SYS”, “ACT”,
“TLK”,“LTN”,““ADDR™) ;

printf(“%2d%5d%5d%5d%5d%5d%5d%6d\n”*, rem, srq,
ndac, sysctlr, actctlr, talker, listener,
addr);

/* This call is no-op for WIN32 programs.*/
_siclcleanup(Q);

return O;

}

Sample: GPIB Interface Session (Visual Basic)
“gpibstat._bas

The following example retrieves and displays

“ GPIB bus status information.

Sub main O

Dim id As Integer® session id

Dim remen As Integer® remote enable

Dim srq As Integer* service request

Dim ndac As Integer® not data accepted
Dim sysctlr As Integer® system controller
Dim actctlr As Integer® active controller
Dim talker As Integer® talker

Dim listener As Integer® listener
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Dim addr As Integer® bus address
Dim header As String“ report header
Dim values As String“ report output

“ Open GPIB interface session
id = iopen(*“‘gpib0™)
Call itimeout(id, 10000)

“ Retrieve GPIB bus status

Call igpibbusstatus(id, I_GPIB_BUS REM, remen)

Call igpibbusstatus(id, 1_GPIB_BUS_SRQ, srq)

Call igpibbusstatus(id, I_GPIB_BUS NDAC, ndac)

Call igpibbusstatus(id, 1_GPIB BUS SYSCTLR,
sysctlr)

Call igpibbusstatus(id, 1_GPIB BUS ACTCTLR,
actctlr)

Call igpibbusstatus(id, I_GPIB BUS TALKER,
talker)

Call igpibbusstatus(id, 1_GPIB_BUS_LISTENER,
listener)

Call igpibbusstatus(id, I_GPIB_BUS ADDR, addr)

“ Display forml and print results

forml.Show

forml.Print “REM”; Tab(7); “SRQ”; Tab(14);
“NDC”’;

Tab(21);“SYS”; Tab(28); “ACT”; Tab(35); “TLK”;

Tab(42); “LTN”; Tab(49);“ADDR” forml.Print
remen;

Tab(7); srq; Tab(14); ndac; Tab(21);sysctlr;

Tab(28); actctlr; Tab(35); talker; Tab(42);
listener; Tab(49); addr

“ Tell SICL to clean up for this task
Call siclcleanup

End Sub
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4

Commander sessions are intended for use on GPIB interfaces that are
not the active controller. In this mode, a computer that is not the
controller is acting like a device on the GPIB bus. In acommander
session, the data transfer routines only work when the GPIB interfaceis
not the active controller.

Because the Agilent 82357 USB/GPIB Interface Converter and the
Agilent E5810 LAN to GPIB Gateway do not support non-controller
roles, they also do not support GPIB commander sessions.

SICL Functionsfor GPIB Commander Sessions

This section describes how some SICL functions are implemented for
GPIB commander sessions.

Table24 SICL Functions for GPIB Commander Sessions

Function

Description

iwrite

iread

isetsth

If the interface has been addressed to talk, the datais written
directly to the interface. If the interface has not been addressed
to talk, it will wait to be addressed to talk before writing the
data.

If the interface has been addressed to listen, the datais read
directly from the interface. If the interface has not been
addressed to listen, it will wait to be addressed to listen before
reading the data.

Sets the status value that will be returned on aireadstb call
(that is, when this device is SPOL Led). Bit 6 of the status byte
has a special meaning. If bit 6is set, the SRQ linewill be set. If
bit 6 is clear, the SRQ line will be cleared.

Agilent SICL User’s Guide
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Addressing GPIB Commanders

To create acommander session on your GPIB interface, specify the
particular interface logical unit or symbolic name in the addr parameter
followed by a comma and the string cmdr in the 1open function.

Theinterface logical unit and symbolic name are set by running the
Connection Expert utility. To open Connection Expert, click the Agilent
IO Control (10 icon on the taskbar) and click Agilent Connection
Expert. SeethelO Libraries Suite Online Help for detailson this utility.
Example GPIB addresses for commander sessions follow.

Table 25 Addressing GPIB Commanders

GPIB,cmdr A commander session with the GPIB interface.

gpib0,cmdr A commander session with the gpib0 interface.

7,cmdr A commander session with the interface at logical unit 7.

These code samples open a commander session with the GPIB interface.
C sample:

INST gpib;

gpib = iopen (““‘gpib0,cmdr’);
Visual Basic sample;

Dim gpib As Integer
gpib = iopen (“gpib0O,cmdr’)

GPIB Commander SessionsInterrupts There are specific
commander session interrupts that can be used. See “Writing GPIB
Interrupt Handlers” in the following section for more information.

Writing GPIB Interrupt Handlers

This section provides some additional information for writing interrupt
handlers for GPIB applicationsin SICL.
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Multiplel INTR_GPIB_TLAC Interrupts

Thisinterrupt occurs whenever a device has been addressed to talk or
untalk, or a device has been addressed to listen or unlisten. Due to
hardware limitations, your SICL interrupt handler may be called twice
in response to any of these events.

Your GPIB application should be written to handle this situation
gracefully. This can be done by keeping track of the current talk/listen
state of the interface card and ignoring the interrupt if the state does not
change.

Handling SRQs from Multiple GPIB Instruments

GPIB isamultiple-device busand SICL allows multiple device sessions
open at the same time. On the GPIB interface, when one device issues a
Service Request (SRQ), thelibrary will inform all GPIB device sessions
that have SRQ handlersinstalled.

Thisisan artifact of how GPIB handles the SRQ line. The underlying
GPIB hardware does not support session-specific interrupts like V XI
does. Therefore, your application must reflect the nature of the GPIB
hardware if you expect to reliably service SRQs from multiple devices
on the same GPIB interface.

Itisvital that you never exit an SRQ handler without first clearing the
SRQ line. If the multiple devices are all controlled by the same process,
the easiest technique isto service all devices from one handler. The
pseudo-code for this follows. This algorithm loops through all the
device sessions and does not exit until the SRQ line is released (not
asserted).

while (srqg_asserted) {

serial_poll (devicel)

if (needs_service) service_devicel
serial_poll (device2)

if (needs_service) service_device2

check_SRQ_line
}
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Sample: Servicing Requests (C) This sample showsa SICL
program segment that implements this algorithm. Checking the state of
the SRQ line requires an interface session. Only one device session
needs to execute ionsrq because that handler is invoked regardless of
which instrument asserted the SRQ line. Assuming | EEE-488
compliance, an ireadstb isall that is needed to clear the device's SRQ.

Since the program cannot leave the handler until all devices have
released SRQ, it is recommended that the handler do aslittle as possible
for each device. The previous sample assumed that only oneiscanf was
needed to service the SRQ. If lengthy operations are needed, a better
technique isto perform the ireadstb and set aflag in the handler. Then,
the main program can test the flags for each device and perform the
more lengthy service.

Even if the different device sessions are in different processes, it is still
important to stay in the SRQ handler until the SRQ lineis released.
However, it isnot likely that a process that only knows about Device A
can do anything to make Device B release the SRQ line.

In such a configuration, a single unserviced instrument can effectively
disable SRQs for all processes attempting to use that interface. Again,
thisis a hardware characteristic of GPIB. The only way to ensure true
independence of multiple GPIB processes isto use multiple GPIB
interfaces.

/* Must be global */
INST idl, id2, bus;

void handler (dummy)

INST dummy;
{
int srg_asserted = 1;
unsigned char statusbyte;

/* Service all sessions in turn until no one is
requesting service */
while (srqg_asserted) {
ireadstb(idl, &statusbyte);
if (statusbyte & SRQ BIT)
{
/* Actual service actions depend upon the
application */
iscanf(idl, “%f’, &datal);
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}
ireadstb(id2, &statusbyte);
if (statusbyte & SRQ BIT){
iscanf(id2, “%f’, &data2);
}
igpibbusstatus(bus, 1 _GPIB_BUS_ SRQ,
&srqg_asserted);
}
}

main() {

/* Device sessions for instruments */
idl = iopen(“gpib0, 17);
id2 iopen(“‘gpib0, 187);

/* Interface session for SRQ test */
bus = i1open(“gpib0”);

/* Only one handler needs to be installed */
ionsrq(idl, handler);
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Using SICL with VXI

This chapter shows how to use SICL to communicate over the VXIbus.
The sample programs in this chapter can be found in the following
locations, if Agilent 1O Libraries Suite was installed in the default
directory:

For C/C++:C:\Program Files\Agilent\IO Libraries Suite\
ProgrammingSamples\C\SICL\

For Visual Basic:

C:\Program Files\Agilent\I0 Libraries Suite\
ProgrammingSamples\VB6\SICL\

This chapter includes:

* Introduction to VXI Interfaces

» Programming V X| Message-Based Devices

e Programming VXI Register-Based Devices

* Programming V XI Interface Sessions

» Miscellaneous VXI Interface Programming

Agilent Technologies 103




5 Using SICL with VXI

Introduction to VXI Interfaces

This section provides an introduction to using SICL with the VXI
interface, including:

» VXI Interfaces Overview

* VXI Communications Sessions
* VXI Device Types

» SICL Functionsfor VXI
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VXI Interfaces Overview

This section provides an overview of VXI interfaces, including typical
hardware configuration, using Connection Expert, and example
configuration using SICL.

Typical VXI Interface

As shown in the following figure, atypical VXI interface consists of
one of two main hardware configurations. E1406A Command Module
or E8491B IEEE-1394 to VXI Module.

» The E1406A Command M odule version consists of a Windows PC
with an 82350 (or equivalent) GPIB card and a V' X| mainframe with
an E1406A Command Module and one or more VX1 instruments.
I/0O communication from the PC to the VX1 instrumentsisviathe
GPIB card, GPIB cable, and E1406A Command Module.

» The E8491B Module version consists of a Windows PC with an
|EEE-1394 OHCI-Compliant (FireWire) PC card and a VX
mainframe with an E8491B IEEE-1394 to VX Module and one or
more V XI instruments. I/O communication from the PC to the VXI
instrumentsisviathe PC card, IEEE-1394 to V X| cable, and E8491B
Module.
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4 )

VXI Interfaces
Windows PC VXI Mainframe
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X X X
E | | |
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Configuring VXI Interfaces

An 10 interface can be defined as both a hardware interface and as a
software interface. One function of the Connection Expert utility isto
associate a unique interface name with a hardware interface.

SICL uses an Interface Name or Logical Unit Number to identify an
interface. Thisinformation is passed in the parameter string of theiopen
function call in a SICL program. Connection Expert assigns a default
Interface Name and Logical Unit Number, as well as other necessary
configuration values, when the interface hardware is configured; you
can change these values by running the Connection Expert utility. See
the Connect 1O Works Online Help for details.
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Example: VXI (E1406A) Interface

The VXI interface system in the following figure consists of a Windows
PC with an 82350 GPIB card that connects to an E1406A Command
Modulein aVXI Mainframe. The VX1 mainframe includes one or more
VX1 instruments. The E1406A is configured for primary address 9 and
logical address (LA) 0. The three VX1 instruments shown have logical
addresses 8, 16, and 24.

The Connection Expert utility has been used to assign the 82350 GPIB
card a SICL name of gpib0. With these names assigned to the
interfaces, the SICL addressing is as shown in the figure. For
information on the E1406A Command Module, see the Agilent E1406A
Command Module User’s Guide. For information on V X1 instruments,
see the applicable VXI Instrument User’s Guide.

VI Interface (E14004 Command Madule)

Windows PC WEI Maindrame
W W y
] ] 4
| | |
Primary E
Address 5 1
i | | |
| i r n n
32350 GPE Cad i L 1 I
GPIE r r f
L&D LAE L& 24 LA1E

SICL Addressing

e [ gpbl S 37
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e I0Y path 1o Wi wrestr sl al loqica | addiess 2 sang
BEZ550 GHE Cand and E14084 1 Command Module at
GFIE primary addness 3 (WX bgical address 28 mapsio
GFE sacondary address 246 = 3)
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Example: VXI (E8491) Interface

-

The VXl interface system in the following figure consists of aWindo
PC with an E8491 PC card that connects to an E8491B |EEE-1394 to
VXI Modulein aVXI Mainframe. The VXI mainframe includes one or
more V XI instruments. For this system, the three VX1 instruments
shown have logical addresses 8, 16, and 24.

The Connection Expert utility has been used to assign the E8491 PC
card a SICL name of vxi. With this name assigned to the interface, you
can usethe SICL addressing shown in thefigure. For information on the
E8491B module, see the Agilent E8491B User’s Guide. For information
on VXI instruments, see the applicable VXI Instrument User’s Guide.

~

VXI Interface (E18491B |IEEE-1394 to VXI Module)

Interface SICL Name Windows PC IEEE-1394 to VXI VXI Mainframe

\Y) Vv \Y

X X X

E | | |

i | | |

SICL Name 9 n n n

1 S S S

"vxi E8491 PC Card B t t t

r r r

LA 8 LA 24 LA 16

-

SICL Addressing

iopen ("vxi,24")

Open 10 path to VXI instrument at logical address 24 using
E8491 PC Card and E8491 IEEE-1394 to VXI Module
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VXI Communications Sessions

Before you begin programming your VXI system, ensure that the
system is set up and operating correctly. To begin programming a VXl
system, you must first determine the type of communication session to
be used. The two types of supported VXI communication sessions
follow. Commander Sessions are not supported with VX1 interfaces.

» Device Session. A VXI device session allows direct accessto a
device regardless of the type of interface to which the deviceis
connected.

* Interface Session. A VXI interface session allows direct, low-level
control of the specified interface that provides full control of the
activities on agiven interface, such as VXI.

Device sessions are the recommended method for communicating while
using SICL, since they provide the highest level of programming, best
overall performance, and best portability.

VXI Device Types

Agilent SICL User’s Guide

There are two different types of VX1 devices: message-based and
register-based. To program a V Xlbus system that is mixed with both
message-based and register-based devices, open a communications
session for each device in the system and program as shown in the
following sections.

M essage-Based Devices

M essage-based devices have their own processors that allow them to
interpret high-level Standard Commands for Programmable I nstruments
(SCPI) commands. When using SICL, place the SCPI command within
the SICL output function call and the message-based device then
interprets the SCPI command.

Register-Based Devices

Register-based devices typically do not have their own processor to
interpret high-level commands and therefore accept only binary data.
You can use the following methods to program register-based devices:
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Interpreted SCPI. Use the SICL iscpi interface and program using
high-level SCPI commands. Interpreted SCPI (I-SCPI) interprets
high-level SCPI commands and sends the data to the instrument.
I-SCPI is supported over LAN, but register programming (imap,
ipeek, ipoke, etc.) isnot supported over LAN. I-SCPI runsonaLAN
server in aLAN-based system.

Direct Register programming. Do register peeks and pokes and
program directly to the device's registers with the vxi interface.

Compiled SCPI. Use the C-SCPI product and program with
high-level SCPI commands (achieve higher throughput as well).

Command Module. Use a Command Module to interpret the
high-level SCPI commands. The gpib interface is used with a
Command Module. A Command Module may also be accessed over
aLAN using aLAN-to-GPIB gateway.

SICL Functionsfor VXI Interfaces

A summary of VXI-specific functions follows. Using these VX1
interface-specific functions means that the program cannot be used on
other interfaces and, therefore, becomes less portable. These functions
will work over aL AN-gatewayed session if the server supports the
operation.

Table26 SICL Functionsfor VXI Interfaces

Function Name Action

ivxibusstatus Returns requested bus status information
ivxigettrigroute Returns the routing of the requested trigger line
ivxirminfo Returns information about V X| devices
ivxiservants | dentifies active servants

ivxitrigoff De-asserts VXI trigger line(s)

ivxitrigon Asserts VX1 trigger line(s)

ivxitrigroute Routes V XI trigger lines

ivxiwaitnormop Suspends until normal operation is established
ivxiws Sends aword-serial command to adevice
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M essage-based devices have their own processors which allow them to
interpret high-level SCPI commands. When using SICL, place the SCPI
command within the SICL output function call and the message-based
deviceinterprets the SCPI command. SICL functions used for
programming message-based devicesinclude iread, iwrite, iprintf,
iscanf, etc.

If a message-based device has shared memory, you can access the
device's shared memory with register peeks and pokes. See
“Programming V X| Register-Based Devices’ for information on
register programming.

VXI Message-Based Device Functions

This section describes how some SICL functions are implemented for
V XI device sessions for message-based devices.
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Table 27 VXI Device Functions

Function name  Action

iwrite Sends data to a (message-based) servant using the
byte-serial write protocol and the byte available
word-serial command.

iread Reads data from a (message-based) servant using the
byte-serial read protocol and the byte request word-serial
command.

ireadstb Performs aVX| readSTB word-serial command.

itrigger Sends word-serial trigger to specified message-based
device.

iclear Sends word-serial device clear to specified
message-hased device.

ionsrq Can be used to catch SRQs from message-based devices.

Addressing VXI M essage-Based Devices

To create a V X1 device session, specify the interface symbolic name or
logical unit and adevice's addressin the addr parameter of the iopen
function. The interface symbolic name and logical unit are set by
running the Connection Expert utility. To open Connection Expert, click
the Agilent 1O Control (10 icon on the taskbar) and click Agilent
Connection Expert. Seethe 1O Libraries Suite Online Help for details
on this utility.

Addressing Guidelines

Primary address must be between 0 and 255. The primary address
corresponds to the VX1 logical address and specifies the addressin the
A16 space of the VXI device. SICL supports only primary addressing
on the VXI device sessions. Specifying a secondary address causes an
error.

Some example addresses for VX| device sessions follow. These
exampl es use the default symbolic name specified during the system
configuration. To change the name listed, you must also change the
symbolic name or logical unit specified during the configuration. The
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name used in the SICL program must match the logical unit or symbolic
name specified in the system configuration. Other possible interface
names are VXI, vxi, etc.

Table 28 Addressing VXI Instruments

vXi,24 A device address corresponding to the device at primary address
24 on the vxi interface.

vxi,128 A device address corresponding to the device at primary address
128 on the vxi interface.

An example of opening a device session with the VXI device at logical
address 64 follows.

INST dmm;
dmm = ifopen (“vxi,64);

Sample: VXI Message-Based Device Session (C)

This sample program opens a communication session with a VXl
message-based device and measures the AC voltage. The measurement
results are then printed.

/* vximdev.c
This example program measures AC voltage on a
multimeter and prints out the results */

#include <sicl.h>
#include <stdio.h>

main()
{
INST dvm;
char strres[20];

/* Print message and terminate on error */
ionerror (I_ERROR_EXIT);

/* Open the multimeter session */
dvm = ifopen (“vxi,24”");
itimeout (dvm, 10000);
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/* Initialize dvm */
iwrite (dvm, “*RST\n”, 5, 1, NULL);

/* Take measurement */

iwrite (dvm,”MEAS:VOLT:AC? 1, 0.001\n”, 23, 1,
NULL);

/* Read measurements */
iread (dvm, strres, 20, NULL, NULL);

/* Print the results */
printf(“Result is %s\n”, strres);

/* Close the multimeter session */
iclose(dvm);

}

Sample: VXI Message-Based Device Session (Visual Basic)

vximdev.bas

This example program opens a communication
session with a VXI message-based device and
measures the DC voltage. Then measurement
results are printed.

Sub Main(Q)

Dim id As Integer

Dim strres As String * 80 “Fixed-length String
Dim actual As Long

" Open the iInstrument session

"vxi" is the SICL Interface name as defined
in Connection Expert

"'"216" is the instrument logical address.
"Change these to the SICL name and logical

“ address for your instrument

id = iopen('vxi,216")
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" Set timeout to 10 seconds
Call itimeout(id, 10000)

Initialize dvm
Call iwrite(id, "*RST" + Chr$(10), 6, 1, 08&)

" Take measurement
Call iwrite(id, "MEAS:VOLT:DC? 1, 0.001"™ + _
Chr$(10), 23, 1, 0&)

" Read result
Call iread(id, strres, 80, 0&, actual)

" Display the results
MsgBox ""Result is: " + strres, vbOKOnly, _
"DVM DCV Result"

" Close the instrument session
Call iclose(id)

" Tell SICL to clean up for this task
Call siclcleanup

End Sub

Programming VXI Register-Based Devices

Agilent SICL User’s Guide

You can use one or more of the following methods to communicate with
V XI register-based devices.

I-SCPI Interface Programming. Usethe SICL iscpi interface and
program using SCPI commands. The iscpi interface interprets the
SCPI commands and allows direct communication with
register-based devices. This method is supported over LAN. Agilent
VISA must beinstalled to use the iscpi interface.

Direct Register Programming. Use the vxi interface to program
directly to the device's registers with a series of register peeks and
pokes. This method can be very time-consuming and difficult. This
method is not supported over LAN.
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» Compiled SCPI Programming. The Compiled SCPI (C-SCPI)
product is a programming language that can be used with SICL to
program register-based devices using SCPI commands. Because
Compiled SCPI interprets SCPI commands at compile time,
Compiled SCPI can be used to achieve high throughput of
register-based devices. See the applicable C-SCPI documentation for
programming information.

e Command M odule Programming. You can use a Command
Module to communicate with VXI devices via GPIB. The Command
Module interprets the high-level SCPI commands for register-based
instruments and sends low-level commands over the V XIbus
backplane to the instruments. See Chapter 4, “ Using SICL with
GPIB” for details on communicating viaa Command Module.

Addressing VXI Register-Based Devices

To create a device session, specify the interface symbolic name or
logical unit and adevice's addressin the addr parameter of the iopen
function. The interface symbolic name and logical unit are set by
running the Connection Expert utility. To open Connection Expert, click
the Agilent 1O Control (10 icon on the taskbar) and click Agilent
Connection Expert. Seethe 1O Libraries Suite Online Help for details
on this utility.

Functions Not Supported

Because VXI register-based devices do not support the word serial
protocol and other features of message-based devices, the following
SICL functions are not supported with register-based device sessions
unlessyou use the iscpi interface. All other functions will work with all
VX1 devices (message-based, register-based, etc.). Use the i?peek and
i?poke functions to communi cate with register-based devices.

Table29 Unsupported Functions

Category Functions Not Supported

Non-formatted |/O iread, iwrite, itermchr

Formatted 1/O iprintf, iscanf, ipromptf, ifread, ifwrite, iflush,
isetbuf, isetubuf

Device/lnterface Control  iclear, ireadstb, isetstb, itrigger
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Table29 Unsupported Functions

Category Functions Not Supported
Service Requests igetonsrq, ionsrq
Timeouts igettimeout, itimeout

VXI Specific ivxiws

Addressing Guidelines

The primary address corresponds to the VXI logical address and must

be between 0 and 255. SICL supports only primary addressing on VXI
device sessions. Specifying a secondary address causes an error. Some
example addresses for VXI device sessions follow.

These examples use the default symbolic name specified during the
system configuration. To change the name listed, you must also change
the symbolic name or logical unit specified during the configuration.
The name used in your SICL program must match the logical unit or
symbolic name specified in the system configuration. Other possible
interface names are VX1, vxi, etc.

Table 30 Addressing Guidelines

iscpi,32 A register-based device address corresponding to the device at
primary address 32 on the iscpi interface.

vXi,24 A device address corresponding to the device at primary address
24 on the vxi interface.

vxi,128 A device address corresponding to the device at primary address
128 on the vxi interface.

An example of opening a device session with the VXI device at logical
address 64 follows.

INST dmm;
dmm = i1open (“‘vxi,64");
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Programming Directly to Registers
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When communicating with register-based devices, you must either send
a series of peeks and pokes directly to the device's registers or use a
command interpreter to interpret the high-level SCPI commands.
Command interpreters include the iscpi interface, Agilent Command
Module, Agilent B-Size Mainframe (built-in Command Module), or
Compiled SCPI (C-SCPI).

When sending a series of peeks and pokes to the device's registers, use
the following process. This procedure is only used on register-based
devicesthat are not using theiscpi interface. Note that programming
directly to the registersis not supported over LAN.

» Map memory space into your process space.
» Read the register’s contents using i ?peek.

» Writeto the device registers using i ?poke.

*  Unmap the memory space.

Mapping Memory Space for Register-Based Devices

When using SICL to communicate directly to the device'sregisters, you
must map a memory space into the process space by using the SICL
imap function:

imap (id, map_space, pagestart, pagecnt,
suggested);

This function maps space for the interface or device specified by theid
parameter. pagestart, pagecnt, and suggested indicate the page number,
number of pages, and a suggested starting location respectively.
map_space determines the memory location to map the space to.

Due to hardware constraints on given devices or interfaces, not all
address spaces may be implemented. In addition, there may be a
maximum number of pages that can be simultaneously mapped.

If arequest is made that cannot be granted due to hardware constraints,
the process will hang until the desired resources become available. To
avoid this, use the isetlockwait with the flag parameter set to O and thus
generate an error instead of waiting for the resources to become
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available. You may aso use the imapinfo function to determine
hardware constraints before making an imap call. Some valid
map_space choices follow.

Table31 Mapping Memory Space

5

Function Description

I_MAP_A16 Mapsin VXI A16 address space (device or interface
sessions, 64K byte pages).

I_MAP_A24 Mapsin VXI A24 address space (device or interface
sessions, 64K byte pages).

I_MAP_A32 Mapsin VXI A32 address space (device or interface
sessions, 64K byte pages).

I_MAP_VXIDE MapsinVXI A16 device registers (device session only,
64 bytes).

<

I_MAP_EXTEN Mapsin VXI device extended memory address spacein
A24 or A32 address space (device sessions only).

@)

I_MAP_SHARE MapsinVXI A24/A32 memory that is physically located
D on the computer (sometimes called local shared memory,
interface sessions only).

I_MAP_AM | Maps in the specified region (address modifer) of VME

address modifer  address space. See the “Communicating with VME
Devices’ section later in this chapter for more
information on this map space argument.

Some example imap function calls follow.

/* Map to the VXI device vm starting at
pagenumber 0 for 1 page */

base address = imap (vm, 1_MAP_VXIDEV, O, 1,
NULL);

/* Map to A32 address space (16 Mbytes) */
ptr = imap (id, 1_MAP_A32, 0x000, 0x100,
NULL);

/* Map to device’s A24 or A32 extended memory */

ptr=imap (id, I_MAP_EXTEND, 0, 1, 0);
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/* Map to computer’s A24 or A32 shared memory */
ptr=imap (id, I_MAP_SHARED, 0, 1, 0);

Use the following table to determine which map-space argument to use
with a SICL imap/iunmap function. All accesses through the* D32
map windows can only be 32-bit transfers. The application software
must do a 32-bit assignment to generate the access and only accesses on
32-bit boundaries are allowed. If 8- or 16-bit accessesto the device are
also necessary, anormal |_MAP_A16/24/32 map must also be
requested.

Table 32 Mapping Memory Space

imap/iunmap Widths VME Data Access Mode
(map-space ar gument)

I_MAP_A16 D8,D16 Supervisory

I_MAP_A24 D8,D16 Supervisory

I_MAP_A32 D8,D16 Supervisory

I_MAP_A16 D32 D32 Supervisory

I_MAP_A24 D32 D32 Supervisory

I_MAP_A32 D32 D32 Supervisory

Reading and Writing Device Registers

When you have mapped the memory space, use the SICL i?peek and
i?poke functions to communicate with register-based instruments. With
these functions, you need to know which register you want to
communicate with and the register’s offset. See the instrument’suser’s
manual for a description of the registers and register locations. An
example using iwpeek follows.

id = iopen (“vxi,24”);
addr = imap (id, I1_MAP_VXIDEV, 0, 1, 0);
reg_data = iwpeek (addr + 4);

Be sure you use the iunmap function to unmap the memory space when
the space is no longer needed. Thisfreesthe mapping hardware so it can
be used by other processes.
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Sample: VXI Register-Based Programming (C)

Agilent SICL User’s Guide

This sample program opens a communication session with a
register-based device connected to the address entered by the user. The
program then reads the | d and Device Type registers and prints the
register contents.

/* vxirdev.c

The following example prompts the user for an
instrument address and then reads the id
register and device type register. The contents
of the register are displayed.*/

#include <stdio.h>
#include <stdlib.h>
#include <sicl.h>

void main Q{
char inst_addr[80];
char *base_addr;
unsigned short id_reg, devtype reg;
INST id;

/* get instrument address */

puts (““Please enter the logical address of the
register-based instrument, for example,
vxi,24 - \n”);

gets (inst_addr);

/* install error handler */
ionerror (I_ERROR_EXIT);

/* open communication session with instrument

*/
id = 1open (inst_addr);
itimeout (id, 10000);
/* map Into user memory space */
base _addr = imap (id, I_MAP_VXIDEV, 0, 1,
NULL);
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/* read registers */

id_reg = iwpeek ((unsigned short *)(base_addr
+ 0x00));

devtype_reg = iwpeek ((unsigned short
*)(base_addr + 0x02));

/* print results */
printf (“Instrument at address %s\n”,
inst_addr);

printf “ID Register = 0x%4X\n Device Type
Register =0x%4X\n”, 1d_reg, devtype req);

/* unmap memory space */
iunmap (id, base_addr, I_MAP_VXIDEV, 0, 1);

/* close session */
iclose (id);}
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Programming VXI Interface Sessions

VXI interface sessions alow direct low-level control of the interface.
However, the programmer must provide al bus maintenance for the
interface and have considerable knowledge of the interface. When using
interface sessions, you must use interface-specific functions, which
means the program cannot be used on other interfaces and becomes less
portable.

VXI Interface Sessions Functions

The following table describes how some SICL functions are
implemented for VXI interface sessions. |-SCPI interface sessions only
support service requests and locking (ionsrq, ilock, and iunlock).

Table 33 Implementing SICL Function for VXI

Function Name Action

iwriteand iread  Not supported for VX1 interface sessions. Returns the
I_ERR_NOTSUPP error.

iclear Causes the VXI interface to perform a SY SREST on
interface sessions. This causes al VX1 devicesto reset. If
the iscpi interface is being used, the iscpi instrument will
be terminated.

If this happens, aNo Connect error message occurs and
you must reopen the iscpi communications session. All
servant devices cease to function until the VVXI resource
manager runs and normal operation is re-established.

Addressing VXI Interface Sessions

Agilent SICL User’s Guide

To create an interface session on a VXI system, specify the interface
symbolic name or logical unit in the addr parameter of the iopen
function. The interface symbolic name and logical unit are set by
running the Connection Expert utility. To open Connection Expert, click
the Agilent 1O Control (IO icon on the taskbar) and click Agilent
Connection Expert. Seethe O Libraries Suite Online Help for details
on this utility.
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Addressing Guidelines

Some example addresses for VXI interface sessions follow. These
exampl es use the default symbolic name specified during the system
configuration. To change the name listed, you must also change the
symbolic name or logical unit specified during the configuration.

The name used in your SICL program must match the logical unit or
symbolic name specified in the system configuration. Other possible
interface names are VX1, vxi, etc. The only interface session operations
supported by I-SCPI are service requests and locking.

Table 34 Symboalic Interface Names

vXi An interface symbolic name.

iscpi Aninterface symbolic name.

This example opens an interface session with the VXI interface.

INST vxi;
vxi = iopen (“vxi”);

Sample: VXI Interface Session (C)

This sample program opens a communication session with the VX1
interface and uses the SICL interface-specific ivxirminfo function to
get information about a specific VXI device. Thisinformation comes
from the VV XI resource manager and is only valid as of the last time the
VXI resource manager was run.

/* vxiintr.c
The following example gets information about a
specific vxi device and prints it out. */

#include <stdio.h>
#include <sicl.h>

void main Q {
int laddr;
struct vxiinfo info;
INST 1id;
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/* get instrument logical address */

printf (“Please enter the logical address of
the register-based instrument, for example,
24 : \n”);

scanf (“%d”, &laddr);

/* install error handler */
ionerror (1_ERROR_EXIT);

/* open a vxi interface session */
id = 1i1open (“vxi”);
itimeout (id, 10000);

/* read VXI resource manager information for
specified device*/
ivxirminfo (id, laddr, &info);

/* print results */

printf (“Instrument at address %d\n”, laddr);

printf (“Manufacturer’s Id = %s\n Model =
%s\n”’, info.manuf_name, info.model name);

/* close session */
iclose (id);

}

5
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Miscellaneous V XI Interface Programming
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This section provides other information for programming viathe VXI
interface, including:

» Communicating with VME Devices
» VXI Backplane Memory /O Performance
» Using VXI-Specific Interrupts

Communicating with VM E Devices

Although VXI isan extension of VME, VME isnot easy touseinaVXI|
system. Sincethe V X| standard defines specific functionality that would
be custom designsin VME, some resources required for VME custom
design are actually used by VXI. Therefore, there are certain limitations
and requirements when using VME in aVXI system.

VME isnot an officially supported interface for SICL and is not
supported over LAN.

Use these processes when using VME devicesin aVXI mainframe:
» Declaring Resources

* Mapping VME Memory

» Reading and Writing Device Registers

»  Unmapping Memory

Declaring Resources

The VX1 Resource Manager does not reserve resources for VME
devices. Instead, a configuration file is used to reserve resources for
VME devicesinaVXI| system. Usethe VXI Device Configurator to edit
the DEVICES file (or edit thefile directly) to reserve resources for

VME devices. The VXI Resource Manager reads thisfile to reserve the
VME address space and VME IRQ lines. The VXI Resource Manager
then assigns the VX1 devices around the already reserved VME
resources.
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For VME devices requiring A16 address space, the device's address
space should be defined in the lower 75% of A 16 address space
(addresses below 0xC000). Thisis necessary because the upper 25% of
A16 address space is reserved for VXI devices.

For VME devices using A24 or A32 address space, use A24 or A32
address ranges just higher than those used by your VX1 devices. This
will prevent the VXI Resource Manager from assigning the address
range used by the VME deviceto any VXI device. (The A24 and A32
address range is software programmable for VX1 devices.)

Mapping VME Memory

SICL defaults to byte, word, and longword supervisory access to
simplify programming VXI systems. However, some VME cards use
other modes of access that are not supported in SICL. Therefore, SICL
provides a map parameter that allows you to use the access modes
defined in the VMEbus Specification. See the VMEbus Specification for
information on these access modes.

Use care when mixing VXI and VME devices. You must know the
VME address space and offset within that address space the VME
devices use. VME devices cannot use the upper 16K of the A16 address
space since this areais reserved for VXI instruments.

When accessing VME or VXI devices via an embedded controller,
current versions of SICL use the “ supervisory data’ address modifiers
0x2D, 0x3D, and 0x0OD for A16, A24, and A32 accesses, respectively.
(Some older versions of SICL use the “non-privileged data” address
modifiers.)

Usethel _MAP_AM | address modifer map space argument in the
imap function to specify the map space region (address modifer) of
VME address space. See the VMEbus Specifications for information on
values to use as the address modifier. If the controller does not support
the specified address mode, the imap call will fail (seetable in the next
section).
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This maps A24 non-privileged data access mode:

prt = imap (id, (I_MAP_AM ] 0Ox39), 0x20, 0x4,
0);

This maps A32 non-privileged data access mode:

prt = imap (id, (1_MAP_AM | O0x09), 0x20, 0x40,
0):

Thistable lists VME access modes supported on Agilent controllers.

Table35 VME Mapping Support

Al6 A24 A32
D08 D16 D32 D08 D16D32 D08D16 D32

Supervisory data X X X X X X X X X
Non-Privileged data

Reading and Writing Device Registers

After you have mapped the memory space, use the SICL i?peek and
i?poke functions to communicate with the VME devices. With these
functions, you need to know the register to communicate with and the
register’s offset.

See the instrument’s user’s manual for descriptions of registers and
register locations. Thisis an example using iwpeek:

id = iopen (“vxi”);

addr = imap (id, (1_MAP_AM | 0x39), 0x20, 0x4,
0);

reg_data = iwpeek ((unsigned short *)(addr +
0x00));

Unmapping Memory Space

Make sure you use the iunmap function to unmap the memory space
when it isno longer needed. This frees the mapping hardware so it can
be used by other processes.
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VME Interrupts

There are seven VME interrupt lines that can be used. By default, VXI
processing of the IACK value will be used. However, if you configure
VME IRQ lines and VME Only, no VXI processing of the IACK value
will bedone. That is, the IACK value will be passed to a SICL interrupt
handler directly.

Sample: VME Interrupts (C)

ThisANSI C sample program opens a V X1 interface session and sets up
an interrupt handler. Whenthe | INTR_VME_IRQL interrupt occurs,
the function defined in the interrupt handler is called. The program then
writes to the registers, causing thel_INTR_VME_IRQ1 interrupt to
occur.

You must edit this program to specify the starting address and register
offset of your specific VME device. This sample program also requires
the VME deviceto beusing | _INTR_VME_IRQ1, and the controller to
be the handler for the VME IRQ1.

/* vmedev.c

This example program opens a VXl interface
session and sets up an interrupt handler. When
the specified interrupt occurs, the procedure
defined in the interrupt handler is called. You
must edit this program to specify starting
address and register offset for your specific
VME device. */

#include <stdio.h>
#include <stdlib.h>
#include <sicl.h>

#define ADDR “‘vxi”

void handler (INST id, long reason, long
secval){
printf (“Got the interrupt\n™);

}
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void main
{
unsigned short reg;
char *base_addr;
INST id;

/* install error handler */
ionerror (1_ERROR_EXIT);

/* open an interface communications session */
id = iopen (ADDR);
itimeout (id, 10000);

/* install interrupt handler */
ionintr (id, handler);
isetintr (id, I_INTR_VME_IRQ1, 1);

/* turn interrupt notification off so that
interrupts are not recognized before the
iwaithdlr function is called*/

iintroff ;

/* map into user memory space */
base addr = imap (id, 1_MAP_A24, 0x40, 1,
NULL);

/* read a register */
reg = twpeek((unsigned short *)(base_addr +
0x00));

/* print results */
printf (“The registers contents were as
follows: Ox%4X\n”, reg);

/* write to a register causing interrupt */
iwpoke ((unsigned short *)(base_addr + 0x00),
reg);

/* wait for interrupt */
iwaithdlr (10000);

/* turn interrupt notification on */
iintron ;

/* unmap memory space */
iunmap (id, base_addr, 1_MAP_A24, 0x40, 1);
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/* close session */
iclose (id);

}

VXI Backplane Memory I/O Performance

Agilent SICL User’s Guide

SICL supports two different memory 1/0O mechanisms for accessing
memory on the VX1 backplane.

Table36 VXI Supported Memory 1/0O Mechanisms

Single location peek/poke and imap, iunmap, ibpeek, iwpeek, ilpeek,
direct memory dereference ibpoke, iwpoke, ilpoke, value = *pointer,
*pointer = value

Block memory access imap, iunmap, ibblockcopy, iwblockcopy,
ilblockcopy, ibpushfifo, iwpushfifo,
ilpushfifo ibpopfifo, iwpopfifo, ilpopfifo

Using Single L ocation Peek/Poke

Single location peek/poke or direct memory dereference is the most
efficient in programs that require repeated access to different addresses.
On many platforms, the peek/poke operations are actually macroswhich
expand to direct memory dereferencing.

An exception is Windows platforms, where ipeek/ipoke are
implemented as functions since (under certain conditions) the compiler
will attempt to optimize a direct dereference and cause aV X1 memory
access of the wrong size.

For example, when masking the results of a 16-bit read in an expression:
data = iwpeek(addr) & Oxff;

the compiler will simplify thisto an 8-bit read of the contents of the
addr pointer. Thiswould cause an error when attempting to read
memory on aVXI card that did not support 8-bit access. When iwpeek
isimplemented as a function, the correct size memory accessis
guaranteed.

131



5 Using SICL with VXI

Using Block Memory Access

The block memory access functions provide the highest possible
performance for transferring large blocks of datato or from the VXI
backplane. Although these calls have higher initial overhead than the
ipeek/ipoke calls, they are optimized on each platform to provide the
fastest possible transfer rate for large blocks of data.

These routines may use DMA, which is not available with ipeek/ipoke.
For small blocks, the overhead associated with the block memory access
functions may actually make these calls longer than an equivalent loop

of ipeek/ipoke calls.

The block size at which the block functions become faster depends on
the particular platform and processor speed.

Sample: VXI Memory 1/O (C)

A code sample follows that demonstrates the use of simple and block
memory 1/0O methodsin SICL.

/*

siclmem.c

This example program demonstrates the use of
simple and block memory 1/0 methods in SICL. */

#include <sicl.h>
#include <stdlib.h>
#include <stdio.h>

#define VXI_INST “vxi,b24”

void main O {
INST id;
unsigned short *memPtrl6;
unsigned short id_reg;
unsigned short devtype reg;
unsigned short memArray[2];
int err;

/* Open a session to the instrument */
id = 1open(VXI_INST);
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/> Simple memory 1/0==========
wpeek ()
irect memory dereference

=1
=d
On many platforms, the ipeek/ipoke operations
are actually macros which expand to direct
memory dereferencing. The exception is on
Microsoft Windows platforms where ipeek/ipoke
are implemented as functions.

This is necessary because under certain
conditions, the compiler will attempt to
optimize a direct dereference and cause a VXI
memory access of the wrong size. For example,
when masking the results of a 16-bit read in a
expression:

data = iwpeek(addr) & Oxff;

the compiler will simplify this to an 8-bit
read of the contents of the addr pointer. This
would cause an error when attempting to read
memory on a VXI card that did not support 8-bit
access. */

/* Map into memory space */
memPtrl6é = (unsigned short *)imap(id,
I_MAP_VXIDEV, 0, 1, 0);

/> ============ Using Peek */

/* Read instrument id register contents */
id_reg = itwpeek(memPtrl6);

/* Read device type register contents */
id_reg = iwpeek(memPtrl6+1);

/* Print results */

printf(“ iwpeek: 1D Register = 0Ox%4X\n”,
id_reg);

printf(“ iwpeek: Device Type Register =
Ox%4X\n”’, devtype_reg);
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/* Use direct memory dereferencing */
id_reg = *memPtrl6;
devtype_reg = *(memPtrl6+1);

/* Print results */

printf(“dereference: 1D Register = 0x%4X\n”,
id_reg);

printf(“dereference: Device Type Register =
Ox%4X\n”’, devtype_reg);

N

* Block Memory 1/0 ==========
iwblockcopy

iwpushfifo

iwpopTfifo

These commands offer the best performance for
reading and writing large data blocks on the
VX1 backplane. For this example, we are only
moving 2 words at a time. Normally, these
functions would be used to move much larger
blocks of data. */

/* ======== Demonstrate Block Read ======== */

/* Read the instrument id register and device
type register into an array. */

err = iwblockcopy(id, memPtrl6, memArray, 2,
0);

/* Print results */

printf(*“ iwblockcopy: ID Register = Ox%4X\n”,
memArray[0]);

printf(“ iwblockcopy: Device Type Register =
Ox%4X\n’, memArray[1]);

/* ======= Demonstrate popfifo */

/* Do a popfifo of the Id Register */
err = twpopfifo(id, memPtrl6, memArray, 2, 0);
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/* Print results */

printf(“ iwpopfifo: 1 ID Register = Ox%4X\n”,
memArray[0]);

printf(“ iwpopfifo: 2 ID Register = Ox%4X\n”,
memArray[1]);

J* ============ Cleanup and ExXit ==========%*/

/* Unmap memory space */

iunmap(id, (char *)memPtrl6, 1_MAP_VXIDEV, O,
1);

/* Close instrument session */

iclose(id);

}

Using VXI-Specific Interrupts

Agilent SICL User’s Guide

Sample: VXI Interrupt Actions (C)

This pseudo-code describes the actions performed by SICL when a
VME interrupt arrives and/or a VXI signal register write occurs.

VME Interrupt arrives:
get iack value

send I1_INTR_VME_IRQ?
is VME IRQ line configured VME only

if yes then
exit
do lower 8 bits match logical address of one of
our servants?
if yes then
/* 1i1ack is from one of our servants */
call servant_signal_processing(iack)
else
/* i1ack is from non-servant VX1 or VME device*/
send 1_INTR_VXI_VME interrupt to interface
sessions

Signal Register Write occurs:
get value written to signal register
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send 1_INTR_ANY_SIG
do lower 8 bits match logical address of one of
our servants?
if yes then
/* Signal is from one of our servants */
call Servant_signal_processing(value)
else
/* Stray signal */
send 1_INTR_VXI_UKNSIG to interface sessions
servant_signal_processing (signal_value)
/* Value is form one of our servants */
is signal value a response signal?
If yes then
process response signal
exit
/* Signal is an event signal */
is signal an RT or RF event?
if yes then
/* A request TRUE or request FALSE arrived */
process request TRUE or request FALSE event
generate SRQ if appropriate
exit
is signal an undefined command event?
if yes then
/* Undefined command event */
process an undefined command event
exit
/* Signal is a user-defined or undefined event
*/
send 1_INTR_VXI_SIGNAL to device sessions for
this device
exit

Sample: Processing VME Interrupts (C)

/* vmeintr.c

This example uses SICL to cause a VME interrupt
from an E1361 register-based relay card at
logical address 136.*/

#include <sicl.h>
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static void vmeint (INST, unsigned short);
static void int_setup (INST, unsigned long);
static void int_hndlr (INST, long, long);
int intr = 0;
main() {

int o; INST id_intfl;

unsigned long mask = 1;

ionerror (1_ERROR_EXIT);

iintroff (;

id_intfl = iopen (“vxi,1367);

int_setup (id_intfl, mask);

vmeint (id_intfl, 136);

/* wait for SRQ or interrupt condition */
iwaithdlr (0);

iintron ;

iclose (id_intfl);

}

static void int_setup(INST id, unsigned long
mask) {

ionintr(id, int_hndlr);

isetintr(id, 1_INTR_VXI_SIGNAL, mask);

}

static void vmeint (INST id, unsigned short
laddr) {

int reg;

char *al6é ptr = O;

reg = 8;
alé ptr = imap (id, 1_MAP_A16, 0, 1, 0);

/* Cause uhf mux to interrupt: */

iwpoke ((unsigned short *)(al6_ptr + 0xc000 +

laddr * 64 + reg), O0x0);

}

static void int_hndlr (INST id, long reason,
long sec) {

printf (“VME interrupt: reason: Ox%x, sec:
0x%x\n’’, reason,sec);

intr = 1;
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6
Using SICL with RS-232

This chapter shows how to open a communications on and
communicate with a device viaan RS-232 connection. The sample
programsin this chapter can be found in the following locations, if
Agilent 10 Libraries Suite was installed in the default directory:

For C/C++:C:\Program Files\Agilent\l10 Libraries Suite\
ProgrammingSamples\C\SICL

For Visua Basic:
C:\Program Files\Agilent\I0 Libraries Suite\
ProgrammingSamples\VB6\SICL

The chapter includes:

* Introduction to RS-232 Interfaces
» Using RS-232 Device Sessions

e Using RS-232 Interface Sessions
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Introduction to RS-232 I nterfaces

This section provides an introduction to using SICL with the RS-232
interface, including:

* ASRL (RS-232) Interface Overview
» Configuring RS-232 Interfaces

* RS-232 Communications Sessions

* RS-232 SICL Functions

ASRL (RS-232) Interface Overview

This section provides an overview of RS-232 interfaces, including
typical hardware configuration, using the Connection Expert utility, and
example configuration using SICL.

Typical RS-232 Interface

Asshown in the following figure, atypical ASRL (RS-232) interface
consists of a Windows PC with one or more RS-232 COM Ports. Each
COM port can be connected to one, and only one, Serial instrument via
an RS-232 cable.
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4 N

.

ASRL Interface (RS-232 COM Ports)

Windows PC RS-232 Cable Serial
Instruments

RS-232 COM Port 1

RS-232 COM Port 2

/

Configuring RS-232 (ASRL) Interfaces

Agilent SICL User’s Guide

An 10 interface can be defined as both a hardware interface and a
software interface. One function of the Connection Expert utility isto
associate a unigque interface name with a hardware interface.

SICL usesaninterface D or logical unit number to identify an
interface. Thisinformation is passed in the parameter string of theiopen
function call in a SICL program. Connection Expert assigns a default
SICL interface ID and logical unit, aswell as other necessary
configuration values, when the interface hardware is configured; you
can change these values by running the Connection Expert utility. See
the 10 Libraries Suite Online Help for details.

Sample: Configuring RS-232 Interface

The ASRL (RS-232) interface system in the following figure consists of
aWindows PC with two RS-232 COM ports, each of which is
connected to asingle serial instrument via RS-232 cables. Connection
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Expert has been used to assign COM Port 1 aSICL name of COM 1 and
to assign COM Port 2 a SICL name of COM 2. Since unique names
have been assigned by Connection Expert, you can now use the SICL
iopen command to open the I/O pathsto the GPIB instruments as shown
in the figure.

/

Interface SICL Names Windows PC RS-232 Cable Serial
Instruments
SICL Name
"COM1" RS-232 COM Port 1
"Com2" RS-232 COM Port 2

~

ASRL Interface (RS-232 COM Ports)

SICL Addressing

iopen ("COM1,488")  Open IO path to Serial instrument using COM Port 1
iopen ("COM2,488")  Open IO path to Serial instrument using COM Port 2

/

RS-232 Communications Sessions

RS-232 isaserial interface that is widely used for instrumentation.
Although RS-232 is slow in comparison to GPIB or VXI, itslow cost
makes it an attractive solution in many situations. Because SICL uses
the RS-232 facilities built into the Windows operating system,
controlling RS-232 instruments is easy.

After you have configured your system for RS-232 communications,
you can start programming using the SICL functions. Using SICL to
communicate with adevice viaRS-232 is similar to using SICL to
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communicate viathe GPIB interface. To use SICL, you must first
determine the type of communications session required. An RS-232
communications session can be either a device session or an interface
session. Commander sessions are not supported on RS-232.

Device Sessions

For direct access to a device, communication is with adevice session.
An RS-232 device session should be used when sending commands and
receiving data from an instrument.

I nterface Sessions

SICL aso adlowsinterface-specific actions, such as setting device
addresses or other interface-specific characteristics. To do this, you
communicate with an inter face session. Setting interface characteristics
(such as the baud rate) must be done with an interface session.

With RS-232, only one device is connected to the interface, so it may
seem like extrawork to have both device sessions and interface
sessions. However, structuring the code so that interface-specific actions
are isolated from actions on the device itself makes programs easier to
maintain. Thisis especially important if you want to use a program with
asimilar device on adifferent interface, such as GPIB.
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RS-232 SICL Functions

Table 37 Theiseridctrl Functions

Function Name Action
iserialctrl Sets the following characteristics of the RS-232
interface:

Table 38 iseridctrl Setsthe State for these RS-232 Characteristics

Request Characteristic Settings

|_SERIAL_BAUD Datarate 2400, 9600, etc.

|_SERIAL_PARITY  Parity |_SERIAL_PAR_NONE
|_SERIAL_PAR_IGNO
RE

|_SERIAL_PAR EVEN
|_SERIAL_PAR_ODD

|_SERIAL_PAR MAR
K
|_SERIAL_PAR_SPAC
E

|_SERIAL_STOP Stop bits/ frame |_SERIAL_STOP 1
|_SERIAL_STOP 2

|_SERIAL_WIDTH  Databits/ frame |_SERIAL_CHAR 5
|_SERIAL_CHAR 6
|_SERIAL_CHAR 7
|_SERIAL_CHAR 8

|_SERIAL_READ_B Receive buffer size Number of bytes

UFsz

|_SERIAL_DUPLEX Datatraffic |_SERIAL_DUPLEX_H
ALF
|_SERIAL_DUPLEX_F
ULL
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Table 38 iseriactrl Setsthe State for these RS-232 Characteristics

Request Characteristic

Settings

| SERIAL_FLOW_C Flow control
TRL

|_SERIAL_READ_E EOI indicator for reads
ol

|_SERIAL_WRITE_E EOI indicator for writes
ol

|_SERIAL_FLOW_NO
NE
|_SERIAL_FLOW_XO
N
|_SERIAL_FLOW_RTS
_CTS
|_SERIAL_FLOW_DTR
_DSR

|_SERIAL_EOI_NONE
|_SERIAL_EOI_BIT8
|_SERIAL_EOI_CHAR

[ ()

|_SERIAL_EOI_NONE
|_SERIAL_EOI BIT8

|_SERIAL_RESET Interface state (none)

Table 39 iserialstat

Function Name Action

iserialstat Gets the following information about the RS-232
interface:

Table 40 iseriastat Captures Status for these RS-232 Characteristics

Request Characteristic Value
|_SERIAL_BAUD Data rate 2400, 9600, etc.
|_SERIAL_PARITY  Parity |_SERIAL_PAR *
|_SERIAL_STOP Stop bits/ frame  |_SERIAL_STOP_*

|_SERIAL_WIDTH  Databits/frame | _SERIAL_CHAR *

|_SERIAL_DUPLEX Datatraffic |_SERIAL_DUPLEX_*
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Table 40 iseriastat Captures Status for these RS-232 Characteristics

Request Characteristic

Value

| SERIAL_MSL Modem status
lines

|_SERIAL_STAT Misc. status

| SERIAL_READ B Receive buffer
UFSZ size

|_SERIAL_READ D Dataavailable
AV

|_SERIAL_FLOW_C Flow control
TRL

|_SERIAL_DCD
|_SERIAL_DSR
|_SERIAL_CTS
|_SERIAL_RI
|_SERIAL_TERI
|_SERIAL_D_DCD
|_SERIAL_D DSR
|_SERIAL_D CTS

|_SERIAL_DAV
|_SERIAL_TEMT
|_SERIAL_PARITY
|_SERIAL_OVERFLOW
|_SERIAL_FRAMING
|_SERIAL_BREAK

Number of bytes

Number of bytes

|_SERIAL_FLOW *

|_SERIAL_READ_E EOlI indicator for |_SERIAL_EOI*

ol reads

|_SERIAL_WRITE_E EOI indicator for |_SERIAL_EOI*

Ol writes

Table41l Other RS-232 Functions

Function Name Action

iserialmclctrl Sets or Clears the modem control lines. Modem control

linesare either |_SERIAL_RTSor |_SERIAL_DTR.

iserialmclstat Gets the current state of the modem control lines.
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Table41l Other RS-232 Functions

iserialbreak Sends a break to the instrument. Break timeis 10
character times, with a minimum time of 50 milliseconds
and a maximum time of 250 milliseconds.

Using RS-232 Device Sessions

Agilent SICL User’s Guide

An RS-232 device session alowsdirect accessto adevice, regardless of
the type of interface to which the device is connected. The specifics of
the interface are hidden from the user.

Addressing an RS-232 Device

To create adevice session, specify the interface logical unit or symbolic
name, followed by a device logical address of 488. The device address
of 488 tells SICL that communication iswith a device that uses the
|EEE-488.2 standard command structure.

For other interfaces (such as GPIB), SICL supports the concept of
primary and secondary addresses. However, for RS-232, the only
primary address supported is 488. SICL does not support secondary
addressing on RS-232 interfaces.

If adevice does not “ speak” IEEE-488.2, you can still use SICL to
communicate with the device. However, some SICL functions that work
only with device sessions may not operate correctly. See“SICL
Functions for RS-232 Device Sessions’ for details.

Theinterface logical unit and symbolic name are defined by running the
Connection Expert utility. To open Connection Expert, click the Agilent
IO Control (10 icon on the taskbar) and click Agilent Connection

Expert. SeethelO Libraries Suite Online Help for detailson this utility.

Some example addresses for RS-232 device sessions:;

COM1,488
serial , 488

Examples of opening a device session with an RS-232 device:
« Csample
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INST dmm;

dmm = i1open (““‘coml,488);

» Visual Basic sample:

Dim dmm As Integer
dmm = i1open (“coml,b488”

SICL Functionsfor RS-232 Device Sessions

This section describes how some SICL functions are implemented for
RS-232 device sessions. There are specific device session interrupts that

can be used.

Table42 SICL Functionsfor RS-232 Device Sessions

Function

Description

iprintf, iscanf,
ipromptf

ireadstb

itrigger

iclear

SICL’sformatted 1/0 routines depend on the concept
of an EQOI indicator. Since RS-232 does not define an
EOI indicator, SICL uses the newline character (\n)
by defauilt.

You cannot change this with a device session.
However, you can use theiserialctr| function with
an interface session. See “SICL Functions for
RS-232 Interface Sessions’ in this chapter for
details.

Sends the |EEE 488.2 command * STB? to the
instrument, followed by the newline character (\n). It
then reads the ASCI| response string and converts it
to an 8-hit integer. Thiswill work only if the
instrument understands this command.

Sends the |EEE 488.2 command * TRG to the
instrument, followed by the newline character (\n).
Thiswill work only if the instrument understands
this command.

Sends a break, aborts any pending writes, discards
any datain the receive buffer, resets any flow control
states (such as XON/XOFF), and resets any error
conditions. To reset the interface without sending a
break, use: iserialctrl (id, |_SERIAL_RESET, 0)
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Table42 SICL Functions for RS-232 Device Sessions

ionsrq Installs a service request handler for this session.
Service requests are supported for both device
sessions and interface sessions. See SICL Functions
for RS-232 Interface Sessions” in this chapter for
details.

Device Session Sample Programs

This section contains two sample programs for RS-232 interface device
SEession programming.

Sample: RS-232 Device Session (C)

This sample program takes a measurement from aDVM using a SICL
device session. This sample program was tested with a 34401A digital
voltmeter. When you run the program with a serial connection to the
34401A, be sure that DTR/DSR flow control is set for the seria port.
Otherwise, the program will appear not to work.

/* ser_dev.c
This example program takes a measurement from a
DVM using a SICL device session.*/

#include <sicl.h>
#include <stdio.h>
#include <stdlib.h>

#i1f ldefined(WIN32)
#define LOADDS __ loadds
#else

#define LOADDS

#endi

void SICLCALLBACK LOADDS error_handler (INST id,
int error) {

printf (“Error: %s\n”, igeterrstr (error));
exit (1);
}
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main(Q)

{
INST dvm;

double res;

/* Log message and terminate on error */
ionerror (error_handler);

/* Open the multimeter session */
dvm = iopen (*“COM1,488");
itimeout (dvm, 10000);

/* Prepare the multimeter for measurements */
iprintf (dvm,”*RST\n");
iprintf (dvm,”SYST:REM\n”);

/* Take a measurement */
iprintf (dvm,”MEAS:VOLT:DC?\n”");

/* Read the results */
iscanf (dvm,”%l1¥”’,&res);

/* Print the results */
printf (“Result is %f\n”,res);

/* Close the voltmeter session */
iclose (dvm);

/* This call is a no-op for WIN32 programs */
_siclcleanupQ);

return O;

}

Sample: RS-232 Device Session (Visual Basic)

This sample program takes a measurement from aDVM using a SICL
device session. This sample program was tested with a 34401A digital
voltmeter. When you run the program with a serial connection to the
34401A, be sure that DTR/DSR flow control is set for the serial port.
Otherwise, the program will appear not to work.
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Option Explicit

ser_dev.bas
This example program takes a measurement from
“ a DVM using a SICL RS-232 device session.

Sub Main(Q)

Dim dvm As Integer
Dim res As Double
Dim argcount As Integer

" Open the multimeter session

" "COM1"™ is the SICL Interface name as defined
“ in Connection Expert

" Change this to the SICL name you have defined
dvm = iopen(''COM1,488")

" Set timeout to 10 sec
Call itimeout(dvm, 10000)

" Prepare the multimeter for measurements

argcount = ivprintf(dvm, "*RST" + Chr$(10),
0&)

argcount = ivprintf(dvm, "SYST:REM" +
Chr$(10), 0&)

" Take a measurement
argcount = ivprintf(dvm, "MEAS:VOLT:DC?" +
Chr$(10))

" Read the results
argcount = ivscanf(dvm, "%If", res)

" Print the results
MsgBox ""Result is " + Format(res),
vbExclamation

" Close the multimeter session
Call iclose(dvm)

" Tell SICL to cleanup for this task
Call siclcleanup

End Sub
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Using RS-232 I nterface Sessions

RS-232 inter face sessions can be used to get or set the characteristics of
the RS-232 interface. Examples of some of these characteristics are
baud rate, parity, and flow control. There are specific interface session
interrupts that can be used.

Addressing RS-232 I nterfaces

To create an inter face session on RS-232, specify the interface logical
unit or SICL interface ID in the addr parameter of the iopen function.
Theinterface logical unit and SICL interface ID are defined by running
the Connection Expert utility. To open Connection Expert, click the
Agilent 10 Control (10 icon on the taskbar) and click Agilent
Connection Expert. Seethe 10 Libraries Suite Online Help for details
on this utility. Some example addresses for RS-232 interface sessions
follow.

Table43 Sample RS-232 Addresses

comM1 A SICL interface ID
serid A SICL interface ID

1 An interface logical unit

These code samples open an interface session with the RS-232
interface.

 Csample:

INST intf;
intf = iopen (““COM1);

* Visual Basic sample:
Dim intf As Integer
intf = iopen (*“*COM1™)
SICL Functionsfor RS-232 I nterface Sessions

This section describes how some SICL functions are implemented for
RS-232 interface sessions.
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Table 44 Implementing Some SICL Functions for RS-232

Functions

Description

iwrite, iread

ixtrig

itrigger

iclear

ionsrq|

All I/O functions (non-formatted and formatted) work the
same as for device sessions. However, it is recommended
that all 1/0 be performed with device sessions to make
your programs easier to maintain.

Provides a method of triggering using either the DTR or
RTS modem status line. This function clears the specified
modem status line, waits 10 milliseconds, then sets it
again. Specifying |_TRIG_STD isthe same as specifying
I_TRIG_SERIAL_DTR.

Pulses the DTR modem control line for 10 milliseconds.

Sends a break, aborts any pending writes, discards any
datain the receive buffer, resets any flow control states
(such as XON/XOFF), and resets any error conditions. To
reset the interface without sending a break, use:
iserialctrl (id, |_SERIAL_RESET, 0)

Installs a service request handler for this session. The
concept of service request (SRQ) originates from GPIB.
On aGPIB interface, a device can request service from
the controller by asserting aline on the interface bus.

RS-232 does not have a specific line assigned asaservice
reguest line. However, you can assign one of the modem
status lines (RI, DCD, CTS, or DSR) as the service
reguest line by running the Connection Expert utility.

Any transition on the designated service request line will
cause an SRQ handler in your program to be called. (Be
sure not to set the SRQ lineto CTS or DSRif you are also
using that line for hardware flow control.)

Service requests are supported for both device sessions
and interface sessions. When the designated SRQ line

changes state, the RS-232 driver calls all SRQ handlers
installed by either device sessions or interface sessions.
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Table 44 Implementing Some SICL Functions for RS-232

iseriactrl

iseriastat

Sets the characteristics of the Serial interface. The
following requests are clarified:

|_SERIAL_DUPLEX: The duplex setting determines
whether data can be sent and received simultaneously.
Setting full duplex allows simultaneous send and receive
data traffic. Setting half duplex (the default) will cause
reads and writes to be interleaved, so that datais flowing
in only one direction at any given time. (The exception to
thisisif XON/XOFF flow control is used.)

|_SERIAL_READ_ BUFSZ: Thedefault read buffer size
52048 bytes.

|_SERIAL_RESET: Performs the same function asthe
iclear function on an interface session, except that abreak
isnot sent.

Gets the characteristics of the Serial interface. The
following requests are clarified:

| SERIAL_MSL: Getsthe state of the modem status
line. Because of the way Windows supports RS-232, the
I_SERIAL_RI bit will never be set. However, the
I_SERIAL_TERI bit will be set when the RI modem
status line changes from high to low.

| SERIAL_STAT: Getsthe status of the transmit and
receive buffers and the errors that have occurred since the
last time this request was made. Only the error bits
(I_SERIAL_PARITY, |_SERIAL_OVERFLOW,
|_SERIAL_FRAMING, and |_SERIAL_BREAK) are
cleared. The|_SERIAL_READ_DAV and
|_SERIAL_TEMT bitsreflect the status of the buffers at
al times.

|_SERIAL_READ_DAV: Getsthe current amount of
data available for reading. This shows how much datais
in Windows' receive buffer, not how much dataisin the
buffer used by the formatted input functions such as
iscanf.
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Table44 Implementing Some SICL Functions for RS-232

iserialmclctrl Controlsthe modem control linesRTSand DTR. If one of
theselinesis being used for flow control, you cannot set
that line with this function.

iseriamclstat Determines the current state of the modem control lines.
If one of these lines is being used for flow control, this
function may not give the correct state of that line.

I nterface Sessions Sample Programs

This section contains two sample programs for RS-232 interface device
SEession programming.

Sample: RS-232 | nterface Session (C)

/*ser_intf.c

This program gets the current configuration of
the serial port, sets it to 9600 baud, no
parity, 8 data bits, and 1 stop bit, and prints
the old configuration.*/

#include <stdio.h>
#include <sicl.h>

main()
{
INST intf; /* interface session id */
unsigned long baudrate, parity, databits,
stopbits;
char *parity_str;

/* Log message and exit program on error */
ionerror (1_ERROR_EXIT);

/* open RS-232 interface session */
intf = fopen (““COM1);
itimeout (intf, 10000);
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/* get baud rate, parity, data and stop bits */
iserialstat (intf, 1_SERIAL_BAUD, &baudrate);
iserialstat (intf, 1_SERIAL_PARITY, &parity);
iserialstat (intf, 1_SERIAL_WIDTH, &databits);
iserialstat (intf, 1_SERIAL_STOP, &stopbits);

/* determine string to display for parity */

if (parity == 1_SERIAL_PAR_NONE) parity_str =
“NONE”";

else if (parity == 1_SERIAL_PAR_ODD)
parity_str = *“0DD”’;

else if (parity == 1_SERIAL_PAR_EVEN)
parity str = “EVEN”;

else if (parity == I_SERIAL_PAR_MARK)
parity_str = “MARK”;

else /*parity == 1_SERIAL_PAR_SPACE*/

parity_str = “SPACE”;

/* set to 9600,NONE,8,1 */

iserialctrl (intf, 1_SERIAL_BAUD, 9600);

iserialctrl (intf, 1_SERIAL_PARITY,
I_SERIAL_PAR_NONE);

iserialctrl (intf, 1_SERIAL_WIDTH,
I_SERIAL_CHAR_8);

iserialctrl (intf, 1_SERIAL_STOP,
I_SERIAL_STOP_1);

/* Display previous settings */
printf(“Old settings: %51d,%s,%ld,%ld\n”,
baudrate, parity_str, databits, stopbits);

/* close port */
iclose (intf);

/* This call is a no-op for WIN32 programs. */
_siclcleanup(Q);

return O;

}
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Sample: RS-232 Interface Session (Visual Basic)
Option Explicit

set_intf.bas

This program (1) gets the current
configuration of the " serial port; (2) sets

“ it to 9600 baud, no parity, 8 data bits, and 1
stop bit;(3) prints the old configuration

Sub MainQ)

Dim intf As Integer

Dim baudrate As Long

Dim parity As Long

Dim databits As Long

Dim stopbits As Long

Dim parity_str As String
Dim msg_str As String

open RS-232 interface session

" "COM1"™ is the SICL Interface name as defined
in Connection Expert

Change this to the SICL Name you have
defined in Connection Expert

intf = 1open("’COM1™)
Call itimeout(intf, 10000)

get baud rate, parity, data bits, and stop

“ bits

Call iserialstat(intf, 1_SERIAL_BAUD,
baudrate)

Call iserialstat(intf, 1_SERIAL_PARITY,
parity)

Call iserialstat(intf, 1_SERIAL_WIDTH,
databits)

Call iserialstat(intf, 1_SERIAL_STOP,

stopbits)
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" determine string to display for parity
Select Case parity
Case I_SERIAL_PAR_NONE
parity_str = "NONE"
Case I_SERIAL_PAR_ODD
parity_str = "0DD"
Case I_SERIAL_PAR_EVEN
parity_str = "EVEN"
Case |_SERIAL_PAR_MARK
parity_str = "MARK"
Case Else
parity_str = "SPACE"
End Select

" set to 9600,NONE,8, 1
Call iserialctri(intf, 1_SERIAL_BAUD, 9600)

Call iserialctri(intf, 1_SERIAL_PARITY,
I_SERIAL_PAR_NONE)

Call iserialctri(intf, 1_SERIAL_WIDTH,
I_SERIAL_CHAR_B8)

Call iserialctri(intf, 1_SERIAL_STOP,
I_SERIAL_STOP_1)

" display previous settings

msg_str = "Old settings: " &
Str$(baudrate) & "," &
parity str & "," & _
Str$(databits) & "," & _
Str$(stopbits)

MsgBox msg_str, vbExclamation

close port
Call iclose(intf)

" Tell SICL to cleanup for this task
Call siclcleanup

End Sub
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Using SICL with LAN

This chapter shows how to open a communications on and
communicate with devices over aLocal AreaNetwork (LAN). The
sample programsin this chapter can be found in the following locations,
if Agilent 1O Libraries Suite was installed in the default directory:

For C/C++:C:\Program Files\Agilent\IO Libraries Suite\
ProgrammingSamples\C\SICL

For Visua Basic:
C:\Program Files\Agilent\I10 Libraries Suite\
ProgrammingSamples\VB6\SICL

The chapter includes:

» LAN Interfaces Overview

» Using Remote Sessions

e Using LAN Interface Sessions

» Using Locks, Threads, and Timeouts

This chapter describes SICL programming using the VISA TCPIP inter-
face type to communicate directly with a LAN-connected device, as
well as using aremote interface (also known asaLAN client) to emu-
late a GPIB, serial (ASRL), or USB interface on the local machine to
communicate with a LAN-connected device.

See the Agilent 10 Libraries Suite Online Help for information on how
to start and stop the Remote 10 Server software, and on how to create
and configure LAN interfaces and remote GPIB/USB/serial interfaces.

See the Connectivity Guide for detailed information on connecting
instrumentsto aL LAN, and for a discussion of network protocols.
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Introduction to LAN Interfaces
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This section provides an introduction to using SICL with Local Area
Network (LAN) interfaces, including:

* LAN and Remote Interfaces Overview
e Considerations when Using SICL with LAN

LAN and Remote I nterfaces Overview

This section provides an overview of LAN (Local Area Network)
interfaces. A LAN isaway to extend the control of instrumentation
beyond the limits of typical instrument interfaces. To communicate with
instruments over the LAN, you must first configure aLAN interface or
aremote GPIB, USB, or serial interface, using the Agilent Connection
Expert.

Direct LAN Connection versus Remote | O Server/Client
Connection

Some instruments support direct connection to the LAN. These
instruments include an RJ-45 or other standard LAN connector and
software support for operating as an independent device on the network.
Some of these instruments are Web-enabled, meaning that they host a
Web page which you can access over the LAN.

With the Agilent 1O Libraries Suite, you can connect to instruments
acrossthe LAN even if they do not have direct LAN capability, if they
are connected to gateways (such as the Agilent E5S810A) or to another
PC running the Remote | O Server software.

Refer to the IO Libraries Suite and the Connectivity Guide for
information on connecting and configuring different types of LAN
instrument connections.

Remote | O Server/Client Architecture

The Remote |O Server and Client software provided with Agilent 10
Libraries Suite allows instrumentation to be controlled over aLAN.
Using standard LAN connections, instruments can be controlled from
computers that do not have special interfaces for instrument control.
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Client/server model. ThelO Libraries Suite software uses the
client/server model of computing. Client/server computing refersto a
model in which an application (the client) does not perform all
necessary tasks of the application itself. Instead, the client makes
requests of another computing device (the remote I/O server) for
certain services.

As shown in the following figure, aremote I/O client (a Windows PC)
makes VISA requests over the network to aremote 1/O server (such asa
Windows PC, an E5810 LAN/GPIB Gateway, or a Series 700 HP-UX
workstation).

Gateway operation. The remote I/O server is connected to the
instrumentation or devices to be controlled. Once the remote I/O server
has compl eted the requested operation on the instrument or device, the
remote 1/O server sends areply to the client. Thisreply contains the
requested data and status information that indicates whether or not the
operation was successful. The remote /0O server acts as a gateway
between the LAN software that the client system supports and the
instrument-specific interface that the device supports.
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Considerationswhen Using SICL with LAN

Specifying Protocol and Socket Number in iopen Calls

Asdescribed in the 10 Libraries Suite Online Help, you can choose
either of two protocols—VXI-11 or SICL-LAN —to associate with a
LAN interface. (If you are using aremote GPI B, remote USB, or remote
seria interface, you will use Connection Expert to specify aLAN
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interface associated with the remote interface. The protocol isdefined in
the associated LAN interface.) In SICL, you can override this
configuration setting by specifying the protocol in the iopen string.
Some examples are:

» iopen(" lan[machineName]:gpib0,1") will use the configured
default protocol. If AUTO isconfigured, SICL-LAN protocol will be
attempted. If that is not supported, VXI-11 protocol will be used.

» iopen(" lan;auto[machineName]:gpib0,1") will automatically
select the protocol (SICL-LAN if available and VX1-11 otherwise).

* iopen("lan;sicl-lan[machineName]:gpib0,1" ) will use SICL-LAN
protocol.

e iopen(" lan;vxi-11[machineName]:gpib0,1" ) will use VXI-11
protocol.

ThelO Libraries Suite also supports TCP/IP socket reads and writes. To
open asocket session, useiopen (*'lan,socketNbr [ machineName]"). For
example, iopen("lan,7777] machineName] ") will open a socket
connection for socket number 7777 on 'machineName.’

LAN Clientsand Threads

You can use multi-threaded designs (with SICL calls made from

multiple threads) in Win32 SICL applicationsover LAN. However, only
one thread is permitted to accessthe LAN driver at atime. This
sequential handling of individual threads by the LAN driver prevents
multiple threads from colliding or overwriting one another. Requests are
handled sequentially even if they are intended for different LAN
Servers.

Use multiple processes to process concurrent threads simultaneously
with SICL over LAN. See Chapter 3, “Programming with SICL" , for
more information on using threadsin SICL applications. Also see
“Using Locks and Threads Over LAN” on page 176 for information on
using locks in multi-threaded applications.

SICL LAN Performance

As with other client/server applications on aLAN, when you deploy an
application that uses SICL over LAN, you must consider the
performance and configuration of the network to which the client and
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server will be attached. If the network to be used is neither a dedicated
LAN nor otherwise isolated via a bridge or other network device,
current use of the LAN must be considered.

Depending on the amount of datato be transferred over the LAN viathe
SICL application, that application and/or other network users may
experience performance problems due to insufficient bandwidth. Thisis
not uniqueto SICL over LAN, but is a general design consideration for
any client/server application.

If you have questions concerning the ability of your network to handle
SICL traffic, consult with your network administrator or network
equipment providers. If you are connecting to aVX1-11 device, you can
configure a V X1-11 interface (rather than AUTO) in the Connection
Expert utility and connect through it to achieve slightly better iopen
performance.

SICL LAN Functions

This table summarizes the SICL functions for the LAN interface.

Table45 SICL LAN Functions

Function Name Action

ilantimeout Sets LAN timeout value.
ilangettimeout Returns LAN timeout value.

igetgatewaytype Indicates whether the sessionisviaa LAN gateway.
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This section provides guidelines to using remote SICL sessions,
including:

* Addressing Guidelines
» SICL Function Support
e Sample Programs

Addressing Guidelines

Communicating with adevice over aLAN viaa TCP/IP or remote
GPIB, USB, or serid interface preserves the functionality of the
gatewayed interface, with afew exceptions. Thus, most operations over
alocal interface (such as GPIB connected directly to your controller)
can also be performed over aremote interface.

The only portions of your application that must be changed are the
addresses passed to the iopen calls (unless you use aliases or store those
addresses in a configuration file, in which case no changes to the
application itself are required). The address used for alocal interface
must have aLAN prefix added so the SICL software knowsto direct the
request to aLAN server on the network.

Creating a Remote Session

Agilent SICL User’s Guide

To create aremote session (also called aL AN-gatewayed session),
specify the LAN’s interface logical unit or interface ID, the IP address
or hostname of the server machine, and the address of the remote
interface or device in the addr parameter of the iopen function. The
interface logical unit and interface ID are defined in the Connection
Expert utility.

To open Connection Expert, click the Agilent IO Control icon on the
taskbar and then click Agilent Connection Expert. See the IO
Libraries Suite Online Help for information on Connection Expert.
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Example: Remote Addressing

Some examples of remote SICL addresses follow. If you are using the
| P address rather than the hostname of the server machine, you must use
the bracket (not the comma) notation.

1an,128.10.0.3:gpib (Incorrect)
1an[128.10.0.3]:gpib (Correct)

Table 46 Examplesof LAN Addressing

Address Description

lan[instserv]:GPIB,7 A device address corresponding to the
device at primary address 7 on the GPIB
interface attached to the machine named
instserv. The default LAN protocol set when
the LAN interface was configured with
Connection Expert will be used.

lan;vxi-11[instserv]:GPIB,7 A device address corresponding to the
device at primary address 7 on the GPIB
interface attached to the machine named
instserv. The VXI-11 protocol (TCP/IP
Instrument protocol) will be used.

lan;sicl-lan [instserv]:GPIB,7 A device address corresponding to the
device at primary address 7 on the GPIB
interface attached to a machine named
instserv. The SICL-LAN protocol will be
used.

lan;auto[instserv]:GPIB,7 A device address corresponding to the
device at primary address 7 on the GPIB
interface attached to a machine named
instserv. The SICL-LAN protocol will be
used if the server supportsit. Otherwise, the
V X1-11protocol will be used.

lan;default[instserv]:GPIB,7 A device address corresponding to the
device at primary address 7 on the GPIB
interface attached to a machine named
instserv. Thedefault LAN protocol set when
the lan interface was configured with
Connection Expert will be used. Thisisthe
same as not specifying a protocol.
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Table46 Examplesof LAN Addressing

v

lan[instserv.agilent.com]:gpib,
7

1an1[128.10.0.3]:GPIB0,3,2

lanl[instserv]:GPIB2

30,instserv:gpib,3,2

lan[instserv]:GPIB,cmdr

lan[instserv]:COM1

lan[instserv]:COM 1,488

lan[instserv]:usb0[2391::1031

::SN_041001::0]

lan[instserv]:UsbDevicel

A device address corresponding to the
device at primary address 7 on the gpib
interface attached to the machine named
instserv in the agilent.com domain. (Fully
qualified domain names may be used.)

A device address corresponding to the
device at primary address 3, secondary
address 2, on the GPI BO interface attached
to the machine with I P address 128.10.0.3.

An interface address corresponding to the
GPIB2 interface attached to the machine
named instserv.

A device address corresponding to the
device at primary address 3, secondary
address 2, on the gpib interface attached to
the machine named instserv. (30 isthe
default logical unit for LAN.)

A commander session with the GPIB
interface attached to the machine named
instserv (assuming the server supports GPIB
commander sessions).

An interface address corresponding to the
RS-232 COM 1 interface attached to the
machine named instserv.

A device address corresponding to an
RS-232 device attached to the machine
named instserv.

A device address corresponding to aUSB
device attached to the machine named
instserv.

A device address corresponding to a USB
device attached to the machine named
instserv. The alias name UsbDevicel is
defined on the machine named instserv.
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SICL Function Support

This table shows the relationship between the address passed to iopen,
the session type returned by igetsesstype, the interface type returned by
igetintftype, and the value returned by igetgatewaytype.

Table 47 Relationships Between SICL Functions

Address Session Type Interface Type Interface Type Gateway Type
(VXI-11 Protocol) (SICL-LAN
Protocol)
lan I_SESS INTF I_INTF_LAN I_INTF_NONE I_INTF_NONE
lan[instserv]:inst0 |_SESS DEV I_INTF_LAN I_INTF_USRDEF I_INTF_LAN
lan[instserv]:gpib0 I_SESS INTF I_INTF_GPIB I_INTF_GPIB I_INTF_LAN
lan[instserv]:gpib0,7 |_SESS DEV I_INTF_GPIB I_INTF_GPIB I_INTF_LAN
gpib0 I_SESS INTF I_INTF_GPIB I_INTF_GPIB I_INTF_NONE
gpib0,7 |_SESS DEV I_INTF_GPIB I_INTF_GPIB I_INTF_NONE
Remote I nterface Support
A gatewayed session to aremote interface provides the same SICL
function support asif the interface were local, with the following
exceptions or qualifications.
Table 48 Exceptionsto Remote Interface Support
Type of Functions SICL FunctionsNOT Supported
SICL functions not iblockcopy, imap, imapinfo, ipeek, ipoke, ipopfifo,
supported over LAN ipushfifo, iunmap, iblockmovex, imapx, iunmapx,
using either protocol ipeekx, ipokex, iunmapx
SICL functions, in All RS-232/serial specific functions
additiontothoselisted  igetlu, ionintr, isetintr, igetintfsess, igetonintr,
above, not supported igpibgett1ldelay, igpibppoall,
with the VXI-11 igpibppollconfig, igpibppollresp, igpibsettldelay
protocol
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For theigetdevaddr, igetintftype, and igetsesstype functions to be
supported with the VXI-11 (TCP/IP instrument protocol), the remote
address strings must follow the V X1-11 naming conventions—gpi b0,
gpibl, etc. For example:

gpib0,7

gpibl,7,2

gpib2

vxi0, vxil, etc. (for example: vxi0,8 or vxiO)

However, since the interface IDs at the remote server may be
configurable, this conformance is not guaranteed. Correct behavior of
iremote and iclear depend on the correct address strings being used.
When iremoteis executed over the VV X1-11 protocol, iremote sendsthe

LLO (local lockout) message in addition to placing the device in the
remote state.

LAN Timeout Functions
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Any of the following functions may time out over LAN, even those
functions that cannot time out over local interfaces. (See “Using
Timeouts with LAN” in this chapter for more details.) These functions
all cause arequest to be sent to the server for execution:

All GPIB-specific functions

All RS-232/serial-specific functions

iabort, iclear, iclose, iflush, ifread, ifwrite, igetintfsess, ilocal, ilock, ionintr,
ionsrq, iopen, iprintf, ipromptf, iread, ireadstb, iremote, iscanf, isetbuf, isetintr,
isetstb, isetubuf, itrigger, iunlock, iversion, iwrite, ixtrig

These SICL functions perform as follows with LAN-gatewayed
sessions.

Table49 How SICL Functions Perform for LAN Gatewayed Devices

idrvrversion  Returns the version numbers from the server.

iwrite, iread  actualcnt may be reported as 0 when some bytes were
transferred to or from the device by the server. This can
happen if the client times out while the server isin the middle
of an 1/O operation.
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Sample Programs

Two sample programs for LAN-gatewayed sessions follow, one for C
and one for Visual Basic 6.0.

Sample: LAN-gatewayed Session (C) This sample program opens
a GPIB device session viaa LAN-to-GPIB gateway. This sampleisthe
same as the sample in Chapter 4 - Using SICL with GPIB, except the
addresses passed to the iopen calls are modified. The addressesin this
sample assume a machine with hostname instserv is acting as a
LAN-to-GPIB gateway.

/* landev.c

This example program sends a scan list to a
switch and, while looping, closes channels and
takes measurements.*/

#include <sicl.h>
#include <stdio.h>

main({

INST dvm;

INST sw;

double res;

int i;

/* Print message and terminate on error */
ionerror (I_ERROR _EXIT);

/* Open the multimeter and switch sessions */
dvm = iopen (“lan[instserv]:gpib0,9,3”);

sw = iopen (“lan[instserv]:gpib0,9,14);
itimeout (dvm, 10000);

itimeout (sw, 10000);

/*Set up trigger*/
iprintf (sw, “TRIG:SOUR BUS\n”);

/*Set up scan list*/
iprintf (sw,”SCAN (@100:103)\n’");
iprintf (sw,”INIT\n”);
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for (i=1;i<=4;i++) {
/* Take a measurement */
iprintf (dvm,”MEAS:VOLT:DC?\n”");

/* Read the results */
iscanf (dvm,”%If”’, &res);

/* Print the results */
printf (“Result is %f\n”,res);
/*Trigger to close channel*/
iprintf (sw, “TRIG\n);
}
/* Close the multimeter and switch sessions */
iclose (dvm);
iclose (sw);

}

Sample: LAN-gatewayed Session (Visual Basic 6.0)

This sample program opens a GPIB device session viaa LAN-to-GPIB
gateway.

Option Explicit

landev.bas

This example program opens a GPIB device
session via a LAN-to-GPIB gateway. The
addresses iIn this example assume a machine
with hostname "instserv® is acting as a

“ LAN-to-GPIB gateway.

Sub Main(Q)

Dim dvm As Integer, sw As Integer
Dim nargs As Integer, 1 As Integer
Dim actual As Long

Dim res As String * 20

" Set up an error handler within this
“ subroutine that will get called if a SICL
" error occurs.
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On Error GoTo ErrorHandler

“Open the multimeter and switch sessions
dvm = iopen(lan[intserv]:gpib0,9,3")

sw = iopen(""lan[intserv]:gpib0,9,14")
Call itimeout(dvm, 10000)

Call itimeout(sw, 10000)

set up the trigger
nargs = iwrite(sw, "TRIG:SOUR BUS" + Chr$(10)
+ Chr$(0), 14, 1, actual)

set up scan list

nargs = iwrite(sw, "SCAN (@100:103)" +
Chr$(10) + Chr$(0), 15, 1, actual)

nargs = iwrite(sw, "INIT" + Chr$(10) +

Chr$(0), 5, 1, actual)

For 1 =1 To 4 Step 1
" Take a measurement
nargs = iwrite(dvm, ""MEAS:VOLT:DC?" +
Chr$(10)+ Chr$(0), 14, 1, actual)

" Read the results
nargs = iread(dvm, res, 20, 0&, actual)

“ Print the results
MsgBox ""Channel ™ & I & ™ result:
vbCrLf

+ res &

" Trigger switch
nargs = iwrite(sw, "TRIG" + Chr$(10) +
Chr$(0), 5, 1, actual)
Next 1

Call iclose(dvm)
Call iclose(sw)

Exit Sub
ErrorHandler:

" Display the error message in the txtResponse
“ TextBox.

MsgBox "*** Error : + Error$
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" Close the device session if i1open was
“ successful.

IT dvm <> 0 Then
Call iclose(dvm)
End If

IT sw <> 0 Then
Call iclose(sw)
End If

End Sub
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Using LAN Interface Sessions
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The LAN interface, unlike most other supported SICL interfaces, does
not allow for direct communication with devices viainterface
commands. LAN interface sessions, if used at all, will typically be used
only for setting the client-side LAN timeout. (See “ Using Timeoutswith
LAN” on page 177.)

Addressing LAN I nterface Sessions

To create a LAN interface session, specify the interface logical unit or
interface name in the addr parameter of the iopen function. The
interface logical unit and SICL interface ID are defined by the
Connection Expert utility.

To open Connection Expert, click the Agilent IO Control 10 icon on the
taskbar and then click Agilent Connection Expert. Seethe IO
Libraries Suite Online Help for information on Connection Expert.
Some examples of SICL interface IDsfor LAN interfaces follow.

Table50 SICL Interface ID Examples

lan A LAN interface address using the interface name lan.

30 A LAN interface address using the logical unit 30. (30 is the default
logical unit for LAN.)

SICL Function Support

These SICL functions are not supported over LAN interface sessions;
they return |_ERR_NOTSUPP.

All GPIB specific functions

All serial specific functions

All formatted 1/O routines

iwrite, iread, ilock, iunlock, isetintr, itrigger, ixtrig,
ireadstb, isetstb, imapinfo, ilocal, iremote

These SICL functions perform as follows with LAN interface sessions.
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Table51 SICL Functionsfor LAN Interface Sessions

iclear Performs no operation, returns|_ERR_NOERROR.

ionsrq Performs no operation against LAN gateways for SICL, returns
|_ERR_NOERROR.

ionintr Performs no operation, returns |_ERR_NOERROR.

igetluinfo  Returnsinformation about local interfaces only. Does not return

information about remote or LAN interfaces.
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Using Locks, Threads, and Timeouts

This section gives guidelines to use locks, threads, and timeouts over
LAN, including:

Using Locks and Threads Over LAN
Using Timeouts Over LAN

Using Locksand Threads Over LAN

If two or more threads are accessing the same device or interface using
two or more different sessions over LAN, and are using SICL locksto
synchronize access, some scenarios may cause timeouts, or may “hang”
an application that does not use timeouts.

Scenariosto Avoid

For proper operation, all threads that use their own sessions to access
the same device or interface should use the same string to identify the
device or interface in their calls to iopen. Therefore, the following
scenarios should be avoided.
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Avoid using a hostname to identify the remote host in one call to
iopen while using an alias or | P address to identify the same host in
another call to iopen.

Avoid using a device symbolic name, or alias, in one call to iopen
(such as “dmm,” where “dmm” equals “gpib,1”) while using the
fully specified device name (such as “gpib,1") in another call.
Avoid using aremote interface’s logical unit (such as“7") in one call

while using the remote interface’s SICL interface ID (such as“gpib”)
in another.

Avoid using igetintfsess to open an interface session (which
internally usesthelogical unit to identify the remote interface) while
opening the interface with its SICL interface ID for another session.
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Recommended Usage

You can avoid each of the above scenarios by always using the same
strings to identify the same device or interface in multi-threaded
applications. You can aso use the igetintfsess function if other sessions
use the logical unit instead of the SICL interface ID to specify the
interface.

If any thread usesilock and iunlock to synchronize accessto a
particular device or interface, all threads accessing that same device or
interface using a different session must also use ilock and iunlock. You
can also use Win32 synchronization techniques to ensure that a thread
does not attempt I/O (iread/iwrite, etc.) to adevice already locked viaa
different session from a different thread within the same process.

If asession has an interface locked, and if a different thread using its
own session attempts to lock a device on that interface, the device lock
will be held off either until the interface is unlocked by the other thread,
or until atimeout occurs on the device lock. Thisis different from how
ilock works on other interfaces (where alock on adevice when the
device'sinterface is aready locked will not hold off theilock operation,
but rather will hold off any subsequent 1/0O to the device).

Using Timeoutswith LAN
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The client/server architecture of the remote 1/0 software requires use of
two timeout values: one for the client and one for the server. The
server’stimeout value is the SICL timeout value specified with the
itimeout function. The client’s timeout valueisthe LAN timeout value,
which may be specified with the ilantimeout function.

Client/Server Operation

When the client sends an /O request to the server, the timeout value
specified with itimeout or with the SICL default is passed with the
request. The server uses that timeout in performing the I/O operation,
just asif that timeout value had been used on alocal 1/O operation.

If the server’s operation is not completed in the specified time, the
server sends areply to the client that indicates that a timeout occurred,
and the SICL call made by the application returns|_ERR_TIMEOUT.
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When the client sends an 1/0 request to the server, it starts atimer and
walits for the reply from the server. If the server does not reply in the
time specified, the client stops waiting for the reply from the server and
returns|_ERR_TIMEOUT to the application.

LAN Timeout Functions

Theilantimeout and ilangettimeout functions can be used to set or
query the current LAN timeout value. They work much like the
itimeout and igettimeout functions. The use of these functionsis
optional, however, since the software will calculate the LAN timeout
based on the SICL timeout in use and the configuration values set via
Connection Expert.

Once the application callsilantimeout, the automatic LAN timeout
adjustment is turned off.

A timeout value of 1 used with the ilantimeout function has special
significance, causing the LAN client to not wait for aresponse from the
LAN server. However, the timeout value of 1 should be used only in
special circumstances and should be used with extreme caution.

Default LAN Timeout Values

Connection Expert specifies two timeout-related configuration values
for the LAN software. These values are used by the software to
calculate timeout values if the application has not previously called
ilantimeout.

Table52 LAN Software Timeout Values

LAN maximum Timeout value passed to the server when an

timeout application either usesthe SICL default timeout value
of Infinity or setsthe SICL timeout to infinity (0).
Value specifies the number of seconds the server will
wait for the operation to complete before returning
I_ERR_TIMEOUT.

A value of 0in thisfield will cause the server to be
sent avalue of infinity if the client application also
uses the SICL default timeout value of infinity or sets
the SICL timeout to infinity (0).
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Table52 LAN Software Timeout Values

Client deltatimeout ~ Value added to the SICL timeout value (server’'s
timeout value) to determine the LAN timeout value
(client’s timeout value). Value specifies the number
of seconds.

Timeout Algorithm

Once ilantimeout is called, the software no longer sends the server
timeout value to the server and no longer attempts to determine a
reasonable client-side timeout. It is assumed that the application itself
wants full control of timeouts, both client and server. Also, ilantimeout
isper process. That is, al sessions going out over the network are
affected when ilantimeout is called.

If the application has not called the ilantimeout function, timeouts are
adjusted via the following algorithm:

» The SICL timeout, which is sent to the server for the current cal, is
adjusted if it is currently infinity (0). Inthat case it will be set to the
Server Timeout value.

e TheLAN timeout is adjusted if the SICL timeout plus the Client
Delta Timeout is greater than the current LAN timeout. In that case
the LAN timeout will be set to the SICL timeout plus the Client
Delta Timeout.

» The calculated LAN timeout only increases as hecessary to meet the
needs of the application, but never decreases. This avoids the
overhead of readjusting the LAN timeout every time the application
changes the SICL timeout.

» Thefirstiopen call used to set up the server connection uses the
Client Delta Timeout specified via Connection Expert for portions of
the iopen operation. The timeout value for TCP connection
establishment is not affected by the Client Delta Timeout.

To change the timeout values:

1 Exit any applicationsthat use SICL.

2 Run the Connection Expert utility. (Click the Agilent 10 Control and
then click Agilent Connection Expert.)
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3 Click on the TCPIP interface shown in the explorer view, then click
Change Properties... in the properties pane on the right.

4 Changethe LAN Maximum Timeout and/or Client Delta Timeout
value(s) and click OK to save the changes.

5 Restart your application(s).

Timeoutsin Multi-threaded Applications

If you want to manually set the client-side timeout in an application
using multiple threads, be aware that ilantimeout may itself time out
due to contention for the LAN subsystem, in cases where multiple
threads in an application are simultaneously using SICL over LAN.

Thus, if multiple threads are using SICL over LAN at the sametime and
LAN timeouts are expected by the application, it is recommended that
you call ilantimeout only when no other LAN I/O is occurring, such as
immediately after session creation (iopen).

If you use the no-wait value and multiple threads are attempting I/O
over the LAN, I/O operations using the no-wait option will wait for
accessto the LAN for two minutes. If another thread isusing the LAN
interface for longer than two minutes, the no-wait operation will time
out.

Timeout Configurationsto Be Avoided

The LAN timeout used by the client should always be greater than the
SICL timeout used by the server. This avoids the situation where the
client times out while the server continues to attempt the request,
potentially holding off subsequent operations from the same client. This
also avoids having the server send unwanted replies to the client.

The SICL timeout used by the server should generally be less than
infinity. Having the LAN server wait less than forever allowsthe LAN
server to detect network problems or clients that have ceased operation
abruptly, and subsequently release resources associated with those
clients, such aslocks.

Using the smallest possible timeout for your application will maximize
the server’s responsiveness to dropped connections, including dropped
connections that result from the client application being terminated
abnormally. You can set avaue less than infinity by setting the LAN
Maximum Timeout configuration value in the Connection Expert utility.
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Even if your application usesthe SICL default of infinity, or if itimeout
is used to set the timeout to infinity, by setting the LAN Maximum
Timeout value to some reasonable number of seconds, you allow the
server to time out, detect network trouble, and release resources.

Application Terminations and Timeouts

If an application is stopped in the middle of a SICL operation performed
at the remote 1/O server, the server continues to try the operation until
the server’stimeout is reached. By default, the remote |1/O server
associated with an application that is using atimeout of infinity and is
stopped may not discover that the client is no longer running for two
minutes. If you are using a server other than the Agilent Remote 10
Server on Windows or the Agilent E5810 LAN/GPIB gateway, check
your server’'s documentation for its default behavior.

If your application uses itimeout to set along timeout value, or if both
the LAN client and LAN server are configured to use infinity or along
timeout value, the server may appear “hung” (unresponsive). If this
situation occurs, configure the LAN interface (viathe Client Delta
Timeout value set with Connection Expert) or the Remote 1O Server
(viaits Server Timeout value) to use a shorter timeout value.

If you must use long timeouts, you may reset the server to regain server
response. You can reset aremote 1/0O server by logging into the server
system and stopping the Remote |0 Server software that is running.
Thiswill affect al clients connected to the server. See “ Appendix B:
Troubleshooting SICL Programs’ for more details. Also, see the
documentation on the server you are using for methods to reset the
server.

Agilent SICL User’s Guide 181



7 Using SICL with LAN

182 Agilent SICL User’s Guide



Agilent 1O Libraries Suite
Agilent SICL User’sGuide

8
Using SICL with USB

This chapter provides guidelinesfor SICL programming of USB
instruments that conform to USBTMC (Universal Serial Bus Test and
Measurement Class) and/or USBTMC-USB488 (Universal Serial Bus
Test and Measurement Class, Subclass USB488 Specification).

The chapter contents are:

* USB Interfaces Overview

e Communicating with aUSB Instrument Using SICL
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USB Interfaces Overview

USBTMC/USBTMC-USB488 instruments are detected and
automatically configured by Agilent 10 Libraries Suite when they are
plugged into the computer. The 10 Libraries Suite Online Help
describes the USB instrument configuration process in more detail.

Do not confuse the Agilent 82357 USB/GPIB Interface with a
USBTMC device. The 82357 is automatically configured as a GPIB
interface, not asa USBTMC device, when it is plugged into the
computer. Only USBTMC/USBTMC-USB488 devices will be
configured as USB devices by Agilent 10 Libraries Suite.
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Communicating with a USB Instrument Using SICL

Agilent SICL User’s Guide

Each USBTMC device can be uniquely identified by a set of four
parameters. These parameters are described in the following table.

Table53 USBTMC Device Parameters

Parameter Data Type ExampleValue Default Value
Manufacturer ID  16-bit unsigned 2391 n/a
integer
Model Code 16-bit unsigned 1031 n/a
integer
Serial Number String (128 SN_001001 n/a
characters max)
USBTMC 8-bit unsigned 0 0

Interface Number  integer

When a USBTMC instrument is attached to the computer, Agilent IO
Libraries Suite automatically configures a USB interface with the name
usbO if one does not already exist. (See the 10 Libraries Suite Online
Help for more details.) A dialog box is also displayed, showing an alias
(which you can change) and the four unique USB parameters for the
device.

To establish communications with a USB device using SICL, you can
use either the full SICL resource string for the device or use the alias.
Using the alias is recommended, for reasons described below.

Using the full SICL resource string to open aUSB instrument, the iopen
call would look like this:

id = iopen('usbO[2391::1031::SN_001001::0]");

Sinceinthis examplethe USBTMC interface | D hasthe default value of
0, it does not have to be specified. Theiopen call would then look like
this:

id = iopen(*'usb0[2391::1031::SN_001001]"");

Following is asummary of the components of this call.
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Table54 Summary of Full-String iopen Call

Value Description

usb0 the SICL name for the USB interface
2391 Manufacturer 1D

1031 Model Code

SN_001001 Serial Number

0 USBTMC Interface Number

This address string uniquely identifies the USB device. The values
needed for the resource string are displayed in a dialog box when the
deviceis plugged into the computer. The same values can aso be
obtained by running the Connection Expert utility and selecting the
USB interface in the explorer view; the values will be shown in the
properties view (right pane of the Connection Expert window).

To simplify theway a USB device isidentified, SICL also provides an
alias which can be used in place of this resource string. The first USB
devicethat is plugged in is assigned a default aias of UsbDevicel.
Additional devices are assigned aliases of UsbDevice2, UsbDevice3,
etc. You can modify the alias to one of your choosing at thetime a
deviceis plugged in, or by running the Connection Expert utility and
modifying the properties of the USB interface.

Note that the Connection Expert displays (and allows editing of) VISA
aliases, not SICL aliases. However, Connection Expert creates a SICL
alias to correspond to each VISA alias, so if you do not use other tools
to edit your aliases, the VISA and SICL aliasesin your test system will
be identical.

Although the case of an adliasis preserved, caseisignored when the alias
isused in place of the full resource string in an iopen call. For example,
UsbDevicel, usbdevicel and USBDEVICEL al refer to the same
device.

Using the alias, an iopen call would look like this:
id = iopen(*'UsbDevicel™);
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Asyou can see, thisis much simpler than having to use the full resource
string for aUSB device.

Using the alias name in a program also makes it more portable. For
example, two identical USB function generators have different resource
strings because they have different serial numbers. If these function
generators are used in two different test systems and you use the full
resource string to access the function generator in the test program, you
cannot use that same program for both test systems, since the function
generators' full resource strings are different. By using the aliasnamein
the program, however, you can use the same program in both test
systems. All you need to do is make sure the same alias name is used for
the function generator in both systems.

Operations Supported on All USBTMC Devices

The following USB-specific SICL functions can be used on all
USBTMC and USBTMC-USB488 device sessions. (See the SICL
Online Help for specific information on these functions.)

Table 55 Operations Supported on All USBTMC Devices

Function Name Action

iusbctrl Used to set parameters affecting the USB device.

iusbgetcapabilitie  Returns a structure containing capabilities information

s about the USB device.

iusbgetinfo Returns a structure containing general information about
the USB device.

iusbstat Used to retrieve the settings of parameters affecting the
USB device.

Interrupts are not supported on USBTMC or on USBTMC-USB488
devices.
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Operations Supported Only on USBTM C-USB488 Devices

The iushgetcapabilities function can be used to determine if adevice
supports the USBTM C-USB488 protocol. Seethe SICL Online Help for
specific information on this function and the definition of the structure
that it returns. If the bcdUSB488 structure element is non-zero, the
device implements the USBTM C-USB488 protocol. The
intf488Capabilities and dev488Capabilities bit masks in this structure
provide the details of what the device supports (e.g. REN Control,
Triggering, SCPI commands, etc.)

SRQs (ionsrq) and triggers (itrigger) are supported only on
USBTMC-USB488 devices. They are not supported on USBTMC
devices that do not implement the USBTM C-USB488 protocol.

On USBTMC-USB488 devices that support REN control, the following
state diagram shows how state transitions are made using various SICL
functions.
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The following SICL functions are used to control the Remote/L ocal
state transitions in USBTM C-USB488 devices sessions. (See the SCL
Online Help for specific information on these functions.)
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Table56 SICL Functions for Remote/Loca State Transition

Function Name  Action

igpibllo Locks out the front panel interface of the device (if REN
istrue).
igpibibrenctl Sets the REN (remote enable) state:

igpibrenctl(id, 0) setsRREN false.
igpibrenctl(id, 1) setsREN true.

iremote iremote(id) sets REN true.
ilocal Enables the front panel interface of the device.
iremote Sets the device REN (remote enable) state to true.

Although igpibllo and igpibrenctl are documented as GPIB-specific
functions that are only valid on interface sessions, these functions can
be called on USBTM C-USB488 device sessions.
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SICL Library Information

This appendix providesinformation on SICL software files and
Windows system interactions.

File System Information

This section describes SICL file system information for Windows
systems.

All SICL filesareinstalled in the base directory specified by the person
who installs Agilent 10 Libraries Suite, with the exception of several
common files that Windows must be able to locate. On Windows 2000,
the following files are copied to the Windows subdirectory. On
Windows XP, the files are copied toWinnt.
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//f Windows 2000/XP ‘\\

<Windir>*

—— Inf

1394ipt.inf
agtgpib.inf
ausbtmec.inf

System 32
1394ipt.dll
agtgpibclass.dll
sicl32.dll
siclrpc.dll
vbsicl32.dll
82357ipt.dll
ausbhelper.dll

Drivers
1394ipt.sys
ag074i32.sys
ag341i32.sys
agt82341.sys
agt82350.sys
agte2050.sys
ausbtmc.sys
agt82357.sys

*<Windir>
Windows 2000 = Winnt

K Windows XP = Windows /

The Registry

Agilent 10 Libraries Suite places the following keysin the Windows
registry under HKEY_LOCAL_MACHINE:

Software\Agilent\10 Libraries\CurrentVersion
Software\Agilent\I10 Libraries Suite\CurrentVersion

Also, if the Remote IO Server is configured, the following key will be
created under HKEY _LOCAL_MACHINE if it did not previously
exist:

Software\Microsoft\Windows\CurrentVersion\
RunServices
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Troubleshooting SICL Programs

This appendix contains a description of SICL error codes and provides
guidelines for troubleshooting common problems with SICL. The
chapter contents are;

» SICL Error Codes

» Common Windows Problems
» Common RS-232 Problems

» Common LAN Problems

See the Agilent 10 Libraries Suite Online Help and the Agilent
USB/LAN/GPIB Interfaces Connectivity Guide for additional
troubleshooting guidelines.

SICL Error Codes

When you install adefault SICL error handler such as|_ERROR_EXIT
or |_ERROR_NOEXIT with anionerror cal, aSICL interna error

message is logged.

SICL logsinternal messages as eventsthat you can view by clicking the
Agilent 10 Contral (on the taskbar) and then clicking Event Viewer.
Both system and application messages can be logged to the Event
Viewer from SICL. SICL messages areidentified by SICL LOG or by
the driver name (such as hp341i32 for the GPIB driver).

For C programs, you can use ionerror to instal acustom error handler.
The error handler can call igeterrstr with the given error code and the
corresponding error message string will be returned. See Chapter 3 -
Programming with S CL for more information on error handlers. This
table summarizes SICL error codes and messages.
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Table57 List of SICL Error Codes

B

Error Error Code Error Sring Description
Number
23 |_ERR_ABORTED Externally aborted A SICL call was aborted by external means.

3 |_ERR_BADADDR Bad address The device/interface address passed to iopen
does not exist. Verify that the interface nameis
the one assigned with Connection Expert.

24 I_ERR_BADCONFIG Invalid configuration Aninvalid configuration was identified when
caling fopen.

13 I_ERR_BADFMT Invalid format Invalid format string specified for iprintf or
iscanf.

4 |_ERR_BADID Invalid INST The specified INST id does not have a
corresponding iopen.

19 |_ERR_BADMAP Invalid map request Theimap call has an invalid map request.

28 I_ERR_BUSY Interfaceisin use by The specified interface is busy.

non-SICL process

14 I_ERR_DATA Dataintegrity violation The use of CRC, Checksum, and so forth imply
invalid data

128 |_ERR_INTERNAL Internal error occurred SICL interna error.

129 |_ERR_INTERRUPT  Processinterrupt occurred A processinterrupt (signal) has occurred in your
application.

21 I_ERR_INVLADDR Invalid address The address specified in iopen isnot avalid
address (for example, “hpib,57").

17 I_ERR_10 Generic 1/O error An I/O error has occurred for this
communication session.

11 |_ERR_LOCKED Locked by another user Resource is locked by another session (see
isetlockwait).

27 | ERR_NESTEDIO Nested I/O Attempt to call another SICL function when
current SICL function has not completed
(WIN16). More than one I/O operation is
prohibited.

25 I_ERR_NOCMDR Commander session is not Tried to specify acommander session when it is

active or available

not active, available, or does not exist.

Agilent SICL User’s Guide

197



B  Appendix B: Troubleshooting SICL Programs

Table57 List of SICL Error Codes (continued)

Error Error Code Error Sring Description
Number
6 | ERR_NOCONN No connection Communication session has never been
established, or connection to remote has been
dropped.
20 |_ERR_NODEV Deviceisnot active or Tried to specify a device session when it is not
available active, available, or does not exist.
0 |_ERR_NOERROR No Error No SICL error returned; function return valueis
zero (0).

10 |_ERR_NOINTF Interfaceis not active Tried to specify an interface session when it is
not active, available, or does not exist.

12 | ERR_NOLOCK Interface not locked Aniunlock was specified when device was not
locked.

7 | ERR_NOPERM Permission denied Accessrights violated.

9 | ERR_NORSRC Out of resources No more system resources available.

22 I_ERR_NOTIMPL Operation not implemented Call not supported on thisimplementation. The
request isvalid, but not supported on this
implementation.

8 |_ERR_NOTSUPP Operation not supported Operation not supported on this implementation.

18 |_ERR_OS Generic O.S. error SICL encountered an operating system error.

16 I_ERR_OVERFLOW  Arithmetic overflow Arithmetic overflow. The space allocated for
data may be smaller than the data read.

5 |_ERR_PARAM Invalid parameter The constant or parameter passed is not valid for
thiscall.

2 |_ERR_SYMNAME Invalid symbolic name Symbolic name passed to 1open not
recognized.
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Table57 List of SICL Error Codes (continued)

B

Description

Error Error Code Error Sring
Number
1 |_ ERR_SYNTAX Syntax error
15 I_ERR_TIMEOUT Timeout occurred
26 |_ERR_VERSION Version incompatibility

Syntax error occurred parsing address passed to
iopen. Make sure you have formatted the
string properly. White space is not allowed.

A timeout occurred on the read/write operation.
The device may be busy, in abad state, or you
may need alonger timeout value for that device.
Check also that you passed the correct addressto
iopen.

The 1open call has encountered a SICL library
that is newer than the drivers. Need to update
drivers.
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Common Windows Problems
Table58 Windows Errors

Program Appearsto Hang and Cannot ~ Check that an itimeout value has been set for al SICL sessionsin your

Be Stopped program. Otherwise, when an instrument does not respond to a SICL read or
write, SICL will wait indefinitely in the SICL kernel access routine,
preventing the application from being stopped.

To stop the application, click the button in the upper-Ieft corner of the window
and then close the window. After afew seconds, an End Task dialog box
appears. Pressthe End Task button to stop the application.

Formatted 1/O Using %F Causes Verify $(cvarsdll) is used when compiling the application, and either
Application Error $(quilibsdil) for Windows applications or $(conlibsdll) for console
applications when linking your application.

Also, the %F format character for iprintf only works with languages that use
MSVCRT.DLL, MSVCRT20.DLL, or MSVCRT40.DLL for their run-time
library.

Some versions of Visual C/C++ use their own versions of the run-time
library. They cannot share global datawith SICL's version of the run-time
library and, therefore, cannot use %F.

Common RS-232 Problems

Unlike GPIB, special care must be taken to ensure that RS-232 devices
are correctly connected to the computer. Verifying the configuration
first may save many hours of debugging time.

Table59 Common RS-232 Problems

No Response from Instrument Be sure the RS-232 interface is configured to match the instrument. Check the
Baud Rate, Parity, Data Bits, and Stop Bits. Also, be sure you are using the
correct cabling. See Appendix A - SCL Library Information for RS-232 cabling
information.

If you are sending several commands at once, try sending commands one at a
time either by inserting delays or by single-stepping the program.

Data Received from Instrument is Check the interface configuration. Install an interrupt handler in your program
Garbled that checks for communication errors.
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Table59 Common RS-232 Problems

Data L ost During Large Transfers Check:
Flow control setting match
Full/half duplex for 3-wire connections
Cabling is correct for hardware handshaking

Common LAN Problems

Both the LAN client and LAN server may log messages to the Event
Viewer under certain conditions, whether or not an error handler has
been registered.

General Troubleshooting Techniques

Before SICL over LAN can function, the client must be able to talk to
the server over the LAN. You can use the following techniques to
determine if the problem is a general network problem or is specific to
the LAN software provided with SICL .

Using the ping Utility

If the application cannot open a session to the LAN server for SICL, the
first diagnostic to try isthe ping utility. This utility allows you to test
general network connectivity between client and server machines.

Using ping looks something like the following, where each line after the
Pinging line is an example of a packet successfully reaching the server.

>ping instserv.agilent.com

Pinging instserv.agilent.com[128.10.0.3] with 32

bytes of data:Reply from 128.10.0.3:bytes=32
time=10ms TTL=255

Reply from 128.10.0.3:bytes=32 time=10ms
TTL=255

Reply from 128.10.0.3:bytes=32 time=10ms
TTL=255

Reply from 128.10.0.3:bytes=32 time=10ms
TTL=225
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However, if ping cannot reach the host, a message similar to the
following is displayed that indicates the client was unable to contact the
server. In this case, you should contact your network administrator to
determine if thereisa LAN problem. When the LAN problem has been
corrected, you can retry your SICL application over LAN.

Pinging instserv.agilent.com[128.10.0.3] with 32
bytes of data:

Request timed out.

Request timed out.

Request timed out.

Request timed out.

LAN Client Problems

iopen Fails- Syntax Error

In this case, iopen failswith the error |_ERR_SYNTAX. If using the
“lan,net_address’ format, ensure that the net_address is a hostname, not
an IP address. If you must use an |P address, specify the address using
the bracket notation, 1an[128.10.0.3], rather than the comma notation
lan,128.10.0.3.

iopen Fails- Bad Address

Aniopen failswith the error |_ERR_BADADDR, and the error text is
core connect failed: program not registered. Thisindicates the
Remote |O Server software has not registered itself on the server
machine. This may also be caused by specifying an incorrect hostname.
Ensure that the hostname or | P address is correct and, if so, check the
Remote |O Server’sinstallation and configuration.

iopen Fails - Unrecognized Symbolic Name

Theiopen failswith theerror |_ERR_SYMNAME, and the error text is
bad hostname, gethostbyname() failed. This indicates the hostname
used in theiopen address is unknown to the networking software.
Ensure that the hostname is correct and, if so, contact your network
administrator to configure your machine to recognize the hostname. The
ping utility can be used to determine if the hosthame is known to your
system. If ping returns with the error Bad | P address, the hostname is
not known to the system.
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iopen Fails - Timeout

Aniopen failswith atimeout error. Increase the Client Delta Timeout
configuration value via the Connection Expert utility. See Chapter 8 -
Using SICL with LAN for more information.

iopen Fails- Other Failures

Aniopen fails with some error other than those already mentioned. Try
the steps at the beginning of this section to seeif the client and server
can talk to one another over the LAN. If the ping and rpcinfo
procedures work, check any server error logs that may be available for
further clues. Check for possible problems such as alack of resources at
the server (memory, number of SICL sessions, etc.).

I/O Operation Times Out

An 1/O operation times out even though the timeout being used is
infinity. Increase the Lan Maximum Timeout configuration value viathe
Connection Expert utility. Also, ensure the LAN client timeout islarge
enough if ilantimeout is used. See Chapter 8 - Using SICL with LAN
for more information.

Operation Following a Timed Out Oper ation Fails

An 1/O operation following a previous timeout failsto return or takes
longer than expected. Ensurethe LAN timeout being used by the system
is sufficiently greater than the SICL timeout being used for the session
in question. The LAN timeout should be large enough to allow for the
network overhead in addition to the time that the I/O operation may
take.

If ilantimeout is used, you must determine and set the LAN timeout
manually. Otherwise, ensure the Client Delta Timeout configuration
valueislarge enough (viathe Connection Expert utility). See Chapter 8
- Using SICL with LAN for more information.

iopen Failsor Other Operations Fail Dueto L ocks

An iopen fails due to insufficient resources at the server or 1/0
operations fail because some other session has the device or interface
locked. LAN server connectionsfor SICL from previous clients may not
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have terminated properly. Consult your server’s troubleshooting
documentation and follow the instructions for cleaning up any previous
SErver processes.

LAN Server Problems

SICL LAN Application Fails- RPC Error

After starting the LAN server, aSICL LAN application fails and returns
amessage similar to the following:

RPC_PROG_NOT_REGISTERED

Thereis ashort (approximately 5 second) delay between starting the
LAN server and the LAN server being registered with the Portmapper.
Try running the SICL LAN application again.

rpcinfo Does Not List 395180 or 395183

A rpcinfo query failsto indicate that program 395180 (SICL LAN
Protocol) or 395183 (TCP/IP Instrument Protocol) is available on the
server. If you have not yet started the LAN server, do so now. Seethe |O
Libraries Suite Online Help for details on how to start the LAN server.
If you have started the LAN server, try rpcinfo again after afew
seconds to ensure the LAN server had time to register itself.

iopen Fails

Aniopen failswhen you run your application, but r pcinfo indicates the
LAN server isready and waiting. Ensure the requested interface has
been configured on the server. See the 1O Libraries Suite Online Help
for information on using the Connection Expert utility to configure
interfaces for SICL.

LAN Server Appears“Hung’

The LAN server appears “hung” (possibly due to along timeout being
set by aclient on an operation that will never succeed). Login to the
LAN server and stop the hung LAN server process. To stop the LAN
server, seethe 1O Libraries Suite Online Help.
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This action will affect all connected clients, even those that may still be
operational. If informational logging has been enabled using the
Connection Expert utility, connected clients can be determined by log
entriesin the Event Viewer utility.

rpcinfo Fails - cannot contact portmapper

An rpcinfo returns the message r pcinfo: can’t contact portmapper:
RPC_SYSTEM_ERROR - Connection refused.

If the LAN server isnot running, start it. If the LAN server isrunning,
stop the currently running LAN server and then restart it.

Use Ctrl+Alt+Del to display atask list. Ensure that both LAN Server
and Portmap are not running before restarting the LAN server. See the
IO Libraries Suite Online Help for details on how to start and stop the
LAN server.

rpcinfo Fails - program 395180 is not available

Anrpcinfo -t server_hostname 395180 1 returnsthe following
message:

rpcinfo: RPC_SYSTEM_ERROR - Connection refused
program 395180 version 1 isnot available

Ensure that the LAN server program is running on the server.

Mouse“Hung” When Sopping LAN Server

After you attempt to stop a LAN server viaeither Ctrl+C or the
Windows Close button (the x in the upper-right hand corner of the
window), the mouse may appear to be “hung.” Press any keyboard key
and the LAN server will stop and the mouse will again be operational .
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access board

The GPIB interface to which a particular device is connected.

Active Controller

See “Controller in Charge”.

address

A string (or other language construct) that uniquely locates and
identifies aresource. VISA defines an ASCII-based grammar that
associates address strings with particular physical devices or
interfaces and VISA resources.

Agilent 488

An /O library provided in Agilent 10 Libraries Suite for
compatibility with existing test & measurement programs that were
developed using National Instruments’ NI-488 or other similar
libraries. Agilent 488 supports communication with GPIB devices
and interfaces, but does not support USB, LAN, RS-232, or VXI
communications.

alias
See VISA alias.

API

Application Programming Interface. The interface that a programmer
sees when creating an application. For example, the VISA API
consists of the sum of all of the operations, attributes, and events of
each of the VISA ResourceClasses.
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attribute

In VISA and SICL, avalue that indicates the operational state of a
resource. Some attributes can be changed; others are read-only.

board

A GPIB interface. It may be aphysical board, an adapter (such asthe
82357 USB/GPIB adapter), or aremote GPIB interface.

board descriptor

A handle, returned from ibfind, that uniquely identifies a GPIB
interface (board) in Agilent 488 original API calls. Also called an
interface descriptor or board unit descriptor.

board-level

Refersto Agilent 488 functions that operate on an interface (board),
rather than on a device.

buserror

An error that signals failure to access an address. Bus errors occur in
conjunction with low-level accesses to memory, and usually involve
hardware with bus mapping capabilities. Bus errors may be caused
by non-existent memory, a non-existent register, an incorrect device
access, etc.

buserror handler

Software that runs when a bus error occurs.

CIC

Controaller in Charge.

command bytes

GPIB commands encoded as individual bytes. Also called GPIB
commands or interface messages.
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commander

In test-system architectures, a device that has the ability to control
another device. In a specialized case, acommander may also be the
device that has sole control over another device (as with the V XI
Commander/Servant hierarchy).

commander session

A session that communicates to the interface’'s commander.
Commander sessions are used when an interfaceisin a
non-Controller role.

communication channel

A communication path between a software element and a resource.
In VISA, “communication channel” is synonymous with “ session.”
Every communication channel in VISA is unique.

Connection Expert

An Agilent software utility that helps you quickly establish
connections between your instruments and your PC. It al'so helpsyou
troubleshoot connectivity problems. Connection Expert is part of the
Agilent 10 Libraries Suite product.

Controller

A device (typically a computer) used to communicate with another
device or devices (typically instruments). The Controller isin charge
of communications and device operation; it controls the flow of
communication and performs addressing and other bus management
functions.

Controller in Charge

The device currently in control of the GPIB.
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device

A unit that receives commands from a Controller. A deviceis
typically an instrument, but can also be a computer actingin a
non-Controller role or another peripheral such as a printer or plotter.
InVISA, adeviceislogically represented by the association of
several VISA resources.

device descriptor

A handle, returned from ibdev or ibfind, that uniquely identifiesa
devicein Agilent 488 original API calls. Also called adevice unit
descriptor.

devicedriver

Software code that communicates with a device: for example, a
printer driver that communicates with a printer from a PC. A device
driver may either communicate directly with a device by reading to
and writing from registers, or it may communicate through an
interface driver.

device session

A session that communicates as a Controller with asingle, specific
device such as an instrument.

device-level

Refersto Agilent 488 functionsthat operate on adevice (instrument),
rather than on an interface.

direct 1/0

Programmatic communication with instruments not involving an
instrument driver. Direct 1/0O may be accomplished by using an 10
Library (VISA, VISA COM, SICL, or Agilent 488) or by using
direct I/0O tools such as those provided by Agilent VEE.

driver

Seeinstrument driver and devicedriver.
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explorer view

The tree view within the Connection Expert window that shows all
devices connected to a test system.

handler

A software routine that responds to an asynchronous event such asan
SRQ or aninterrupt.

instrument

A device that accepts commands and performs atest and
measurement function.

instrument driver
Software that runs on a computer to allow an application to control a
particular instrument.

Interactive O

An Agilent application that allows you to interactively send
commands to instruments and read the results. Interactive 10 is part
of the Agilent 10 Libraries Suite product.

interface

A connection and medium of communication between devices and
controllers. Interfaces include mechanical, electrical, and protocol
connections.

interface descriptor

A handle, returned from ibfind, that uniquely identifies a GPIB
interface (board) in Agilent 488 original API calls. Also called a
board descriptor or board unit descriptor.

interfacedriver

Software that communicates with an interface. The interface driver
a so handles commands used to perform communications on an
interface.
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interface messages

GPIB commands encoded as individual bytes. Also called GPIB
commands or command bytes.

inter face session

A session that communicates and controls parameters affecting an
entire interface.

interrupt

An asynchronous event that requires attention and actions that are
out of the normal flow of control of a program.

1O Control

Theicon in the Windows notification area (usually the lower right
corner of your screen). The 1O Control gives you access to Agilent
I/O utilities such as Connection Expert, Agilent I/O documentation,
and VISA options.

IO Libraries

Application programming interfaces (APIs) for direct 1/0
communication between applications and devices. There are four
Agilent 10 Librariesin the Agilent 1O Libraries Suite: VISA, VISA
COM, SICL, and Agilent 488.

Listener

A devicethat can receive data from the bus when instructed
(addressed to listen) by the System Controller.

lock

A state that prohibits other users from accessing aresource such asa
device or interface.
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logical unit

A number associated with an interface. A logical unit, in SICL and
Adgilent VEE, uniquely identifies an interface. Each interface on the
controller must have a unique logical unit.

mapping

An operation that returns a reference to a specified section of an
address space and makes the specified range of addresses accessible
to the requester. This function isindependent of memory allocation.

non-Controller role

A computer isin anon-Controller role when it acts as adevice
communicating with a computer that isin a Controller role.

notification area

The area on the Windows taskbar where notifications are posted,
typically in the lower right corner of the screen. Also called taskbar
notification area or Windows notification area.

operation

A defined action that can be performed on aresource.

primary VISA

The VISA ingtalation that controls the visa32.dll file. The primary
VISA will be used by default in VISA applications. See also
secondary VISA.

process

An operating system component that shares a system'’s resources. A
single-process computer system allows only asingle program to
execute at any given time. A multi-process computer system allows
multiple programs to execute simultaneously, each in a separate
process environment.
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programming alias
See VISA alias.

refresh

In Connection Expert, the action that invokes the discovery
mechanism for detecting interfaces and instruments connected to
your computer. The explorer view is then refreshed to show the
current, discovered state of your test system.

register

An address location that contains a value that represents the state of
hardware, or that can be written into to cause hardware to perform a
specified action or to enter a specified state.

resource (or resource instance)

In VISA, an implementation of aresource class (in object-oriented
terms, an instance of aresource class). For example, an instrument is
represented by a resource instance.

resour ce class

The definition of a particular resource type (a classin object-oriented
terms). For example, the VISA Instrument Control resource classes
define how to create a resource to control a particular capability of a
device.

resour ce descriptor

A string, such asa VISA resource descriptor, that specifies the 1/0
address of a device.

SCPI

Standard Commands for Programmable Instrumentation: a standard
set of commands, defined by the SCPI Consortium, to control
programmable test and measurement devices in instrumentation
systems.
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secondary VISA

A VISA installation that does not install visa32.dll in the standard
VISA location. The secondary VISA installation namesits VISA
DLL with adifferent name (agvisa32.dil) so that it can be accessed
programmatically. The primary VISA will be used by default in
VISA applications. See also primary VISA.

session

VISA term for acommunication channel. Aninstance of a
communications path between a software element and a resource.
Every communication channel in VISA isunique.

SICL

Standard Instrument Control Library. SICL isan Agilent-defined
API for instrument I/O. Agilent SICL isone of the IO Libraries
installed with Agilent 1O Libraries Suite.

side-by-side

A side-by-side installation allows two vendors' implementations of
VISA to be used on the same computer. See also primary VISA and
secondary VISA.

SRQ

An |EEE-488 Service Request. Thisis an asynchronous request (an
interrupt) from a remote device that requires service. In GPIB, an
SRQ isimplemented by asserting the SRQ line onthe GPIB. In VX,
an SRQ isimplemented by sending the Request for Service True
event (REQT).

Standby Controller

A device or interface that has Controller capability, but is not
currently the Active Controller.
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status byte

A byte of information returned from a remote device that shows the
current state and status of the device. If the device follows |EEE-488
(GPIB) conventions, bit 6 of the status byte indicates whether the
deviceis currently requesting service.

symbolic name

A name corresponding to a single interface. This name uniquely
identifies the interface on this Controller or gateway. When thereis
more than one interface on the Controller or gateway, each interface
must have a unique symbolic name.

System Controller

One Controller on a GPIB isthe System Controller. Thisis a master
Controller; it has the ability to demand control and to assert the IFC
(Interface Clear) and REN (remote enable) lines.

system tray

See notification area.

Talker

A device that transmits data onto the bus when instructed (addressed
to tak).

task guide

The information and logic represented in the left pane of the
Connection Expert window. The task guide provides links to actions
and information that help guide you through the most common 1/0O
configuration tasks.

taskbar notification area

See notification area.
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test system

An entire test setup including a controller (often a PC), instruments,
interfaces, software, and any remote controllers, instruments, and
interfaces that are configured to be used as part of the system.

thread

An operating system object that consists of aflow of control within a
process. A single process may have multiple threads, each having
access to the same data space within the process. Each thread has its
own stack, and all threads may execute concurrently (either on
multiple processors, or by time-sharing a single processor).

ViFind32

A console application that usesthe viFindRsrc and viFindNext VISA
functions to enumerate all resourcesvisibleto VISA. This
application is useful for verifying that all expected interfaces have
been configured by Connection Expert, and that the expected devices
have been attached. ViFind32 is part of the Agilent 1O Libraries
Suite.

virtual instrument

A name given to the grouping of software modules (such as VISA
resources with any associated or required hardware) to give them the
functionality of atraditional stand-alone instrument. Within VISA, a
virtual instrument isthe logical grouping of any of the VISA
resources. The VISA Instrument Control Resources Organizer serves
as ameansto group any number of any type of VISA Instrument
Control Resources within aVISA system.

VISA

Virtual Instrument Software Architecture. VISA isastandard 1/0
library that allows software from different vendors to run together on
the same platform. Agilent VISA is part of the Agilent IO Libraries
Suite.

VISA address

A resource descriptor that can be used to open a VISA session.
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VISA alias

A string that can be used instead of aresource descriptor in VISA
programs. Using VISA aliases rather than hard-coded resource
descriptors makes your programs more portable. You can define
VISA aliases for your instrumentsin Connection Expert.

VISA COM

The V XlIplug& play specification for a COM-compliant VISA 1/O
library and itsimplementation. Agilent VISA COM is part of the
Agilent 10 Libraries Suite.

VISA Instrument Control Resources

The VISA definition of device-specific resource classes. VISA
Instrument Control Resourcesinclude all VI1SA-defined device and
interface capabilities for direct, low-level instrument control.

VISA name

The prefix of aVISA address, also called the VISA interfaceID.
The VISA name specifies the interface.

VISA resource manager

The part of VISA that manages resources. This management includes
support for opening, closing, and finding resources, setting attributes,
retrieving attributes, and generating events on resources.

VISA resource template

The part of VISA that defines the basic constraints and interface
definition for the creation and use of aVVISA resource. Each VISA
resource must derive its interface from the VISA resource template.

VXI Resource M anager

A software utility that initializes and prepares a VXI system for use.
The VXI Resource Manager is part of the Agilent 10 Libraries Suite.
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Windows notification area

See notification area.
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addressing device sessions, 34
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addressing RS-232 interfaces, 152
addressing V XI message-based
devices, 112
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web site, 14
Agilent 488, 207
asynchronous events,
enabling/disabling, 57
asynchronous events, handling, 56
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buffers, formatted 1/0, 44, 52
building SICL applications, 30

C

C applications, compiling, 31
command module, 110
commander session, 33
common LAN problems, 201
communications sessions,

opening, 32
compiled SCPI (C-SCPI), 110
compiling C applications, 31
configuring RS-232 interfaces, 141
Connection Expert, 18

D

device session, 32

device sessions, addressing, 34
device sessions, RS-232, 143
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error handlers

using in Visua Basic, 62

error handlers, usingin C, 59
error handling, 59

Event Viewer, 59
Event Viewer utility, 196

examples

C Example Program Code, 16
Configuring RS-232
Interface, 141
Creating a Commander
Session, 36
Device Locking (C), 66
Device Locking (Visual
Basic), 67
Error Handlers (Visual Basic), 63
Formatted I/O (Visua Basic), 51
GPIB (82350) Interface, 83
GPIB Device Session (C), 88
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Installing an Error Handler
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RS-232 Interface Session (C), 155

RS-232 Interface Session (Visua
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Servicing Requests (C), 100
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V X| Message-Based Device
Session (C), 113
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GPIB communications sessions,
selecting, 85

GPIB device sessions, service
requests, 88

GPIB device sessions, SICL
functions, 86

GPIB device sessions, using, 86

GPIB devices, addressing, 86

GPIB interface sessions

servicerequests, 94

GPIB interface sessions,
interrupts, 93

GPIB interface sessions, SICL
functions, 92

GPIB Interfaces, configuring, 83

GPIB interfaces, introduction, 82

GPIB SICL functions, 85

H

handling errors, 59

1/0 commands, sending, 36
interface session, 33
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interpreted SCPI (1-SCPI), 110
interrupt handlers, 57
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|-SCPI interface, 115

L
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hardware architecture, 160
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timeouts, 177
timeouts in multi-threaded
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Using the ping Utility, 201
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LAN interfaces, overview, 160
LAN-gatewayed sessions, 165
libraries, C applications, 30
locking
multi-user environment, 66
locks
actions, 65
locking multi-user
environment, 66
locks, using, 64

M

message-based devices,
programming, 111
message-based devices, VXI, 109

N

NI-488, 207
non-formatted |/O, 53

O

opening communications
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overview, guide, 10
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P

peeks and pokes, register, 110
programming VX1 register-based
devices, 115

R

register peeks and pokes, 110

register-based devices, 109

register-based devices,
programming, 115

RS-232
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communications sessions, 142
device sessions, 143, 147
interface sessions, 143, 152
interface sessions, SICL
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SICL functions, 144
RS-232 device sessions
SICL function support, 148
RS-232 devices, addressing, 147
RS-232 interfaces, addressing, 152
RS-232 interfaces, configuring, 141
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S

sample code
See also examples, 9
selecting GPIB communications
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sending I/0O commands, 36
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description, 12
GPIB functions, 85
GPIB interface sessions, 92
SICL declaration file, 30
SICL applications, building, 30
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SICL overview, 11
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using GPIB interface sessions, 92
using RS-232 interface sessions, 152
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VISA, 11
Visua Basic applications,
running, 32
VME devices
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declaring resources, 126
interrupts, 129
mapping VME memory, 127
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registers, 128
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command module, 116
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